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PeerSync Help

Welcome to Peer Software's powerful file mirroring, backup and distribution solution,
PeerSync v9.5. With this product you will be able to conveniently synchronize folders for
back-up purposes or portability requirements. Never again will you overwrite newer data by
attempting to manually update an individual file or the contents of a folder. 

History

PeerSync has been available for download/purchase since early 1995. Since then
hundreds of downloads have been logged from various international forums where
PeerSync was made available and thousands of copies have been sold. PeerSync is an
MS Windows-based product. Originally written in Visual Basic, the current product is
written in Delphi Object Pascal. PeerSync originated as a solution to a problem frequently
encountered by our own developers, that of keeping files in sync between multiple hard
drives. Developers working on-site at customers' locations or at home during crunch
schedules would then have to synchronize their data back to the office server. This was
most often done manually, with each individual file being dragged to the appropriate server
folder. Invariably, data would be lost when one or several of the server files contained new
information which was subsequently overwritten. In addition to loss of work and resulting
frustration, the process was also time consuming. Anywhere from 20 minutes to 2 hours
would be spent during each synchronization. After reviewing several commercially
available products, it became apparent that an effective and user-friendly solution to this
common problem did not exist, hence the development of PeerSync.

Description

Configured through the Profiler, an intuitive and easy-to-use application, PeerSync
automatically synchronizes multiple directories and sub-directories from user-defined
Source to Target Folders. While removing the frustration and loss of time associated with
manual synchronization, PeerSync prevents loss of data by checking file dates and times
to ensure that newer information is not overwritten. Synchronization can occur between
any mapped or UNC connected drives located on local computers or computer networks.
While processing and performing any number of simultaneous tasks, PeerSync retains and
expands upon the selectivity and precision of manual synchronization by offering a suite of
automated file inclusion and exclusion features. Files can be included within
synchronization according to standard DOS-type wild cards and excluded using sub-string
comparisons or file attribute settings. Files can be also be excluded according to their date
and size. In addition, PeerSync can be configured to update or add files which are out-
dated or non-existent in the current Target Folder. Precision and scope are further
enhanced through PeerSync Jobs and Command Line Modes. A virtually unlimited number
of folder combinations (Jobs) can be created and stored in Profiles which can be run
manually or automatically using command line arguments. While synchronizing large
numbers of folder combinations at once, each combination can have a unique set of
exceptions. In this way PeerSync combines the benefits of precise folder matching with
that of an automated environment. Real-Time Source Folder monitoring and repetitive
operations on the host PC are also available with PeerSync's options. PeerSync can also
be used for network file management purposes. Reports run during synchronization can
display added, updated, and opened files as well as directories created, and can display
unmatched files found in Target directories.

File Transfer Protocol (FTP)
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As of version 9.4, PeerSync's File Transfer Protocol (FTP) is "End-of-Life" and no further
development or support will be provided. Please contact support@peersoftware.com for
more information. 

File and Folder Compression

As of version 9.4, PeerSync's  File and Folder Compression feature is "End-of-Life" and no
further development or support will be provided. Please contact
support@peersoftware.com for more information. 

Dell EMC VNX and Isilon

Version 9.4 and higher of PeerSync supports real-time and share migration for both Dell
EMC VNX and Isilon when using CIFS/SMB.

Dell EMC Unity

Version 9.5 and higher of PeerSync supports real-time and share migration for Dell EMC
Unity when using CIFS/SMB.

Nutanix Files

Version 9.5 and higher of PeerSync supports real-time and share migration for Nutanix
Files when using CIFS/SMB.

The manufacturer of PeerSync makes no warranties, implied or otherwise, for use of this product. User assumes all
responsibility for any data loss or damage.

Copyright © 1993-2021 Peer Software Inc. All Rights Reserved. Privacy Policy

PeerSync is a registered trademarks of Peer Software, Inc.
Reproduction in whole or in part without permission is strictly prohibited.

The PeerSync Help Manual was built on Tuesday, June 1, 2021

http://www.peersoftware.com/our-privacy-policy.html
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Product Information

License Agreement

PEER SOFTWARE END USER LICENSE AGREEMENT

PLEASE READ THIS AGREEMENT CAREFULLY.  BY CHECKING THE "ACCEPT" BUTTON BELOW,
OPENING THE PACKAGE, DOWNLOADING THE SOFTWARE, OR USING THE SOFTWARE, YOU ARE
AGREEING TO BE BOUND BY THIS AGREEMENT.  IF YOU DO NOT AGREE TO ALL OF THE TERMS
AND CONDITIONS OF THIS AGREEMENT, CLICK THE "DO NOT ACCEPT" BUTTON AND THE
INSTALLATION PROCESS WILL NOT CONTINUE, RETURN THE SOFTWARE TO THE PLACE OF
PURCHASE FOR A FULL REFUND, OR DO NOT DOWNLOAD THE SOFTWARE.  IF YOU ARE
ENTERING INTO THIS AGREEMENT ON BEHALF OF A CORPORATION OR OTHER LEGAL ENTITY,
YOU REPRESENT THAT YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THIS AGREEMENT.

This Peer Software End User License Agreement ("Agreement") is legally binding
between the purchasing entity identified on the applicable ordering document
(e.g., quote or purchase order) ("Customer") and Peer Software, Inc. ("Peer
Software") regarding Customer's purchase, evaluation, and/or license of the
Software, as described below.  This Agreement is effective as of the earlier of
the date set forth on the applicable ordering document or the date that Customer
accepted this Agreement as described above.

1. Definitions.

1.1. "Documentation" means any user instructions, manuals, and online help files
regarding the use of the Software that are generally provided by Peer Software
in connection with the Software.

1.2. "Software" means Peer Software's commercially released machine-executable
object code version of its proprietary software, as may be more fully described
in the applicable ordering document.

2. Software Licenses and Restrictions.

2.1. License.  Subject to the terms and conditions of this Agreement, Peer
Software grants to Customer a non-exclusive, non-sublicensable and non-
transferable license to (a) use the Software solely for its own internal needs;
and (b) use the Documentation in connection with the permitted use of the
Software.

2.2. Restrictions.  Customer will not:  (i) copy or reproduce the Software; (ii)
modify or create any derivative works of the Software; (iii) decompile,
disassemble, or reverse engineer the Software; (iv) redistribute, encumber,
sell, rent, lease, sublicense, or otherwise transfer rights to the Software; (v)
remove or alter any trademark, logo, copyright or other proprietary notices,
legends, symbols, or labels in the Software; (vi) provide access to or disclose
the Software to any third party, or use the Software to create or provide any
offering or service, whether or not it is similar or competitive to the
Software, including without limitation processing third-party data files as a
consultant, service provider, or otherwise; (vii) extract or use any software or
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content that is furnished by Peer Software except as part of the Software;
(viii) use the Software for any unlawful purpose; (ix) use the Software in
connection with the storage or transmission of infringing, libelous, or
otherwise unlawful or tortuous material, or in violation of any third-party
privacy rights, or (x) publish or disclose to any third party any performance or
benchmark tests or analyses relating to the Software, except for internal use by
the Customer.

3. Term and Termination.

3.1. Term of Agreement.  This Agreement will be effective from the date of
purchase of the Software and shall end upon the earlier of:  (i) the end of the
License Term (if any) specified in the applicable ordering document (and any
renewal thereof), or (ii) the termination of this Agreement pursuant to Section
3.3.  In the case of an evaluation of the Software, this Agreement will
terminate at the conclusion of the evaluation period as stated on the applicable
ordering document, unless Customer purchases and/or licenses the Software prior
to the conclusion of the evaluation period.

3.2. Term of Software Licenses.  The Software License Term shall be specified in
the applicable ordering document for the Software and/or the time period as
specified in the Software license key provided by Peer Software to the Customer.

3.3. Termination.  This Agreement may be terminated for cause by either party,
in the event that the other party commits a material breach of this Agreement
and does not cure such breach within thirty (30) days of receipt of written
notice specifying such breach and the intent to terminate.

3.4. Effect of Termination.  Upon termination of this Agreement, all rights
granted to Customer with respect to term- and subscription-based Software and
Documentation will terminate, and Customer will immediately discontinue use of
such Software and Documentation and any of Peer Software's Confidential
Information.  Upon request by Peer Software, Customer will certify in writing to
Peer Software within thirty (30) days that the affected copies of the Software,
in whole or in part, in any form, and any Confidential Information, have either
been returned to Peer Software or destroyed in accordance with Peer Software's
instructions.  With respect to Software installed for which the license grant
was perpetual, if this Agreement is terminated pursuant to Section 3.3 because
of Customer's uncured breach of the license or restrictions of Section 2, or the
confidentiality obligations of Section 10, the licenses granted under Section 2
will terminate and Customer shall promptly cease all use of the Software and
Documentation and destroy (and in writing certify such destruction) or return to
Peer Software all copies of the Software and Documentation then in Customer's
possession or control.  If this Agreement is terminated by either party for any
reason other than those given in the preceding sentence, then provided that
Customer has paid the entire license fee, applicable maintenance and support
fees, all fees due under any applicable Statement of Work for services, and any
other fees due, then any Software licenses identified as "perpetual" on the
applicable order form will survive such termination, subject to the following:

(a) the terms and conditions of this Agreement pertaining to the Software will
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survive any such termination (including without limitation Sections 2.1 and
2.2);

(b) any such "perpetual" license will always be subject to subsequent
termination by Peer Software for Customer's uncured breach of the license and
restrictions of Section 2 or confidentiality obligations of Section 10; and

(c) Peer Software's obligation to provide Software Support or other services
under this Agreement will terminate.
3.5. Survival.  Sections 2.2, 3, 4, 6, and 8 through 12, inclusive shall survive
the termination of this Agreement.

4. Payment.  Customer shall pay all amounts net thirty (30) days from the date
of invoice.  Software will be invoiced at time of shipment.  Fees for perpetual
Software licenses will be invoiced and paid in advance of receiving final non-
expiring Software license keys.  Fees for term- or subscription-based Software
licenses and Software Support will be invoiced for all years purchased and paid
at the beginning of the period.  Any fees for professional services will be
invoiced according to the Statement of Work.  All fees are nonrefundable. 
Customer will be responsible for all taxes resulting from the purchases other
than taxes on Peer Software's net income.

5. Limited Warranty.

5.1. Peer Software warrants for a period of ninety (90) days from shipment that
the Software will substantially conform to the Documentation.

5.2. Repair or replacement is limited to providing maintenance releases of the
Software that Peer Software generally makes available from time to time.

5.3. The Software can contain some components subject to open source software,
freeware, shareware, or similar licensing or distribution models ("Open Source
Components").  Without limiting the generality of the foregoing, Peer Software's
warranty obligations under this Agreement do not apply to Open Source
Components.

6. WARRANTY DISCLAIMER.  EXCEPT AS SET FORTH IN SECTION 5, PEER SOFTWARE AND ITS
LICENSORS AND SUPPLIERS DISCLAIM ANY AND ALL REPRESENTATIONS, WARRANTIES, AND
CONDITIONS, WHETHER EXPRESS, IMPLIED, OR STATUTORY, REGARDING OR RELATING TO THE
SOFTWARE AND DOCUMENTATION, OR ANY OTHER MATERIALS OR SERVICES FURNISHED OR
PROVIDED TO CUSTOMER UNDER THIS AGREEMENT, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, NONINFRINGEMENT, AND FITNESS FOR A
PARTICULAR PURPOSE, ANY WARRANTY THAT THE SOFTWARE WILL BE UNINTERRUPTED, ERROR
FREE, OR THAT CUSTOMER CONTENT WILL BE SECURE OR NOT OTHERWISE LOST OR DAMAGED.

7. SOFTWARE SUPPORT.

7.1. During Customer's paid Software Support subscription, Peer Software will
provide Software Support to Customer.
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7.2. Peer Software will have no obligation to provide Software Support for:  (a)
improper installation of the Software; (b) any modification of the Software not
made by Peer Software unless it is preapproved in writing by Peer Software; (c)
any version of the Software running on any platform that is not supported by
Peer Software; or (d) any version of the Software that has reached its end of
support life.

7.3. The initial Software Support period will be specified in the applicable
ordering document from the effective date of this Agreement.  Reinstatement of
lapsed Software Support, if any, is subject to Peer Software's then-current
support services reinstatement policy and fees in effect on the date the
reinstatement is granted.

7.4. Peer Software reserves the right to charge additional support fees at its
then standard professional services rates for support services performed in
connection with reported problems that are later determined to have been due to
Customer error or third-party hardware or software.  Any configuration or
integration work must be separately quoted by Peer Software's professional
services organization and agreed by the parties in writing.

8. INDEMNIFICATION.

8.1. Peer Software agrees that it will, at its own expense, defend all suits or
proceedings instituted against Customer and pay any award or damages finally
assessed against Customer in such suits or proceedings, insofar as the same are
based on any third-party claim that the Software or any parts thereof furnished
under this Agreement constitute an infringement in the United States of any
United States patent, copyright trade secret or other intellectual property
right of a third party; provided, however, that Customer (i) gives immediate
written notice to Peer Software of the institution of the suit or proceedings,
(ii) gives Peer Software sole control of the defense and settlement of such
suits or proceedings, and (iii) gives Peer Software all needed information,
assistance, and authority to enable Peer Software to do so.  Notwithstanding the
foregoing, Peer Software will not be responsible for, and the foregoing
indemnity obligation shall not apply to (a) any use of the Software that is not
their intended use; or (b) any modification of the Software by anybody other
than Peer Software.  In the event that Peer Software believes that any claim is
likely to occur, Peer Software may, at its sole option and expense, either (i)
secure for Customer the right to continue using such item(s), (ii) replace such
item(s) with noninfringing item(s), or (iii) require the return of such item(s)
and refund the sums paid therefor.  THE FOREGOING STATES PEER SOFTWARE'S ENTIRE
LIABILITY AND OBLIGATION (EXPRESS, STATUTORY, IMPLIED, OR OTHERWISE) WITH
RESPECT TO INTELLECTUAL PROPERTY INFRINGEMENT OR CLAIMS THEREFOR.

8.2. Customer agrees to indemnify, defend, and hold Peer Software, its
directors, officers, employees and agents harmless from all loss, liability,
claims, demands, judgments, and expenses, including, without limitation,
attorneys' fees, arising out of, or in any way connected with Customer's or its
representative(s)' use of the Software.
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9. LIMITATION OF LIABILITY.  PEER SOFTWARE'S LIABILITY ARISING OUT OF THIS
AGREEMENT AND/OR SALE WILL BE LIMITED TO REFUND OF THE PURCHASE PRICE.  IN NO
EVENT WILL PEER SOFTWARE BE LIABLE FOR ANY SPECIAL, CONSEQUENTIAL, PUNITIVE,
EXEMPLARY, INCIDENTAL OR INDIRECT DAMAGES (INCLUDING WITHOUT LIMITATION LOSS OF
PROFIT, LOSS OF DATA, LOSS OF USE, BUSINESS INTERRUPTION, SECURITY BREACH, OR
COSTS OF PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES) WHETHER OR NOT PEER
SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSS, HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY ARISING OUT OF THIS AGREEMENT.  THIS EXCLUSION INCLUDES
ANY LIABILITY THAT MAY ARISE OUT OF THIRD-PARTY CLAIMS AGAINST CUSTOMER.  THESE
LIMITATIONS SHALL APPLY NOTWITHSTANDING ANY FAILURE OF ESSENTIAL PURPOSE OF ANY
LIMITED REMEDY.

10. Confidentiality.  "Confidential Information" means any and all information
related to a party's business that is labeled or identified as "confidential" or
"proprietary"; or otherwise is of such a type or disclosed in such a way that a
reasonable person would understand that the information disclosed is
confidential or proprietary, including without limitation software, source code
and specifications, trade secrets, development plans, technical information,
business forecasts and strategies.  Without limiting the foregoing, the
Software, their structure, organization, code, and related documentation are the
"Confidential Information" of Peer Software.  Each party agrees (i) to hold the
other party's Confidential Information in strict confidence, (ii) not to
disclose such Confidential Information to any third parties, except as described
below, and (iii) not to use any Confidential Information except for the purposes
of this Agreement.  Each party may disclose the other party's Confidential
Information to its responsible employees and contractors with a bona fide need
to know, but only to the extent necessary to carry out the purposes of this
Agreement, and only if such employees and contractors are subject to a
nondisclosure agreement sufficient to protect the other party's Confidential
Information hereunder.  The restrictions set forth in this section will not
apply to any Confidential Information that the receiving party can demonstrate
(a) was known to it prior to its disclosure by the disclosing party; (b) is or
becomes publicly known through no wrongful act of the receiving party; (c) has
been rightfully received from a third party authorized to make such disclosure
without restriction; (d) is independently developed by the receiving party
without reference to the disclosing party's Confidential Information.  The
parties agree that a breach of this section may cause irreparable damage that
money cannot satisfactorily remedy and therefore, the parties agree that in
addition to any other remedies available at law or hereunder, the disclosing
party will be entitled to seek injunctive relief for any threatened or actual
disclosure by the receiving party.

11. Proprietary Rights.  The Software and Documentation contain Peer Software's
proprietary information that is protected to the maximum extent by applicable
intellectual property and other laws.  Except for the license granted under
Section 2.1, Peer Software reserves all right, title, and interest to the
Software and Documentation, including without limitation any modifications,
enhancements, improvements, customizations, maintenance releases, revisions, or
derivative works thereof.  There is no implied license, right or interest
granted in any copyright, patent, trade secret, trademark, invention, or other
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intellectual property right under this Agreement.

12. Miscellaneous.  This Agreement will be governed by and construed under the
laws of the State of Virginia without regard to any conflict of laws provisions.
 The federal and state courts in Fairfax County, Virginia will have exclusive
jurisdiction and venue to adjudicate any dispute arising out of this Agreement.
 This Agreement sets forth the entire agreement and understanding of the parties
relating to the subject matter hereof and supersedes all prior discussions,
proposals, and understandings between them.  Without limiting the generality of
the foregoing, this Agreement will supersede the terms of Customer's form of
purchase order, acknowledgment, or other business forms notwithstanding Peer
Software's acceptance or acknowledgment of such business forms.  No modification
of or amendment to this Agreement, nor any waiver of any rights under this
Agreement, will be effective unless set forth in writing signed by officers of
both parties hereto.  Customer agrees not to export the Software in violation of
the laws and regulations of the United States or any other nation.  In no event
may Customer assign this Agreement or its rights and obligations under this
Agreement.  Peer Software shall have the right to assign this Agreement to any
successor to its business or assets to which this Agreement relates, whether by
merger, sale of assets, sale of stock, reorganization, or otherwise.  This
Agreement will be binding upon and inure to the benefit of the parties hereto,
their permitted successors and assigns.  If any provision of this Agreement is
held to be illegal or unenforceable, that provision will be limited or
eliminated to the minimum extent necessary so that this Agreement will otherwise
remain in full force and effect and enforceable.  The failure of either party to
enforce its rights under this Agreement at any time for any period will not be
construed as a waiver of such rights.  Any notices or communication under this
Agreement will be in writing and will be hand-delivered, sent by registered or
certified mail return receipt requested, by nationally-recognized express
courier with a tracking system, or by confirmed facsimile transmission to the
party receiving such communication, at the receiving party's address set forth
on the applicable ordering document, or such other address as a party may in the
future specify to the other party.

PeerSync Installation

PeerSync is shipped (downloaded) in a full installation program. To run, simply double-click
on the executable in the Explorer window, or choose "Run" from the Start Menu and then
select the application. For networked installations, PeerSync supports silent installation by
adding "/S" to the installation application's command line.

Example: %PATH%/peersync_architecture_version.exe/S

See Additional Configuration Entries for more Information on silent installation
configuration.

Note: Adding /S /A INSTALL.LOG to the Uninstall.exe command line will perform an automatic silent uninstall of
PeerSync. 

Additional Configuration Entries

PeerSync and the PeerSync installation (peersync_architecture_version.exe) use a
configuration file (PSDef.cfg) to read and set options during and after installation.  If a
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PSDef.cfg file is located in the same folder as peersync_architecture_version.exe before
installation, this file will be automatically copied to the PeerSync installation folder during
installation.

Pre-Installation Configuration Options

The following options are available before installation and are used during manual
and silent installs:

Installation
Folder

This option can be set to any directory path and designates what
directory to install PeerSync into.

Disable
Install
Reboot

This option can be set to 'Yes' or 'No' and allows you to suppress the
rebooting (if needed) of your computer after installation. 

Install
PSProfiler

This option can be set to 'Yes' or 'No' and allows you to decide if the
PSProfiler interface is to be installed.

Install
PSWizard

This option can be set to 'Yes' or 'No' and allows you to decide if the
PSWizard interface is to be installed.

Install
SNMP

This option can be set to 'Yes' or 'No' and allows you to decide if files
needed for SNMP are to be installed (SNMP is only available in the
Enhanced Package).

Create Start
Menu
Shortcut

This option can be set to 'Yes' or 'No' and allows you to decide if
shortcuts related to the PeerSync installation will be added to the Start
menu.

Post Installation Configuration Options

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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The following options are used by PeerSync and other installed applications after
install:

User Name This is used to set the Registration or Evaluation information to be read in
by PeerSync.

Company
Name

This is used to set the Registration or Evaluation information to be read in
by PeerSync.

Options This is used to set the Registration or Evaluation information to be read in
by PeerSync.

Password This is used to set the Registration or Evaluation information to be read in
by PeerSync.

TempFolder This option can be set to any directory path and will be used for a
temporary folder PeerSync to use.  If the path does not exist, an attempt
will be made to create it.  If it cannot be created, the default will be used
which is the logon users system Temp path.

Registration and Passwords

If this is an unregistered or Evaluation Copy of PeerSync, you can register it with Peer
Software, Inc. as a fully licensed copy by providing credit card information via phone or
secure Internet registration, or by sending a check or money order to the address below
(see included "readme.txt" file for pricing information).  As an integral component of
PeerSync 9.5 and all subsequent versions, the Profiler application is included as part of
registration. 

For more information on registering PeerSync, please visit
https://www.peersoftware.com.

Upon registering PeerSync, user information will be generated according to the name and
company name (if any) you specified during registration, as well as a password specific to
the product version you have licensed. This information will be emailed to you and will be
used to activate your current copy. Additional license fees must be paid for multi-user use.

PeerSync may not be commercially distributed or distributed by government agencies
including their contractors UNLESS registration fees are paid for by the distributing party.

See License agreement for product redistribution.

Please visit https://www.peersoftware.com for different versions of PeerSync and types of
licensing we offer.

Note Regarding Updates:  As new updates/changes become available, updated versions of the software will be
posted at https://www.peersoftware.com.  Check this page periodically to download the latest executables.  Your
Authorization Key will continue to work with updated versions unless a major release is issued, or PeerSync is
installed in a different folder than the previously installed/authorized version.

Entering Your User Information and Password

Through an Evaluation Copy of PeerSync:

After registration with Peer Software, Inc., you will receive Registration Information
generated which is from the information you provided during registration. The password

http://www.peersoftware.com/purchase/registration.aspx
https://www.peersoftware.com
https://www.peersoftware.com
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you receive will be specific to the PeerSync product you have licensed and registered with
Peer Software. Upon entering valid password and user information into your Evaluation
Copy, that copy will be immediately converted to a fully licensed version of the appropriate
PeerSync product. The instructions below apply to a "Registered Evaluation Copy" of
PeerSync, that being one whose evaluation period is still active.

To activate your registered and licensed PeerSync product, first run your Evaluation Copy
of PeerSync. Then choose "About" from the Help Menu located on the far right of the
Profiler Menu Bar. To activate your registered and licensed PeerSync product, first run your
Evaluation Copy of PeerSync. Then choose "About" from the Help Menu.

 Located on the far right of the Profiler Menu Bar. This opens the About PeerSync screen,
which contains "User Name," "Company", "Options" and "Password" fields.

Be sure to enter this information exactly as you received it, with the same spacing,
hyphenation, punctuation, and cases (i.e. if a comma or period contained within a company
name is omitted, registration will not be accepted). It is advisable to cut-and-paste
passwords directly from the Email registration information. If passwords are typed using
lower case letters where upper cases have been indicated, or if other information is typed
incorrectly, the message shown below will be displayed. This message indicates that
registration was unsuccessful; shows the number of attempts made to register, and
contains' a link to Peer Software's website. You will only be allowed a limited number of
attempts before the application closes entirely and will need to be opened again in order to
retry.

If registration is successful, your will receive a success dialog. Your Evaluation Copy will
have been immediately activated as a registered version of the PeerSync product you have
licensed, with this change indicated on the interface title bar. Click "OK" on the success
dialog to begin usage of your newly activated PeerSync product. You will not have to exit
and restart the application to do so.
 
Through an Unregistered Copy of PeerSync: 

Unregistered copies of PeerSync are Evaluation Copies whose evaluation period has
expired, or copies into which a valid password and user information has not yet been
entered. These copies can still be activated as fully licensed versions of whichever
PeerSync product whose usage you have purchased from Peer Software, Inc.

After registration with Peer Software, you will receive Registration Information which is
generated from the information you provided during registration. The password you receive
will be specific to the PeerSync product you have licensed. 

To activate your copy of PeerSync as a fully licensed version, first run the copy. Because
your copy is unregistered, the application will not open in its entirety, instead an About
PeerSync screen will open. This screen contains "User Name," "Company", "Options" and
"Password" fields.

Be sure to enter this information exactly as you received it, with the same spacing,
hyphenation, punctuation, and cases (i.e. if a comma or period contained within a company
name is omitted, registration will not be accepted). It is advisable to cut-and-paste
passwords directly from the Email registration information. If passwords are typed using
lower case letters where upper cases have been indicated, or if other information is typed
incorrectly, the message shown below will be displayed. This message indicates that
registration was unsuccessful; shows the number of attempts made to register, and
contains' a link to Peer Software's website. You will only be allowed a limited number of
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attempts before the application closes entirely and will need to be opened again in order to
retry.

If registration is successful, your will receive a success dialog. Your copy will now have
been immediately activated as a registered version of the PeerSync product you have
licensed. Click "OK" on the success dialog to begin using your registered copy: the About
PeerSync screen will close and the full application interface will be displayed. You will not
have to exit and restart the application to begin usage.

TERMS AND CONDITIONS

READ THE LICENSE AGREEMENT BEFORE USING THIS PROGRAM. 

Please send any suggestions, comments or requests for support to the proprietor of
PeerSync:

Peer Software, Inc.
5900 Fort Drive , Suite 415
Centrevile, VA 20121

Phone: 703.763.7700
Fax: 703.763.7705
Web: https://www.peersoftware.com

Upgrade Information

Visit https://go.peersoftware.com/peersync-upgrade-requests to get the latest version of
PeerSync. 

Check this page periodically to download the latest executables. Your Authorization Key
will continue to work with updated versions unless a major release is posted.

To Upgrade PeerSync and PSListener

Major product upgrades such as v9.4 to v9.5 will require a new product key. Users
currently on annual maintenance must fill out the request for upgrade form to receive the
upgrade license key before downloading v9.5.x. Users not on annual maintenance must
contact sales for upgrade pricing.

The following document outlines the steps to upgrade PeerSync and PeerSync Listener
(ByteReplicator - TCP WAN Connector/PSListener Agent) from one version to the next:
https://kb.peersoftware.com/peerkb/peersync/peersync-how-to-articles/upgrade-peersync-
andpeersync-listener

https://www.peersoftware.com
https://go.peersoftware.com/peersync-upgrade-requests
https://go.peersoftware.com/peersync-upgrade-requests
http://www.peersoftware.com/contact.html
https://kb.peersoftware.com/peerkb/peersync/peersync-how-to-articles/upgrade-peersync-andpeersync-listener
https://kb.peersoftware.com/peerkb/peersync/peersync-how-to-articles/upgrade-peersync-andpeersync-listener
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Interface Features

The manufacturer of PeerSync makes no warranties, implied or otherwise, for use of this product. User assumes all
responsibility for any data loss or damage.

Copyright © 1993-2021 Peer Software Inc. All Rights Reserved. Privacy Policy

PeerSync is a registered trademarks of Peer Software, Inc.
Reproduction in whole or in part without permission is strictly prohibited.

The PeerSync Help Manual was built on Tuesday, June 1, 2021

Getting Started

The Profiler is used to create PeerSync Profiles. A Profile can contain as many as 255
individual synchronization tasks, or Jobs. A Job is defined by identifying a Source Folder, a
Target Folder (to which the contents of the Source will be synchronized), and then
choosing from more than 80 easily specified Job Settings. These settings determine which
contents will be synchronized, in what manner, and when they will be synchronized --
according to your choice of Real-Time, Scheduled, or manually initiated operations.  

The process of building a Profile is made quick and simple by allowing you to easily create
Jobs and then follow the sequentially arranged list of Settings screens accessed through
the Selection Tree, which is located on the left side of the application interface. The user
begins by first selecting a single Job or Multiple Jobs from the Profile Job List. Then
specific synchronization criteria is applied to the selected items using Job Settings. Once
synchronization criteria has been configured for each Job, Run/View Current Profile
window is used to launch the entire Profile. By offering a Tool button Toolbar as well as
separate Selection Tree and Profile Job List windows, Profiler's browser-based interface

http://www.peersoftware.com/our-privacy-policy.html
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allows you to easily view, create, copy, rename, move, or delete Jobs regardless of which
Settings screen is currently being displayed.

Product Definitions

Synchronization Updating any existing files or adding new files in the Target
Folder using the Source Folder as the guide. When
completed, the Target Folder should contain all of the files in
the Source Folder with matching content and time stamps.

Replication Same as synchronization, except files that are in the Target
Folder that do not have a matching Source File will be
deleted.

Profiles A Profile is a description of a complete synchronization
scenario. Profiles can contain many Source-Target
combinations allowing the end-user to define very detailed file
synchronizations and run them all within a single request. For
example, you could build a Profile that contains Multiple
Source and Target Folders such as:

Source = C:\My
Documents

Target = \
\SERVER1\USERS\TEST\My
Documents

Source = D:\LocalData Target = \
\SERVER2\USERS\TEST\LocalD
ata

Source = C:
\WINDOWS\Profiles

Target = \
\SERVER3\USERS\TEST\Profiles

Each of these Source-Target entries can then be further
detailed with more than 65 options each making each entry a
completely self-contained process while still allowing it to be
run as part of a bigger set or Profile. 

Jobs A Job is a single entry in a Profile. A Profile can contain from
one to 255 Jobs and each Job contains more than 80
individual option settings.

Real-time Mode In this mode of operation, PeerSync will automatically detect
changes made to the Source Folder(s) and execute the
synchronization options selected for the matching Job.
Typically, the Target Folder is updated with the Source Folder
change within moments of the change. Note that PeerSync
may have completed the operation before Windows actually
displays the change in the Target Folder Explorer window.

Scheduled Mode In this mode of operation, PeerSync will execute the
designated Job at the selected time. Each Job in the Profile
can have the same or different time interval.

Product Support All support of PeerSync will be handled on our web site
support page located at
http://www.peersoftware.com/support/submit-a-case.html.

http://www.peersoftware.com/support/submit-a-case.html
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PeerSync is fully supported under all NT based platforms of
Windows but should first be evaluated on each machine in
which you wish to register the product on. PeerSync is no
longer fully supported under Windows 9x platforms.

Notes:  

1. The Profiler is not meant to be running persistently on the Desktop. Rather it should be accessed to
create/modify Profiles and to view the status of running Jobs. 

2. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

Tool Buttons

Profiler offers simple buttons allowing you to easily modify the current Profile and its Jobs,
regardless of which screen has been chosen from the Selection Tree. These buttons can
be hidden by unchecking the "Tool Buttons" option, accessed through the "Toolbars" item
on the View Menu. Even if this Toolbar has been hidden you will still be able to access its
options by using the File, Edit, and Job Menus. You can also change the placement of
these buttons by clicking on the left side of the Toolbar and dragging it to rest above or
below the Profile Description Toolbar. 

Tool Buttons Toolbar

The following descriptions are listed in the order in which they appear left to right on the
Tool Buttons Toolbar and are all accessible via the application Menus.

New Profile Located on the far left of the Toolbar, this button creates a new Profile. If
another Profile containing unsaved changes is currently open when this
button is pressed, a dialog box will open asking you if you want to save
changes to the current Profile before opening a new one (See Save
Profile Button Below). If you choose "No," the new Profile will replace the
current one and no changes will be saved.

Note:  If the current Profile has not been previously saved and "No" is chosen, the entire
Profile will be lost. 

Open Profile This button displays a "Select Profile File" dialog box allowing you to
open an existing Profile. By default, it will open in the path in which
PeerSync has been installed (i.e. C:\Program Files\PeerSync). Links to
previously opened Profiles can be accessible through a drop-down list
opened by clicking on the arrow key attached to this button.   

Save Profile This button allows you to save new Profiles, or save changes made to
existing Profiles. If you are saving a new Profile, a "Save As" dialog box
will open allowing you to name and store it as an .SNC file in your choice
of folders, with "NewProfile" as the default name and the path in which
PeerSync has been installed as the default directory. Profiles and Profile
modifications must be saved in order to be subsequently accessible. 

Launch
Current

This feature will launch the current Profile (Job/Global settings). During
this process, an instance of PeerSync will be started with the current

http://www.peersoftware.com/support/submit-a-case.html
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Profile Profile as the first parameter and the arguments selected from the
Options/Commands screen as the subsequent parameters. You can
automate this process via a shortcut, through the startup folder, in the
registry or as a service by selecting one of these features from the
StartUp Services screen. 

Note: An active Profile must be stopped/restarted in order for any configuration changes to

take effect. 

Terminate/S
top Active
Profile

This option, when available, will allow a user to terminate an instance of
PeerSync that contains an active Profile that is connected to the Profiler. 

Restart
Active
Profile

This option, when available, provides intelligent restart functionality that
eliminates/improves scanning upon PeerSync service/application restart.
This greatly improves performance during a restart (most commonly due
to profile changes, but also for any other reason). 

Note: An active Profile must be restarted in order for any configuration changes to take
effect. 

Connect:
Enable Job
Control
Mode

This tool button becomes visible when the Profiler has been started and
is in a running state. The option connects the configuration Profile to the
running PeerSync. When selected, this option changes the Job List
Display into Job Control Mode. 

Disconnect:
Enable
Configuratio
n Mode

This tool button becomes visible when the Profiler is running as a service
and Job Control Mode has been enabled. When selected, this option
changes the Job List Display into the default Configuration Mode. 

Add Job This button adds a Job to the bottom of the current list (See Profile Job
List). Jobs are named "New Job Item" and assigned a number by default.
If you have selected "Use Wizard to Add New Jobs" from the Options
Menu, the Wizard application will open when this button is pressed. The
Wizard provides a guided, step-by-step method for creating and
configuring new Jobs. A drop-down list attached to this button also allows
you to choose between "Add Job With Wizard" or "Add Job With
Defaults" options. If the former is chosen, Wizard will open every time
this button is pressed. If the latter is chosen, new Jobs added to the list
through this button will be configured manually using Selection Tree
screens. These Jobs will use whichever default settings are currently
applied (See Job Menu, "Save Defaults"). 

Note:  The first time "Add Job With Wizard" is chosen from the drop-down list, the Wizard
application will open. After that point Wizard will be launched by pressing the Add Job
button.  

Copy Job Creates a copy of the currently selected Job and places it at the bottom
of the Profile Job List. Copies will be numbered by default and named
after the original (i.e. "Copy 1 of My Syncs").

Rename Job Allows you to rename the currently selected Job. Jobs can also be
renamed manually by clicking on them after they have been highlighted.  

Delete Job Deletes the currently selected Job(s). When this button is pressed, a
dialog box will open asking you to confirm deletion. Jobs can also be
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deleted by selecting them and then pressing the DELETE key on your
keyboard.

Move Job
Up

Moves the currently selected Job up one place within the Profile Job List.

Move Job
Down

Moves the currently selected Job down one place within the Profile Job
List.

Show
Selection
Tree

Shows or hides the Selection Tree. If the Tree has been hidden, its space
will be filled within the interface by the currently selected Settings screen.
When the tree is hidden, screens can still be selected using the drop-
down list attached to the Back button. 

Job View Click the down arrow button next to this option to see the entire list of
settings that can be used to alter the view of the Job list. 

Select Columns This option is available only when the Details view
mode is set. It is used to define the exact columns to
display in the Job list. Options include Source, Target,
Group, Modified, and State.

Large Icons Select this option to represent each Job as a large
icon in the Job list panel.

Small Icons Select this option to represent each Job as a small
icon in the Job list panel

List Select this option to represent each Job as a list in
the Job list panel.

Details Select this option to represent each Job as a detailed
list in the Job list panel. Use the Select Columns
option to customize the view to show only the desired
columns.

Group by This option is only available when the Large Icons,
Small Icons, or Details view modes are selected. Use
this option to group the Jobs based on the following
categories: Source, Target, Job Group, Job State,
and Modified. 

Options This option is only available when the Details view
mode is selected. Use this option to customize the
look of the Job list panel by selecting: Show
Columns, Show Grid Lines, or Row Select. 

Back Opens the screen located immediately above that, which is currently
being displayed. Settings screens can also be accessed using the drop-
down list located on the right side of the Back button; list items follow the
same order as that shown on the Selection Tree. 

Next Opens the Profile Options screen located immediately below the screen
currently being displayed.
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Help Manual Opens the application help file. You may also access specific parts of the
help file for features you are currently observing by pressing 'F1' on your
keyboard.

Profile Description

This field is located bellow the Tool Buttons Toolbar by default and displays a textual
description of the current Profile. By default the description for an unsaved Profile will read
"Profile Job List." Unless you enter a unique description into this field, a default description
will be assigned upon saving the Profile; this default description will match the new Profile
name.

Descriptions can be changed at any time; like all Profiler configurations, they must be
saved prior to closing the Profile or application in order to be stored. The Profile Description
can also be hidden by unchecking the "Profile Description" option, accessed through the
"Toolbars" item on the View Menu.

Menus

1.  File Menu

File

This menu includes items allowing you to create and save new Profiles, open existing
Profiles, create Profile desktop shortcuts, and exit the application. 

New Create a new Profile. This feature is accessible from the Tool
Buttons Toolbar.

Open Open an existing Profile. This feature is also accessible from
the Tool Buttons Toolbar.

Reopen Reopen a recently used Profile.

Save Save the current Profile. This feature is also accessible from
the Tool Buttons Toolbar.

Save as Rename and Save the current Profile.

Profile - Revert to
Saved

Revert to the last saved settings of the current Profile. 

Profile - Merge Existing Merge an existing Profile into the current Profile.

Profile - Create
Shortcut on Desktop

Create and add a shortcut to PeerSync of the current Profile
and settings/command line arguments to the desktop.

Profile - Save Defaults Save the current settings of the Profile as the default settings.

Exit Close/exit the application.

2.  Edit Menu

Edit
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Allows you to move one step up or down between Selection Tree options screens while
providing a shortcut to the Run/View Current Profile Activity screen.

Back Move back to the previous screen. This feature is accessible
from the Tool Buttons Toolbar.

Next Move on to the next screen. This feature is also accessible
from the Tool Buttons Toolbar.

Run/View Current
Profile 

Go to the Run/View Current Profile Activity screen.

3.  View Menu

View

Allows you to change the appearance of the application interface. "Hint" items enable or
disable pop-up hints activated by passing the mouse pointer over interface features, as
well as those displayed in the Status Bar located at the bottom of the application
interface. In addition to a description of Profiler features, hints will identify command line
arguments associated with those features (if any).

Toolbars - Tool Buttons Show/hide the Tool Buttons Toolbar.

Toolbars - Profile
Description

Show/hide the Profile Description Toolbar.

Toolbars - with Hot
Tracks

Show/hide the hot tracks features for the Toolbars.   

Toolbars - with Text
Labels

Show/hide description text labels for the Toolbars.

Selection Tree Show/hide the Selection Tree left side panel. This feature is
also accessible from the Tool Buttons Toolbar.1

Refresh Current Profile
Activity

Refresh Profile activity.

Status Bar Show/hide the Status Bar at the bottom of the application.

Hints - on Application Show/hide pop-up hints displayed on the application.

Hints - on Status Bar Show/hide hints displayed on the Status Bar.

Folders Allows for the ability to launch and display Source and Target
Folder selections in organized Explorer windows in a set
viewing area. This helps the user to view and/or validate the
Source and Target Folder content before, after, and during
synchronization. These features may be helpful during
evaluation and when running and testing a newly modified
Profile.  

Job Groups Similar to Microsoft's Multiple Document Interface (MDI),
PeerSync now contains a multi-pane interface that allows the
user to organize groups of Jobs (Source and Target pairs) by
any convention necessary. User-specified tab controls allow
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quick transition from one group to another. The traditional Job
list interface is still available for those who do not need the
group panes.

Profile Messages Open the Profile Message Log file if it exists. The naming
convention of the Message Log files is as follows:
Profile.snc.log, where Profile represents the name of the
current Profile. 

4.  Options Menu

Options

Allows you to select options pertaining to the way PeerSync, the Profiler and the Wizard
interact with each other and Windows Explorer.

Use Wizard to Add
Jobs

Available only if the Wizard is installed during the PeerSync
installation. If selected, directs Profiler to open the Wizard
application as an easier and simpler way to add new Jobs to a
Profile. If not selected, the Add Job option will use the saved
Job defaults. This feature is toggled on or off depending on
which option was used the last time that a Job was added
(with Defaults or with Wizard).

Create SNC extension
association

If selected, creates an association of any file that has an SNC
extension with the Profiler to be used as the default
application to open these files. If not selected, the association
of SNC files with the Profiler will be removed. This feature is
also accessible from the  Startup Services screen.

Add Quick-Sync Folder
option to Explorer
menu

If selected, will add our Quick-Sync feature to Windows
Explorer. To access this feature, simply right-click on any
folder in Explorer, or on your Desktop, and you will be able to
sync the folder to selected Target Folder(s), add the Job to a
Quick-Sync Profile that is stored out in memory, and
administer the ability to modify/add to the Jobs using the
Profiler. This feature is also accessible from the Startup
Services screen. 

Check For Modified
Profile

If checked, this option will activate a timer to check if a
change occurred to the Profile every 3 seconds and will
prompt for a reload. 

On Profile Exit This option allows for the ability to do one of the following
when exiting the Profiler while it is connected to an Active
Profile: Display Terminate Active Profile Dialog, Leave Active
Profile Running, or Terminate Active Profile.

Global Settings Displays various settings including Recovery/Offline Options,
Performance Options, Reporting Options, Display Options,
ACL Options, Bi-directional Options, Managed Files Options,
and Current Command Line Arguments.
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5.  Run Menu

Run 

Allows you to Launch the Current Profile, Terminate the Active Profile and Update the
Current Profile.

Note: An active Profile must be restarted in order for any configuration changes to take
effect. 

Launch Current Profile This feature will launch the current Profile (Job/Global
settings) in PeerSync. During this process, an instance of
PeerSync will be started with the current Profile as the first
parameter and the arguments selected from the
Options/Commands screen as the subsequent parameters.
You can automate this process via a shortcut, through the
startup folder, in the registry or as a service by selecting one
of these features from the Startup Services screen. This
feature is also accessible from the Tool Buttons Toolbar. 

Terminate Active
Profile

This option, when available, will allow a user to terminate an
instance of PeerSync that contains an active Profile which is
connected to the Profiler. This feature is also accessible from
the Tool Buttons Toolbar.

Update Current Profile This option, when available, will allow a user to update an
instance of PeerSync with the current Profile opened in the
Profiler.

Restart Active Profile This option, when available, provides intelligent restart
functionality that eliminates/improves scanning upon
PeerSync service/application restart. This greatly improves
performance during a restart (most commonly due to profile
changes, but also for any other reason). 

Pre-Sync Report This executes a pre-sync report of the currently selected
Jobs. During this process, files and folders will not be
modified and persistent arguments set for the current Profile
will be ignored. A report will be created and displayed with the
work that would be performed if a synchronization was
actually run. This feature may be quite helpful during
evaluation and when running and testing a newly modified
Profile. Pre-Sync Report options are as follows:

Run a Pre-Sync Report (do not sync files/folders)
Starts PeerSync to analyze the work that would be performed
if synchronization was actually run. During this process files
and folders will not be modified. The report file, PreSync.Log,
will be displayed at the end of the run. 

Overwrite existing Pre-Sync report files
Enabled by default, this setting overwrites the PreSync.Log
file when the Pre-Sync process completes.

Show Pre-Sync report file at end of run
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Enabled by default, this setting will open and display the
PreSync.Log report file after the Pre-Sync process
completes.

Reprocess Failed
Events

This option, when available, will allow for Failed Files to be
processed. Failed Files are files that have failed to be
replicated/synchronized possibly due to Retries being turned
off or exceeded.

Reprocess Failed
Scans

This option, when available, will allow for Failed Scans to be
processed. Failed Scans will only occur if a scan is
interrupted or cannot run and the Retry failed connection
every x minutes option is disabled.

Note:  Because it is separate from the core software engine, the Profiler allows you to create and configure new
Profiles while PeerSync runs Synchronization Operations at optimum efficiency. In both this Help file and on
Profiler screens, "Current" refers to the Profile currently being configured but not yet launched, while "Active" most
often refers to the Profile presently being run by the PeerSync engine.

6.  Job Menu

Job

Allows you to manipulate Jobs within the current Profile. If "Allow Multiple Selection" has
been checked on this menu, you will be able to select and apply settings to Multiple Jobs.

Add - Job with
Defaults 

Creates and adds a Job to the current Profile using the saved
Job defaults. This feature is also accessible from the Tool
Buttons Toolbar and the Profile Job List Pop-Up Menu.

Add - Job with Wizard Creates and adds a Job to the current Profile suing a Wizard
which guides in the creation of a Profile. This feature is also
accessible from the Tool Buttons Toolbar and the Profile Job
List Pop-Up Menu.  

Copy Creates a duplicate copy of the currently selected Job and all
of its settings. This feature is also accessible from the Tool
Buttons Toolbar and the Profile Job List Pop-Up Menu.

Rename Allows for the renaming of the selected Job. This feature is
also accessible from the Tool Buttons Toolbar and the Profile
Job List Pop-Up Menu.

Delete Allows for the deletion of the currently selected Job(s). This
feature is also accessible from the Tool Buttons Toolbar and
the Profile Job List Pop-Up Menu.

Clear All This will close the current Profile allowing for the user to
create a new Profile.

Move Up Moves the currently selected Job up one in the list. This
feature is also accessible from the Tool Buttons Toolbar and
the Profile Job List Pop-Up Menu.

Move Down Moves the currently selected Job down one in the list. This
feature is also accessible from the Tool Buttons Toolbar and
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the Profile Job List Pop-Up Menu.

Select All This will select all of the Jobs. 

Invert Selection This will change the selected state of all the Jobs.

Allow Multiple
Selection

Gives the ability to select and apply settings to Multiple Jobs.

Create Auto Job Name This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are
automatically generated based on their Source and Target
paths which make it a simple task to organize the Job list.

Log File - View Display the log file for the selected Job.

Log File - Clear Clear the log file for the selected Job.

Message Log File -
View

Display the message log file for the selected Job or profile.

Message Log File -
Clear

Clear the message log file for the selected Job or Profile.

Save Defaults Stores the currently selected Job Settings as the default for
all subsequent newly added Jobs. 

7.  Help Menu

Help

While allowing you to access Help files and the About screen, this menu also provides
demonstrations of PeerSync's Real-Time Monitoring and Scheduled Operation modes.

Demos This option allows the user to instantly run either a Real-Time
or Scheduled test Profile to demonstrate PeerSync's
synchronization capabilities. 

Web Site This menu item will have many links back to our web site for
product information, downloads, updates and support.

PeerSync Help Will open the application help file to the contents section. You
may also access specific parts of the help file for features you
are currently observing by pressing 'F1' on your keyboard.

Check for Updates... Checks whether you are using the latest version of PeerSync.
This process requires an Internet connection in order to
transmit your registration information to our web server for
validation. This feature also has the ability to check updates
for all PeerSync related products (if they are installed) directly
from the Profiler. This includes also the PSListener. A menu
option to check for updates will be displayed for all products
that have been installed.

Include Unchecked
Jobs in Support Info
File

If enabled, the Create Support Info File on the Desktop...
log and configuration gathering process will collect Job
information from un-checked Jobs.
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Create and Upload
Support Info to Peer
Software Support...

This option will compile all Profile-related files into a zip file.
This zip file can be created on the desktop and/or
automatically uploaded to Peer Software Support via an
Amazon S3 region closest to you. If you do choose to upload
to Peer Software Support, you will be required to enter a
reason for the upload.

The following is a list of files that are included if they exists: 

PeerSync Files:

[ProfileName].snc - Profile

PSDEF.CFG - Configuration File

[ProfileName]. tot.xml - Total Support File

[ProfileName]_np. tot.xml - Total Support File (Non
Persistent)

[ProfileName]. cur.xml - Current Support File 

[ProfileName]_np. cur.xml - Current Support File (Non
Persistent)

[ProfileName].las.xml - Last Support File

[ProfileName]_np.las.xml - Last Support File (Non
Persistent)

[ProfileName].snc[.bak*].log - Profile Error Log Files

PSError.Log - Application Error Log File

[JobName].[bak*].log - Job Level Log Files

[JobName].flt[.bak*].log - Job Level Error Log Files

[JobName].del[.bak*].log - Deletion Cleanup Log Files

[ProfileName].tlr - Time Last Run Log File

[%VariableNames%].txt - Also included are Variable
Data Import and Job Data
Import files

ADDCache.cur.txt - Current cache file of Add
events

ADDCache.las.txt - Last cache file of Add events

UPDCache.cur.txt - Current cache file of Update
events

UPDCache.las.txt - Last cache file of Update
events

DELCache.cur.txt - Current cache file of Deleted
events

DELCache.las.txt - Last cache file of Deleted
events

JSCCache.cur.txt - Current cache file of Job
Scans

JSCCache.las.txt - Last cache file of Jobs Scans

EXCCache.cur.txt - Current cache file of
Excluded items

EXCCache.las.txt - Last cache file of Excluded
items

FFLCache.cur.txt - Current cache file of Failed
Events
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FFLCache.las.txt - Last cache file of Failed
Events

JSHCache.cur.txt - Current cache file of
Historical Data

JSHCache.las.txt - Last cache file of Historical
Data

MSGCache.cur.txt - Current cache file of
Messages

MSGCache.las.txt - Last cache file of Messages

CTPCache.cur.txt - Current cache file of Copy
Thread Progress

CTPCache.las.txt - Last cache file of Copy
Thread Progress

SNCCache.cur.txt - Current cache file for the
Profile

SNCCache.las.txt - Last cache file for the Profile

MFLCache.cur.txt - Current cache file of
Managed Files List items

MFLCache.las.txt - Last cache file of Managed
Files List items

SupportInfo.txt - Contains the list of files that
PeerSync will try to include in
the support zip folder

PeerLock Files:

PLDef.CFG - Configuration File

PeerLock[.bak*].log - PeerLock Log Files

 The files will be zipped and stored on the Desktop for easy
attachment to emails.  A copy of the zipped folder will also be
stored in the PeerSync installation folder (i.e. C:\Program
Files\PeerSync\InfoFiles\SupportInfo_date/time .zip). 

Create and Upload
System Info to Peer
Software Support...

Creates a system info file (SysInfo.nfo). A copy of this file will
be kept in the InfoFiles folder located in the PeerSync
installation folder (i.e. C:\Program
Files\PeerSync\InfoFiles\SystemInfo_200810081953.zip -
where 200810081953 represents yyyymmddhhss
respectively). Creating the System Information File takes a
few minutes. Keeping a copy of the System Information file in
the InfoFiles folder eliminates the need to wait for the creation
of a new file whenever one is needed and provides an archive
of previous system states that can be used for
troubleshooting.

This System Info file can be created on the desktop and/or
automatically uploaded to Peer Software Support via an
Amazon S3 region closest to you. If you do choose to upload
to Peer Software Support, you will be required to enter a
reason for the upload.
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Register PeerSync Will display the PeerSync Registration Screen to activate the
PeerSync trial version or upgrade the current license.

License Information Will display the different Product Editions and Licensing
available for PeerSync. Will also display what the current
edition has available as well as other useful information about
the current package you are running.

About PeerSync Will display an about screen, which contains information
about the current PeerSync you are running.

8.  Popup View Menu

View Popup Menu

Activated by right clicking on the Tool Buttons Toolbar, Profile Description Toolbar, or the
Status Bar. Some of these options can be selected from the View Menu.

Tool Buttons Show/hide the Tool Buttons Toolbar.

Profile Description Show/hide the Profile Description Toolbar.

with Hot Tracks Show/hide the hot tracks features for the Toolbars.   

with Text Labels Show/hide description text labels for the Toolbars.

Status Bar Show/hide the Status Bar at the bottom of the application.

9.  Popup Tray Icon Menu

PeerSync Tray Icon Popup Menu

Activated by right clicking on the Tray Icon. The Tray Icon is only accessible when
PeerSync is running as an application (not as a service) and has the "Show tray icon"
option enabled in the Options/Commands window. 

View Log File Allows you to access, launch and view Log files in the default
text editor for the current Profile.

View Message Log File Allows you to access, launch and view the Message log file
for the current Profile.

View Admin Folder Allows you to access, launch and view Admin log file Folders
in Explorer for the current Profile.

Open Source Folder Allows you to access, launch and view Source Folders in
Explorer for the current Profile.

Open Target Folder Allows you to access, launch and view Target Folders in
Explorer for the current Profile.

Show Status Display This item will show the PeerSync Status Display dialog box
during synchronization so the user can see activity, status,
and other information while PeerSync is running. This feature
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is only available if the Display Status in the PeerSync feature
was enabled for the current Profile.

Connect/Launch
PeerSync Profiler

This item will open the Profiler, if it is not already open, and
send status messages to be displayed on the Run/View
Current Profile Activity screen. This connection feature will
only work if the Display Status in Profiler feature was enabled
for the current Profile.

About PeerSync Will display an about screen, that contains information about
the current PeerSync you are running.

Exit PeerSync Allows you to close/exit the current session of PeerSync.

Note: A pop-up hint message will be displayed when you mouse over the Tray Icon. This will provide key
information about the current PeerSync application running including the Profile name and the status of VSS if it is
running. 

10.  Profile Job List

Located beneath the Toolbars, this window displays all Jobs associated with the current
Profile. Use of this list is central to the Profile-building process; all configurations made on
the Job Settings screens (accessed through the Selection Tree) will only be applied to
those Jobs currently selected from this list. 

To select a Job, highlight it using the left mouse button. The "Allow Multiple Selection" item
must be checked on the Job Menu in order to select and have settings applied to Multiple
Jobs. To select Multiple Adjacent Jobs, highlight the first Job, hold down the SHIFT key on
your keyboard, and then highlight the last Job you wish to include. You can also hold down
the SHIFT key and then use the up or down arrow keys on your keyboard. To select
Multiple Nonadjacent Jobs, highlight the first Job, then hold down the CTRL key on your
keyboard and click on each additional Job you wish to include. Once you have selected a
Job or Jobs, move through the screens found on the Selection Tree and apply settings as
desired. Highlighting on the selected Job(s) will appear gray as you move through these
screens, indicating that any configured settings will only be applied to those selected Jobs. 

The box appearing to the left of each Job must be checked in order for that Job to be
included in the active Profile when launched. Although unchecked Jobs will not be
processed upon launch, they will be saved within the Profile for future use and/or
selection. 

Upon creating a new Profile, an initial Job will be displayed bearing the name "New Job
Item 1" by default (this applies to manual Job creation only). The first New Job added within
an existing Profile will also bear this name. Successive Jobs will be named "New Job Item
2," "New Job Item 3," etc. Any selected Job can be renamed through the "Rename" Tool
Button, through items found on both the Job Menu and Profile Job List Pop-Up Menu
described below, or manually by selecting it a second time using the left mouse button.

In both new and stored Profiles, you can navigate the Profile Job List as well as add, copy,
delete, and navigate Jobs using the Tool Buttons; using items from the Job Menu, and by
using items found on the Profile Job List Pop-Up Menu described below. You can also
navigate the list and delete items using the DELETE and up and down arrow keys on your
keyboard. 
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Note:  In order to navigate or modify the Profile Job List, you must have first clicked somewhere within the Profile Job
List window; this ensures that during configuration any options chosen from the Selection Tree screens are applied
exclusively to the currently selected Job. 

The height of the Profile Job List window can be changed by passing the mouse pointer
over its bottom border until a double/Arrow cursor appears, then dragging the window to
meet the desired size. At minimum size, only a single Job may be viewed. Adding a new
Job while this view is in effect prompts display of up and down arrow buttons in the right
side of the window. These buttons allow you to view different Jobs within the list. 

Job List Pop-Up Menu

Activated by right clicking on the Profile Job List, this menu duplicates the mostly used
features found on the Job Menu while providing some additional items listed below. 

Synchronize Selected
Jobs 

This executes an immediate, non-persistent synchronization
of the currently selected Jobs ("non-persistent" refers to a
one-time sync process; "persistent" refers to ongoing sync
operations such as Real-Time Monitoring or Scheduled
Operations). During this process, persistent arguments set for
the current Profile will be ignored. When the button is
released, a confirmation dialog will be displayed indicating
which Jobs have been selected from the active Profile and
asking you to confirm synchronization through a "Yes" or "No"
button. If "Yes" is selected, the synchronization will proceed.
A message will always be displayed upon completion of this
operation. Other sync operations allow you to choose
whether or not such a message will be displayed. 

Create Pre-Sync
Report

This executes a pre-sync report of the currently selected
Jobs. During this process, files and folders will not be
modified and persistent arguments set for the current Profile
will be ignored. A report will be created and displayed with the
work that would be performed if a synchronization was
actually run. This feature may be quite helpful during
evaluation and when running and testing a newly modified
Profile.  

Connect: Enable Job
Control Mode

See description for this option under Tool Buttons. 

Disconnect: Enable
Configuration Mode

See description for this option under Tool Buttons. 

Start Pending Job:
Name

See description for this option under Job Control Mode. This
option is only available when the Job List Display is in
Control Mode. 

Start Pending Job:x See description for this option under Job Control Mode. This
option is only available when the Job List Display is in
Control Mode. 

Log File - View This menu item allows you to view Log reports by opening the
file in a text editor. This feature is also accessible from the
Reporting screen. 
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Log File - Clear This menu item allows you to clear Log reports. This feature
is also accessible from the Reporting screen. 

Message Log File -
View

This menu item allows you to view Message Log reports by
opening the file in a text editor. This feature is also accessible
from the View Menu item. 

Message Log File -
Clear

This menu item allows you to clear Message Log reports. This
feature is also accessible from the View Menu item. 

Job List View Options This feature enables/disables the ability to display the "Click
Here to Add Another Job" Job every time a new Job has been
created.

Use "<Click Here to
Add Another Job>"
Feature

This menu item will add a new Job to the end of the Job list
named "<Click Here to Add Another Job>" every time a new
Job is created.

Suppress Add Job
Confirm Dialog

This menu item will suppress the Confirmation Dialog that is
launched when clicking on the "<Click Her to Add Another
Job>" Job.

View Job Groups*
(Enhanced Package) 

This feature enables/disables the ability to allow the user to
organize/categorize Jobs within a Profile into Job Groups. 

When this feature is enabled, you can create as many Job
Groups as desired. Each Job Group is represented by a Tab.
Each Tab displays the Job Group Name, the number of
Checked Jobs and the number of Total Jobs for the
corresponding Job Group, in the following format:  GROUP
NAME [CHECKED JOBS / TOTAL JOBS]

Select All This menu item will select/highlight all Jobs within the current
Job Group for a quick and easy way of modifying all Jobs
within a given Profile. If this feature is not enabled you must
turn on the Allow Multiple Selection feature on from the Job
Menu.

Last Run On This is a display of the last run date/time of the selected Job
within the current Profile. This is the date/time that will be
used when comparing files for the Bi-directional
Synchronization Mode option on the File Options screen. This
feature is also displayed on the from the  Folder Selection
screen. 

Last Run On - Reset This allows a means of resetting the last run date/time of the
selected Job within the current Profile. 

Job Group Pop-Up Menu* (Enhanced Package) 

Activated by right clicking on the Profile Job List, this Popup menu allows for the following
features:

Add Job
Group

This menu item will create and add a new Job Group to the existing
Profile. 

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Edit or
Delete Job
Groups

These menu items will display the Modify Job Groups Dialog, allowing for
the adding, renaming, moving, re-ordering, modifying and/or the deletion
of Job Groups. 

Edit Job
Groups
Dialog

To add a Job Group click "New," then type the desired name into the field
located at the bottom of the dialog. Repeat this process for each Job
Group you wish to add. Entries can be deleted by selecting them from the
list and clicking the "Delete" key at the bottom of the box. You can also
use the "Up" and "Down" buttons to reorder the items.

All Tabs -
Check All
Jobs

This menu item will set all Jobs to the checked state allowing for a quick
and easy way of checking all Jobs across all Job Groups. 

All Tabs -
Uncheck All
Jobs

This menu item will set all Jobs to the unchecked state allowing for a
quick and easy way of unchecking all Jobs across all Job Groups. 

* Note:  Some features described on this page require the Enhanced Package.

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Selection Tree

Screens can be accessed through the Selection Tree that are used to set synchronization
criteria for individual Jobs (Job Settings), as well as set global properties relating to
execution of the entire Profile and all related Jobs (Global Settings). Once you have
selected a Job or Jobs from the Profile Job List , all options configured on Job Settings
screens will only be applied to those selections. After synchronization criteria for all
individual Jobs have been established, use the Global Settings screens to set global
properties relating to all Jobs, as well as choosing how you would like the Profile to be
executed. The Profile Job List will appear gray when any Global Settings screen is
displayed, indicating that all properties set on that screen will be applied to the entire
Profile.

Selection Tree 
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The Selection Tree is located at the left side of the Profiler interface. The Selection Tree
can also be hidden by unchecking the "Selection Tree" option, accessed through the
"Toolbars" item on the View Menu.

Selection Tree Modes The Selection Tree Modes are located in a drop-down list
above the Selection Tree. These modes can be used to
show/hide PeerSync configuration windows. The Selection
Tree can be set to Basic, Intermediate, Advanced or
Customized. Some Selection Tree items will not be
accessible depending on the package you are currently using.
 "Basic" is the default Selection Tree Mode. 

Selection Tree
Categories

New in PeerSync v7.4, customers who are running PeerLock
v2.0.1 or higher on the same machine as PeerSync will now be
able to configure PeerLock directly from the PeerSync Profiler.
Configuration options include the ability to link specific
PeerSync Profile Jobs to PeerLock, ability to access/view/edit
the PeerLock Global Settings from the PeerSync Profiler, ability
to install/uninstall the PeerLock Service, as well as launch and
view PeerLock directly from the PeerSync Profiler. 

The Selection Tree can be categorized into four sections:
PeerSync, PeerLock, Startup/Service, and Run/View. By
default these categories will not be shown unless you have
PeerLock v2.0.1 or newer installed on the same computer as
PeerSync. You can manually display these categories by
adding PeerLock  windows to the Customized tree mode.  

Selection Tree Pop-Up Menu

Activated by right clicking on the Selection Tree, this menu duplicates the items listed in
the Selection Tree, as well as, the items listed in the drop-down list located on the right
side of the Back button on the Tool Buttons Toolbar. When right-clicking on the PeerSync
Selection Tree Category, this Menu offers the following options:

Show All Profile
Options

This feature will toggle between showing all Profile Options
and the Custom Options in the Selection Tree. 

Customize This feature will allow the user to select which Profile Options
to display in the Custom Selection Tree, when the "Show All
Profile Options" is turned off. When selected the user will be
given the dialog box shown below to pick and choose which
Profile Options to use.

Selection Tree Categories
PeerSync
PeerLock
Startup/Service
Run/View

http://www.peersoftware.com/solutions/file-locking-for-ms-dfsr.html
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1.  PeerSync

1.1  PeerSync Job Settings

PeerSync Job Settings Screens
Folder Selection
Automation
Blackout Settings
Scan Limitations
File Options
NFS Settings
Permissions
Open Files
Managed Files
Performance
Byte Replicator
Revisioning
Miscellaneous
Additional Features
Exceptions
Reporting
Admin Reporting
Email Reporting
Pre/Post Process
Advanced Options
PeerSync Global Settings
Options/Commands
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Note:  Some settings are ignored when enabled in conjunction with other settings. For example, report summaries
are ignored in multiple threaded or enhanced Real-Time mode.

1.1.1  Job List Display

Topics
Configuration Mode
Job Control Mode
Job List Popup Menu

Note:  The Job List Display is the area within the Profiler listing all the Jobs and visually categorizing them
based on various modes. 

The Job List Display is the area within the Profiler lists all the Jobs and visually
categorizes them based on various modes for improved Job review. 

Configuration Mode

This is the default mode used by the Profiler. Here, each Job is categorized into one of
the following states:

Enabled All the Jobs which have a checked check box will be listed in
this category. 

Disabled All the Jobs which have an un-checked check box will be
listed in this category. 

The Job List Display is the area within the Profiler listing all the Jobs and visually
categorizing them based on various modes for improved Job review. 

The Profiler supports Job Control functionality that allows every Job to be stopped,
started, or restarted individually. To enter the Job Control mode, right click in the Job List
Display and select Connect: Enable Job Control Mode from the Profile Job List pop-up
menu. 

Job Control Mode

Active This category lists Jobs which are running successfully
without any errors. 

Active w/Errors This category lists Jobs which are running but contain errors
typically indicating connectivity issues.
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Active w/Warnings This category lists Jobs which are running but contain errors
typically indicating Failing Events. 

Inactive Lists Jobs that were disabled or were newly added and the
Profiler does not yet know information about them. As soon
as the Profile is saved, newly added Jobs will be added to the
Pending state. 

Pending Lists Jobs that were enabled or were newly added to the
running Profile but have not yet been started.

Stopped This category lists Jobs which have been stopped since the
Profile has been started.

Job Control Bar

The Job Control Bar buttons allows every Job to be stopped, started, or restarted
individually. 

Start Pending Jobs:x Start all the Jobs that are in a Pending state where x
represents the total number of Jobs that are in a Pending
state.

Start Job Start the selected Job that is in a Sopped state.

Stop/Restart Job Stop or restart the selected Jobs that are in an Active state.

Save Profile and
Refresh

When Job changes are made to the running Profile, a Save
Profile and Refresh option can be seen at the bottom right
corner of the Job List Display. Saving will refresh the Job
List Display to reflect any changes. The Job Control Bar
buttons become disabled and grayed out to indicate that
Profile changes were made which require saving. 

Note: An active Profile must be restarted in order for any configuration changes to take effect. 

Configuration Mode Columns

The following columns can be viewed in the Job List Display when in Configuration or
Control Mode:

Source Displays the source paths of the listed Jobs.

Target Displays the target paths of the listed Jobs.

Group Lists the name of the group each Job belongs to.

State Identifies the State each Job belongs to.

Modified Displays the time and date the last time a Job was modified.
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1.1.2  Folder Selection

Topics
Folder Selection Overview 
Source Folder Selection
Target Folder Selection 
Include Sub-folders
Swap Source and Target Folders 
Last Save
Last Scan
Other Features

Note:  Features listed on this page may require the TCP WAN Connector, NetApp, or NFS options.

Each Job within a Profile is initially defined by using the Folder Selection screen to select a
Source and Target Folder. The contents of a Source Folder will be synchronized to a
Target Folder according to criteria further defined on other Settings screens. Once you
have highlighted a Job or Jobs from the Profile Job List, this screen offers several different
methods to locate and select folders for synchronization. File paths can be typed manually,
or you can browse local and network drives to locate and select your desired folders. 

Source Folder Selection

The options listed on this page can be accessed from the Folder Selection window. The
following options are available for selecting a Source folder.

Using Normal Mode Select a "Normal" Source folder if you can navigate to the
desired Source directory via a Local Path, a UNC Path, or a
Mapped Drive. This selection requires that the machine on
which PeerSync is running has full access to the desired
Source directory. In some instances Network Logon may be
required. 

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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Select a Source Folder by typing the file path into the field
provided or by using the Select Source Folder Button. By
default, the Source Folder field will contain the path in which
PeerSync has been installed: in most cases this will be C:
\Program Files\PeerSync\Source. The convention outlined in
this path must be used when manually typing entries, (i.e. a
drive must be specified followed by a colon, with subsequent
folders separated by backslashes). This field is not case
sensitive, though spaces may only be entered where they are
part of valid folder names (i.e. "Program Files"). No space
should appear between slashes and folder names. This field
also supports File/Folder Path Variables. 

UNC names can be entered manually, or can be selected
from the Network Neighborhood using the "Browse for Folder"
dialog box (see Select Source Folder Button). UNC names
will appear in the form \
\COMPUTER\SHAREDDEVICE\PATH. For example: \
\SERVER11\D\USERDATA.

Starting with the release of v9.0, we now support the ability to
connect to a remote NetApp filer and register for real-time
event notification.  Please visit https://www.peersoftware.com
or contact Sales for license information.

Note:  We do not recommend using UNC paths for folders that reside on the
local machine, in this scenario you should use the local path to that folder.

Folders can also be dragged and dropped from MS Windows
Explorer into the Source Folder Field for automatic insertion.

The Source Folder Field holds a folder selection History of up
to 10 entries. They can be selected by clicking on the drop
down button located to the right of the field. 

The current path will be displayed below the Source Folder
Selection Field. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to
correct the invalid path and you exit the Source Folder
Selection field, the application will throw a message and use
the default PeerSync installation path C:\Program
Files\PeerSync\Source instead.

The Host Name and User Name & Password values (if
provided) are displayed above the Source Folder Selection
field (see Network Logon).

Using TCP Mode Select a "TCP" Source folder if the Source directory is outside
the scope of the machine on which PeerSync is running. TCP
enables access to machines not located on the same network
as PeerSync. As a prerequisite, the PSListener needs to be
installed and running on the remote Source machine in order

https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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for PeerSync to be able to communicate with it. This feature
supports encryption and compression.

Note: We strongly recommend the use of a VPN when transferring files over
the public Internet for security purposes. Otherwise, you should use our
Encryption feature with a user name and password to protect data and all
communication as it is being transferred. 

When selecting the TCP Mode for the first time the Source
TCP/Port Configuration window will open automatically for
Source Folder configuration. Otherwise, the previously
entered TCP folder path will be displayed. This path can be
manually edited by typing directly into the field provided or by
using the Configuration button. The convention outlined in
this path must be used when manually typing entries, (i.e. the
key word TCP must be specified followed by a colon, two
backslashes, the Source IP address or machine name, and
subsequent folders separated by backslashes). This field is
not case sensitive, though spaces may only be entered where
they are part of valid folder names (i.e. "Program Files"). No
space should appear between slashes and folder names.
This field also supports File/Folder Path Variables. 

The Source Folder Field holds a folder selection History of
more then 10 entries. They can be accessed by clicking on
the drop down button located to the right of the field. 

The current path will be displayed bellow the Source Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to
correct the invalid path and you exit the Source Folder
Selection field, the application will throw a message and use
the last valid TCP path specified or the default path TCP:\
\127.0.0.1\C\Source. 127.0.0.1 represents the loopback IP
address of the local host (i.e. the machine on which PeerSync
is running).

The provided Host Name and User Name & Password values
are displayed above the Source Folder Selection field. 

Related Options
Source TCP/Port Configuration
Source Folder Configuration Button
Select Source Folder Button
Explore/Open/Create Button
Source Folder Popup Menu

Notes: 

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit
https://www.peersoftware.com or contact Sales for additional information.

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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2. You cannot monitor a TCP source in Real-Time.

3. NetApp CIFS real-time support requires the NetApp option.  Please visit https://www.peersoftware.com or
contact Sales for additional information.

4. NFS real-time support requires an NFS and NetApp enabled license.  Please visit
https://www.peersoftware.com or contact Sales for additional information.

5. Bi-directional synchronization mode, as well as other non applicable features are ignored when using a TCP
Source.

6. Selecting a TCP Source and a TCP Target for the same Job is not supported.

7. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the
synchronization process (Source or Target).

We strongly recommend the use of a VPN when transferring files over the
public Internet for security purposes. Otherwise you should use our Encryption
feature with a user name and password to protect the data and all
communication as it is being transferred.

This option requires our PSListener tool to be installed on the
remote computer with identical Encryption and Port
configuration.

Source TCP/Port Configuration 

The Source Folder Configure Button is activated by clicking on the Configure button
located in right lower corner of the Source Folder panel/section. Selecting the Configure
button opens the Source TCP/Port Configuration window. Alternatively, you may right-click
on the Source Folder field and select Configure: Source Folder (See Source Folder Popup
Menu). 

TCP Configuration Tab

General Settings

Host Name Enter the IP address or machine name of the Source Folder into this filed.
You may use the machine name only if the remote Source Machine
resides on the same network as that on which PeerSync is running. 

Path on
Host

Provide the full path (i.e. C:\Documents and Settings\Source) to the
Source folder in this field. The path entered needs to be a local path
without a machine name or UNC format. This field does not validate the
existence of the path you provide therefore you must exercise great care
when doing so. If the path does not exist, PeerSync will create it during
run time as long as a valid host name or IP address has been provided
and it can find the drive letter specified.

A UNC path can be entered for the Path on Host selection for a TCP
source or TCP target.   This gives the ability to configure non-windows
to non-windows Jobs over TCP (i.e. NetApp to NetApp over TCP). 
Note: This will make use of a new NETWORK constant in the source or
target selection. 

Example: 

https://www.peersoftware.com
http://www.peersoftware.com/contact.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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TCP:\\WindowsServer\NETWORK\\NetAppSVM\vol1\Data

Care must be exercised if your PSListener contains a "Root Path". If you
specify such a path in your PSListener it will behave like an FTP server
that sets Root Paths to limit user access to the local file system. If a
"Root Path" exists on the PSListener it will limit PeerSync's ability to
access directories on the remote device. PeerSync will only be able to
access directories equal to or bellow the specified "Root Path" level
provided that it meets the Port and Encryption requirements. In no
circumstances can PeerSync access directories located above this path.
If the remote path you enter in the Path to Host  field references a
directory above the "Root Path", PeerSync will create that folder
structure at runtime bellow the "Root Path". 

Example: 

PSListener "Root Path" = C:\Backup\Users\Admin
PeerSync's "Path to Host"  = C:\Backup\My Documents
Actual Remote Source Path = C:

\Backup\Users\Admin\C\Backup\My
Documents

Note: The "Root Path" will be ignored when performing byte-level replication using Normal
Mode (i.e. Local or UNC paths). 

Port Configuration Tab

Port Configuration  

Time Out Sets the amount of time a connection will wait to complete a
data transfer before exiting and performing the failure
operation. 

Port This is the TCP Port used to communicate with the Listener
on the remote machine. This must match the port number that
the PSListener is configured for. By default both Listener and
PeerSync use port 7333.

Note: The Profiler will not support Well Known Port numbers 0 - 1023. You
must use port numbers that are greater than or equal to 1024. 

Compression Uses a lossless compression algorithm to transmit data in
fewer bits. By default Compression is disabled to achieve
faster performance. 

User Information (To be used for encryption)

This is an optional setting that allows you to specify a User Name and Password to be
used for encryption as well as authentication purposes when connecting to the remote
PSListener. In order to activate encryption or authentication, you must specify both a



PeerSync Help41

Copyright © 1993-2021 Peer Software Inc. All Rights Reserved.

User Name and a Password value.  Strong DES encryption will be used to encrypt the
data and communication as it is being transmitted over the Internet, LAN, WAN, or VPN. 

User Name The User Name can be arbitrarily chosen and is not tied to
Active Directory. However, once specified, you must enter
the same User Name entry in the PSListener Configuration
residing on the remote location. 

If you specify a User Name without a Password, the User
Name entry will be ignored and no encryption or
authentication with the PSListener will occur. 

Password The Password can be arbitrarily chosen. Once specified, you
must enter the same Password in the PSListener
Configuration residing on the remote location. 

Notes: 

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit
https://www.peersoftware.com or contact Sales for additional information.

2. You cannot monitor a TCP source in Real-Time.

3. Bi-directional synchronization mode as well as other non applicable features are ignored when using a TCP
Source.

4. Selecting a TCP Source and a TCP Target for the same Job is not supported.

5. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the
synchronization process (Source or Target).

Source Folder Configuration: Using Normal Mode

The Source folder configure button is activated by clicking on the Configure button located
in right lower corner of the Source Folder panel/section. Selecting the Configure button
opens the Source Folder Configuration window. Alternatively, you may right-click on the
Source Folder field and select Configure: Source Folder (See Source Folder Popup
Menu). 

Related Options
Detection Method - Global
Connection Manager - Global
Network Logon Settings
NetApp Settings
NetApp ONTAP | Clustered Data ONTAP Settings
Dell EMC Isilon Settings
Dell EMC Unity Settings
Dell EMC Celerra | VNX | VNX2 Settings
Nutanix Files Settings
CIFS/NFS
FPolicy Utilities

Detection Method for Real-time Monitoring

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Choose the desired detection method for the Source folder. You may choose from the
following options:

Windows Select this option to specify a local path resides on the server where
PeerSync is installed. Close the Source Folder Configuration dialog
once you have selected your desired source folder detection mode and
enter the path to the source folder in the Folder Selection screen (i.e. D:
\Path\Folder). 

Note: PeerSync must reside on the source system in order to enable Normal real-time
detection.

NetApp
ONTAP |
Clustered
Data
ONTAP

Select this option to specify the path to a NetApp cDOT SVM for either
real-time or scanning scenarios. Close the Source Folder Configuration
dialog once you have selected your desired source folder detection mode
and enter the path to the source folder in the Folder Selection screen
(i.e. \\SVM1\Share\Folder).

Note: This option can only be activated if the license supports NetApp detection. Please
visit https://www.peersoftware.com or contact Sales for additional information.

NetApp Data
ONTAP 7-
Mode

Select this option to specify the path to a NetApp 7-Mode filer or vfiler for
either real-time or scanning scenarios. Close the Source Folder
Configuration dialog once you have selected your desired source folder
detection mode and enter the path to the source folder in the Folder
Selection screen (i.e. \\NetAppFiler\Share\Folder).

Note: This option can only be activated if the license supports NetApp detection. Please
visit https://www.peersoftware.com or contact Sales for additional information.

Dell EMC
Isilon

Select this option to specify the path to a Dell EMC Isilon cluster for either
real-time or scanning scenarios. Close the Source Folder Configuration
dialog once you have selected your desired source folder detection mode
and enter the path to the source folder in the Folder Selection screen
(i.e. \\ISILON1\Share\Folder).

Note: This option can only be activated if the license supports Dell EMC Isilon detection.
Please visit https://www.peersoftware.com or contact Sales for additional information.

Dell EMC
Unity

Select this option to specify the path to a Dell EMC Unity storage device
for either real-time or scanning scenarios. Close the Source Folder
Configuration dialog once you have selected your desired source folder
detection mode and enter the path to the source folder in the Folder
Selection screen (i.e. \\UNITY1\Share\Folder).

Note: This option can only be activated if the license supports Dell EMC Unity detection.
Please visit https://www.peersoftware.com or contact Sales for additional information.

Dell EMC
Celerra |
VNX | VNX2

Select this option to specify the path to a Dell EMC Celerra/VNX/VNX2
data mover for either real-time or scanning scenarios. Close the Source
Folder Configuration dialog once you have selected your desired
source folder detection mode and enter the path to the source folder in
the Folder Selection screen (i.e. \\CEEVNX1\Share\Folder).

Note: This option can only be activated if the license supports Dell EMC Celerra/VNX/VNX2
detection. Please visit https://www.peersoftware.com or contact Sales for additional
information.

https://www.peersoftware.com
http://www.peersoftware.com/contact.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Nutanix
Files

Select this option to specify the path to a Nutanix Files cluster for either
real-time or scanning scenarios. Close the Source Folder Configuration
dialog once you have selected your desired source folder detection mode
and enter the path to the source folder in the Folder Selection screen
(i.e. \\NTNXFiles1\Share\Folder).

Note: This option can only be activated if the license supports Nutanix Files detection.
Please visit https://www.peersoftware.com or contact Sales for additional information.

 NetApp FPolicy Screening Options

Enable CIFS
Screening

CIFS Screening is enabled by default when clicking the "Set CIFS
Defaults" button in the CIFS/NFS tab.

Enable
NFSv3
Screening

NFSv3 is the only NetApp FPolicy Screening option supported when
working with NFS. This must be set when utilizing NFS detection and is
automatically selected when the "Set NFS Defaults" button is clicked in
the CIFS/NFS tab. 

Enable
NFSv4
Screening

NFSv4 screening is presently not supported.

 Event Filtering Options

Exclude
Users

Provide a list of semi-colon (;) delimited users to exclude when using non-
Default detection mode in real-time. Real-time events from the users in
this field will be excluded. Enter the desired user names in a semi colon
delimited format (i.e. user1;user2;user3).

Exclude
Extensions

Provide a list of semi-colon (;) delimited file extensions to exclude when
using non-Default detection mode during scans or in real-time. To
exclude extensions via the command line use /Q70:s, where s represents
the comma (,) delimited list of extensions to exclude
(i.e. /Q70:tmp;dwl;dwl2). Use %AUTO% for PeerSync to build a list of file
extensions dynamically. To use the %AUTO% option via the command
line use /Q70. This is the equivalent of using the /QR argument for
FPolicy only.

Exclude IP
Address
(also shown
as PeerSync
Server)

Provide a list of semi-colon (;) delimited IP addresses to exclude when
using a non-Default detection mode during scans or in real-time.

Note: For bi-directional configurations that do not filter events by other means you should
add all IP addresses for the PeerSync systems involved to this list that you do not want to
detect events from to prevent oscillation.

Allow for
remote real-
time

This option indicates whether or not the selected source folder detection
method supports real-time detection for remote paths. Presently, this

https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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configuratio
n

feature is only supported for NetApp, Dell EMC, and Nutanix
platforms.

Notes: 

1. NFS real-time support requires an NFS and NetApp enabled license.  Please visit
https://www.peersoftware.com or contact Sales for additional information.

2. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the
synchronization process (Source or Target).

The Connection Manager tracks and determines if connections are lost to source and/or
target folders. With this new capability PeerSync can proactively detect when a connection
is lost or reconnected, giving the ability to restart real-time and/or scan Jobs if needed.

Automatically use
recommended settings
based on Detection
Method

Check this option if you wish to let the Connection Manger
track the connection status on both the source and target
locations. When a lost connection is restored, PeerSync will
restart real-time and/or scan Jobs if the option to "Scan Job
once at start" is enabled. In addition, this logic will apply to
only connections which are set for real-time monitoring.

Connection Manager for Failed Connections
Choose one of the following options to manually disable or enable the
Connection Manger which tracks the connection status on the desired
locations.

Disabled Disable the Connection Manager

Enabled for Source
Connections Only

Enable the Connection Manger to track the connection
status only on the source location.

Enabled for Target
Connections Only

Enable the Connection Manger to track the connection status
only on the target location.

Enabled for Source and
Target Connections

Enable the Connection Manger to track the connection
status on both the source and target locations.

Connection Manager Options

Only include
connections that are
set for real-time
monitoring

Set the Connection Manager to monitor only connections
that are set for real-time detection.

Scan real-time Jobs on
reconnect if "Scan Job
once at start" is
enabled

Set the Connection Manager to scan real-time Jobs on
reconnect if the Scan Job once at start option is enabled.

https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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This screen is available when using the Windows detection method.

Network Logon Settings

Provides the ability to connect to a source folder that may require a different account
than the one PeerSync is running under. 

Connect As Provide the user name to allow PeerSync connection to the
source directory that is not accessible using the current
service or logged on account. Be sure to include the domain
name if applicable (i.e. MyDomain\UserName).

Password Enter the password information for login.

System Information for Source Host

Get Info Click this button to display a short description about the
source file server that PeerSync is connecting to. 

Edit or maintain default NetApp settings when selecting NetApp Data ONTAP 7-Mode or
NetApp ONTAP | Clustered Data ONTAP as the detection method. These options are
only applicable when using the NetApp Data ONTAP 7-Mode or NetApp ONTAP |
Clustered Data ONTAP detection method. 

Automatically detect
and use recommended
NetApp configuration

When using the NetApp Data ONTAP 7-Mode  or NetApp
ONTAP | Clustered Data ONTAP detection method,
checking this option will automatically populate the required
NetApp settings with the defaults. Uncheck this option if you
wish to manually edit these settings.

NetApp Settings 

Host Server Name Edit the host name or IP address of the NetApp filer, vfiler, or
SVM. 

Root Path Prefix Edit the local path of the NetApp share you wish to monitor.

FPolicy Name Edit the FPolicy name that is used to register for event
notification on the filer. By default PeerSync uses
PEERSYNC_COMPUTERNAME, where COMPUTERNAME
is the name of the host where PeerSync is running. PeerSync
will create the FPolicy name at the start of the Job.

FPolicy Options - Global
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Use cDOT Detection Check this option when using NetApp ONTAP | Clustered
Data ONTAP detection method. 

Use Asynchronous
Mode

If enabled, PeerSync will not wait for a response from the
FPolicy server, which enhances overall performance. To
enable Asynchronous Mode via the command line argument
use /Q74Y. This option is enabled by default for both NetApp
detection methods (7-Mode and cDOT) and cannot be
disabled when using cDOT detection mode. 

Disable FPolicy on
Close

By default PeerSync will disable the FPolicy name it used to
register for event notification when the Job is stopped.
Disable this option if you do not want  PeerSync to delete the
FPolicy name when the Job is stopped.

NetApp FPolicy Additional Settings - By Host

Exclude Volumes Provides the ability to exclude entire volumes from scans
and real-time detection, which enhances overall
performance. Enter a list of semi-colon (;) delimited
volumes to exclude when using NetApp FPolicy
detection during scans or in real-time. Here is an
example of excluding volumes vol3 and vol4: vol3,vol4.
To exclude volumes via the command line use /Q7-s,
where s represents the semi-colon (;) delimited list of
volumes to exclude (i.e. /Q7-vol3;vol4).

Include Volumes Provide a list of semi-colon (;) delimited volumes to include
when using NetApp FPolicy detection during scans or in real-
time. This field is visible only if the “Exclude Volumes” check
box is un-checked.  Here is an example of including volumes
vol1 and vol2: vol1;vol2. To include volumes via the command
line use /Q7+s, where s represents the semi-colon (;)
delimited list of volumes to include (i.e. /Q7+vol1;vol2).

System Information for Source Host

Validate Click this button to display a short description about the
source storage device that PeerSync is connecting to. This
also checks if the credentials provided gain access to the
source storage device.

These options are only applicable when using the NetApp ONTAP | Clustered Data
ONTAP detection method. 

NetApp ONTAP | Clustered Data ONTAP - By Host

PeerSync Server IP This is an optional list of semi colon (;) delimited IP addresses
of the system(s) where the FPolicy server is running (i.e. the
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system where PeerSync is running).  Events generated on
the SVM from this IP will be automatically filtered unless the
"Disable IP Filtering" option is used. Therefore it is important
to note that in order for real-time detection to work, all
changes must be made from different systems and not the
system where PeerSync is running. The Profiler will
prepopulate the list of options with all available IP addresses
on the server.

Username Provide the user name for the account that will be used to run
the API calls against the SVM.

Password Provide the password for the account that will be used to run
the API calls against the SVM.

NetApp FPolicy cDOT Additional Settings

Management IP Optionally, specify the IP address for the system where the
Management node is on a separate IP from the IP used to
access the shares. 

Include Shares Provide a list of alternate shares to register for. Alternate
shares are automatically discovered and registered by
default. This can be disabled by unchecking the Disable
Alternate Share Lookup option.  For example, use this in
cases where the alternate share points to the root level and
should not be included.

cDOT Options - Global

Asynchronous Mode Enabled by default, PeerSync will not wait for a response
from the FPolicy server, which enhances overall
performance. Currently, this setting must always be enabled.

Disable Alternate
Share Lookup

Alternate shares are automatically discovered and registered
for by default. This can be disabled by unchecking the
Disable Alternate Share Lookup option.  For example, use
this in cases where the alternate share points to the root level
and should not be included.

System Information for Source Host

Validate Click this button to display a short description about the
source storage device that PeerSync is connecting to. This
also checks if the credentials provided gain access to the
source storage device.

This screen is available when using the Dell EMC Isilon detection method.
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Automatically use
recommended settings
based on Detection
Method

Automatically use recommended settings based on the
detection method selected.

Cluster Options

Cluster IP The management IP address of the Isilon cluster. 

Cluster Username Username used to sign into the Isilon cluster.

Cluster Password Password used to sign into the Isilon cluster. 

Cluster Port The cluster port number of the Isilon system. Default value is
8080. 

Validate Cluster If enabled, the Isilon cluster will be validated both on
registration and periodically by a maintenance thread. 

Include Alternate
Shares

Include Alternate Shares in detection of the Isilon cluster.

Update Isilon CEE Log
Time

Update Isilon CEE Log Time upon registration. 

Isilon Advanced Settings

Cluster Access Zone The name of the Access Zone that PeerSync is to monitor.

Get Access Zone Info Attempts to get a list of possible access zones from the Isilon
cluster using the credentials specified above.

Audit Cluster Name The name of the cluster as specified in the Audit Settings in
the OneFS web UI.

System Information for Source Host

Validate Click this button to display a short description about the
source storage device that PeerSync is connecting to. This
also checks if the credentials provided gain access to the
source storage device.

This screen is available when using the Dell EMC Unity detection method.

Automatically use
recommended settings
based on Detection
Method

Automatically use recommended settings based on the
detection method selected.
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Control Station Options

Unisphere IP The Unisphere IP address of the Unity system. 

Unisphere Username Username used to sign into Unisphere.

Unisphere Password Password used to sign into Unisphere.

Unisphere Port The Unisphere Port number of the Unity system. Default
value is 443.

CEPP Pool Name The CEPP Pool Name to be used by the Unity system.

Validate Unisphere If enabled, the Unisphere configuration will be validated both
on registration and periodically by a maintenance thread. 

Include Alternate
Shares

Include Alternate Shares in detection of the Unity system.

System Information for Source Host

Validate Click this button to display a short description about the
source storage device that PeerSync is connecting to. This
also checks if the credentials provided gain access to the
source storage device.

This screen is available when using the Dell EMC Celerra | VNX | VNX2 detection
method.

Automatically use
recommended settings
based on Detection
Method

Automatically use recommended settings based on the
detection method selected.

Control Station Options

Control Station IP The Control Station IP address of the VNX system. 

Control Station
Username

Username used to sign into the VNX Control Station.

Control Station
Password

Password used to sign into the VNX Control Station.

Control Station Port The Control Station Port number of the VNX system. Default
value is 443.

CEPP Pool Name The CEPP Pool Name to be used by the VNX system.

Validate Control
Station

If enabled, the VNX Control Station will be validated both on
registration and periodically by a maintenance thread. 
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Include Alternate
Shares

Include Alternate Shares in detection of the VNX system.

System Information for Source Host

Validate Click this button to display a short description about the
source storage device that PeerSync is connecting to. This
also checks if the credentials provided gain access to the
source storage device.

These options are only applicable when using the Nutanix Files detection method. 

Nutanix Files Options

PeerSync Server IP This is a list of semi colon (;) delimited IP addresses of the
system(s) where the PeerSync is running.  Events generated
on the Nutanix Files cluster from this IP will be automatically
filtered unless the "Disable IP Filtering" option is used.
Therefore it is important to note that in order for real-time
detection to work, all changes must be made from different
systems and not the system where PeerSync is running.  The
Profiler will prepopulate the list of options with all available IP
addresses on the server.

Username Provide the user name for the account that will be used to run
the API calls against the Nutanix Files cluster.

Password Provide the password for the account that will be used to run
the API calls against the Nutanix Files cluster.

System Information for Source Host

Validate Click this button to display a short description about the
source storage device that PeerSync is connecting to. This
also checks if the credentials provided gain access to the
source storage device.

Job Scan Method - Global

CIFS - Default This scan method should be selected when working with any
local Windows or remote SMB source and is selected
automatically when clicking on the "Set CIFS Defaults"
button at the bottom. 

NFS - Unix/Linux rsync
command

This scan method utilizes the Unix/Linux rsync algorithm to
scan folders and files. It should be selected when using NFS
detection and is selected automatically when clicking on the
"Set NFS Defaults" button at the bottom. 



PeerSync Help51

Copyright © 1993-2021 Peer Software Inc. All Rights Reserved.

Copy File Method - Global

CIFS - Default This copy method should be selected when working with any
local Windows or remote SMB source. This option is
selected automatically when clicking on the "Set CIFS
Defaults" button at the bottom. 

NFS - Unix/Linux rsync
command

This copy method utilizes the Unix/Linux rsync algorithm to
sync and transfer files. It should be selected when using NFS
detection and is selected automatically when clicking on the
"Set NFS Defaults" button at the bottom. 

NFS - Unix/Linux cp
command

This copy method utilizes the Unix/Linux cp command to sync
and transfer files. It provides an alternative sync/transfer
method to rsync for NFS detection.

CIFS - CopyFile API
- /GFC Argument

This copy method uses a basic file transfer API call
(CopyFile) that provides no progress and therefore may be
faster. 

CIFS - CopyFileEx API
- /GFE Argument

This copy method uses an advanced copy method via the
CopyFileEx API call that provides feedback.

CIFS - File Stream
Method - /GFS
Argument

This copy method uses an alternate file stream method to
transfer the files.

Admin Backup Enable this option to transfer files that the account running
PeerSync does not currently have permission to but the
account can add itself to (/Q7S Command Line Argument).

Advanced Backup Enable this option for files such Symantec Enterprise Vault
stub files ( /Q7S>>Command Line Argument).

Advanced Backup with
Permissions

Enable this option for files such as Symantec Enterprise
Vault stub files and/or to transfer files with all permissions
during the file copy (/Q7S>>> Command Line Argument).

Permissions (Security style) - Global

CIFS - Default (NTFS) This security style should be selected when using Normal or
NetApp 7Mode or cDOT detection. This option is selected
automatically when clicking on the "Set CIFS Defaults"
button at the bottom. 

NFS - Unix/Linux down
and chmod commands
(UNIX)

This security style should be selected when using NFS
detection. This option is selected automatically when clicking
on the "Set NFS Defaults" button at the bottom. 
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Enable NFS Extended
Reporting and Display

Check this option to enable extended reporting and display
information for permissions when working with NFS
detection.

Set CIFS Defaults Click this button to automatically set the global scan, copy,
and permission settings to use the CIFS/SMB protocol. 

Set NFS Defaults Click this button to automatically set the global scan, copy,
and permission settings to use NFS. 

These options are only applicable when using the NetApp ONTAP | Clustered Data
ONTAP or NetApp Data ONTAP 7-Mode detection method. 

FPolicy Utility Features

Disable cDOT FPolicy Available when using NetApp ONTAP | Clustered
Data ONTAP detection mode. Click this button to
disable any policies that match the naming convention
defined in the Profile. The default policy naming
convention is PEERSYNC_FPOLICY-SERVER-NAME).

All PoliciesCheck this option to disable all cDOT policies
that are in an "idle" state and were created from
the FPolicy system where PeerSync is running. 

Regardles
s of state

Check this option to disable cDOT policies
created regardless of their state. 

Delete 7-Mode FPolicy Available when using NetApp Data ONTAP 7-Mode
detection. Click this button to delete all FPolicies that
are in an "idle" state and were created from the
FPolicy system where PeerSync is running. 

Located to the right of the Source Folder Selection Field, this button opens a "Browse for
Folder" dialog box. Once this box has opened, locate your chosen Source folder, select it
using the left mouse button, and click "OK." 

Note:  This button is not available when selecting TCP Source or Target.

Explore/Open/Create Source Button

This button provides three options to be selected from the attached drop-down list. The
button label will change to reflect whichever item has been checked on this list. 

Explore  When "Explore" has been selected and the button is
depressed, an Explorer-type window will open displaying all
available directories. By default, this window will show the
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folder whose path is currently designated in the Source Field.
If the folder shown in this field does not exist, Profiler will
display a dialog alerting you to this fact and asking if you
would like to create it. You may do so by clicking the "Yes"
button located at the bottom of this dialog. Once you have
done so the newly created folder will be shown in the
Explorer-type window. 

Open  When "Open" has been selected and the button is
depressed, a traditional MS navigation window is opened
displaying the contents of whichever folder is currently shown
in the Source Folder Field. If this folder does not exist, Profiler
will display a dialog alerting you to this fact and asking if you
would like to create it. You may do so by clicking the "Yes"
button located at the bottom of this dialog. Once you have
done so the newly created Folder will be shown in the
navigation window. 

Create  When "Create" has been selected and the button is
depressed, a "Select Directory" dialog will open allowing you
to specify a Source Folder path by using the mouse to select
a desired drive, directory, and folder. Folder paths can also
be manually entered into the "Directory Name" field. If you
enter a path for a folder that does not exist and hit the ENTER
key or click "OK," a dialog box will appear allowing you to
create this folder.

Note:  This button is not available when selecting TCP  for Source or Target.

Source Folder Popup Menu: Using Normal Mode

The Source Folder PopUp Menu is activated by right clicking on the Source Folder field.
The first four features allow the user to Browse for Source Folder, Explore, Open and/or
Create the Source Folder selection. 

Configure: Source
Folder

Selecting this option displays the Source Network Logon
Settings window. This allows the user to specify Network
Logon credentials for the Source Folder which enables
connection to directories that are not accessible with the
current logged on account. 

Edit: Source Variable
File

This will allow the user to view/edit Variable Data Import
and/or Job Data Import files that are used in the Source
Folder selection. This option is only available if using Job data
import files.

Create Auto Job Name This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are
automatically generated based on their Source and Target
paths which make it a simple task to organize the Job list. 

Source Folder Popup Menu: Using TCP Mode
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The Source Folder PopUp Menu is activated by right clicking on the Source Folder field.
The first two features allow the user to Explore and Open the Source Folder selection. 

Configure: Source
Folder

Selecting this option displays the Source TCP/Port
Configuration window. This window provides a guided method
for entering the Source TCP path as well as TCP and/or Byte
Replicator settings (see TCP Configuration).

Create Auto Job Name This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are
automatically generated based on their Source and Target
paths which make it a simple task to organize the Job list. 

Notes:  

1. The TCP features listed above require the TCP WAN Connector option. Please visit
https://www.peersoftware.com or contact Sales for additional information.

2. The Browse for Source Folder and Create options are not available when using TCP Source Mode. 

Target Folder Selection

The options listed on this page can be accessed from the Folder Selection window. The
following options are available for selecting a Target folder.

Using Normal Mode Select a "Normal" Target folder if you can navigate to the
desired Target directory via a Local Path, a UNC Path, or a
Mapped Drive. This selection requires that the machine on
which PeerSync is running has full access to the desired
Target directory. In some instances Network Logon may be
required. 

Select a Target Folder by typing the file path into the field
provided or by using the Select Target Folder Button. By
default, the Target Folder field will contain the path in which
PeerSync has been installed: in most cases this will be C:
\Program Files\PeerSync\Target.  The convention outlined in
this path must be used when manually typing entries, (i.e. a
drive must be specified followed by a colon, with subsequent
folders separated by backslashes). This field is not case
sensitive, though spaces may only be entered where they are
part of valid folder names (i.e. "Program Files"). No space
should appear between slashes and folder names. This field
also supports File/Folder Path Variables. 

UNC names can be entered manually, or can be selected
from the Network Neighborhood using the "Browse for Folder"
dialog box (see Select Target Folder Button). UNC names will
appear in the form \\COMPUTER\SHAREDDEVICE\PATH.
For example: \\SERVER11\D\USERDATA 

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Note:  We do not recommend using UNC paths for folders
that reside on the local machine, in this scenario you should
use the local path to that folder.

Folders can also be dragged and dropped from MS Windows
Explorer into the Target Folder Field for automatic insertion.

The Target Folder Field holds a folder selection History of
more then 10 entries. They can be selected by clicking on the
drop down button located to the right of the field. 

The current path will be displayed bellow the Target Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to
correct the invalid path and you exit the Target Folder
Selection field, the application will throw a message and use
the default PeerSync installation path C:\Program
Files\PeerSync\Target instead.

The Host Name and User Name & Password values (if
provided) are displayed above the Target Folder Selection
field (see Network Logon).

Using TCP Mode Select a "TCP" Target folder if the Target directory is outside
the scope of the machine on which PeerSync is running. TCP
enables access to machines not located on the same network
as PeerSync. As a prerequisite, the PSListener needs to be
installed and running on the remote Target machine in order
for PeerSync to be able to communicate with it. This feature
supports encryption and compression.

Note: We strongly recommend the use of a VPN when transferring files over
the public Internet for security purposes. Otherwise, you should use our
Encryption feature with a user name and password to protect data and all
communication as it is being transferred. 

When selecting the TCP Mode for the first time the Target
TCP/Port Configuration window will open automatically for
Target Folder configuration. Otherwise, the previously
entered TCP folder path will be displayed. This path can be
manually edited by typing directly into the field provided or by
using the Configuration button. The convention outlined in
this path must be used when manually typing entries, (i.e. the
key word TCP must be specified followed by a colon, two
backslashes, the Target IP address or machine name, and
subsequent folders separated by backslashes). This field is
not case sensitive, though spaces may only be entered where
they are part of valid folder names (i.e. "Program Files"). No
space should appear between slashes and folder names.
This field also supports File/Folder Path Variables. 

The Target Folder Field holds a folder selection History of
more then 10 entries. They can be accessed by clicking on
the drop down button located to the right of the field. 
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The current path will be displayed bellow the Target Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to
correct the invalid path and you exit the Target Folder
Selection field, the application will throw a message and use
the last valid TCP path specified or the default path TCP:\
\127.0.0.1\C\Target. 127.0.0.1 represents the loopback IP
address of the local host (i.e. the machine on which PeerSync
is running).

The provided Host Name and User Name & Password values
are displayed above the Target Folder Selection field (see
Configuration Button).

Related Options
Target Folder Configuration Button
Select Target Folder Button
Explore/Open/Create Button
Target Folder Popup Menu
Alternate Target Path Selection

Notes: 

1. TCP (i.e.TCP WAN Connector Option) is optional modes which may not be included in your package. Please
visit https://www.peersoftware.com or contact Sales for additional information.

2. Bi-directional synchronization mode as well as other non applicable features are ignored when using a TCP
Target.

3. Selecting a TCP Source and a TCP Target for the same Job is not supported.

4. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the
synchronization process (Source or Target).

Using Normal Mode

The Target Folder Configuration Button can be activated by clicking on the Configure
button located in right lower corner of the Target Folder panel/section. Selecting the
Configure button opens the Target Network Logon Settings window. Alternatively, you may
right-click on the Target Folder field and select Configure: Target Folder (See Target Folder
Popup Menu). This window allows for network logon Name and Password information for a
remote Target connection. 

Using TCP Mode 

The Target Folder Configuration Button can be activated by clicking on the Configure
button located in right lower corner of the Target Folder panel/section. Selecting the
Configure button opens the Target TCP/Port Configuration window. Alternatively, you may
right-click on the Target Folder field and select Configure: Target Folder (See Target Folder
Popup Menu). 

TCP Configuration Tab

This window provides a guided method for entering the Target TCP path. 

https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Host Name Enter the IP address or machine name of the Target folder into this filed.
You may use the machine name only if the remote Target machine
resides on the same network as that on which PeerSync is running. 

Path to
Host 

Provide the full path (i.e. C:\Documents and Settings\Target) to the
Target folder in this field. The path entered needs to be a local path
without a machine name or UNC format. This field does not validate the
existence of the path you provide therefore you must exercise great care
when doing so. If the path does exist, PeerSync will create it during run
time as long as a valid host name or IP address has been provided and it
can find the drive letter specified.

A UNC path can be entered for the Path on Host selection for a TCP
source or TCP target.   This gives the ability to configure non-windows
to non-windows Jobs over TCP (i.e. NetApp to NetApp over TCP). 
Note: This will make use of a new NETWORK constant in the source or
target selection. 

Example: 

TCP:\\WindowsServer\NETWORK\\NetAppSVM\vol1\Data

Care must be exercised if your PSListener contains a "Root Path". If you
specify such a path in your PSListener it will behave like an FTP server
that sets Root Paths to limit user access to the local file system. If a
"Root Path" exists on the PSListener it will limit PeerSync's ability to
access directories on the remote device. PeerSync will only be able to
access directories equal to or bellow the specified "Root Path" level
provided that it meets the Port and Encryption requirements. In no
circumstances can PeerSync access directories located above this path.
If the remote path you enter in the Path to Host  field references a
directory above the "Root Path", PeerSync will create that folder
structure at runtime bellow the "Root Path". 

Example: 

PSListener "Root Path" = C:\Backup\Users\Admin
PeerSync's "Path to Host"  = C:\Backup\My Documents
Actual Remote Target Path = C:

\Backup\Users\Admin\C\Backup\My
Documents

Note: The "Root Path" will be ignored when performing byte-level replication using Normal
Mode (i.e. Local or UNC paths). 

Port Configuration Tab 

Provides settings to be used by both the Source and Target connections when using
TCP and/or Byte Replicator. 

Time Out Sets the amount of time a connection will wait to complete a data transfer
before exiting and performing the failure operation. 

Port This is the TCP Port used to communicate with the Listener on the
remote machine. This must match the port number that the PSListener is
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configured for. By default both Listener and PeerSync use port 7333.

Note: The Profiler will not support Well Known Port numbers 0 - 1023. You must use port
numbers that are greater than or equal to 1024. 

Compressio
n 

Uses a lossless compression algorithm to transmit data in fewer bits. By
default Compression is disabled to achieve faster performance. 

User
Information

This is an optional setting that allows you to specify a User Name and
Password to be used for encryption as well as authentication purposes
when connecting to the remote PSListener. In order to activate
encryption or authentication, you must specify both a User Name and a
Password value.  Strong DES encryption will be used to encrypt the data
and communication as it is being transmitted over the Internet, LAN,
WAN, or VPN. 

The User Name and Password entries can be arbitrarily chosen and are
not required to be valid. However, once specified, you must enter the
same User Name and Password entries in the PSListener Configuration
residing on the remote location. 

If you specify a User Name without a Password, the User Name entry
will be ignored and no encryption or authentication with the PSListener
will occur. 

Notes:

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit
https://www.peersoftware.com or contact Sales for additional information.

Located to the right of the Target Folder Selection Field, this button opens a "Browse for
Folder" dialog box: once this box has opened, locate your chosen Target folder, select it
using the left mouse button, and click "OK." 

Note:  This button is not available when selecting TCP for Source or Target.

Explore/Open/Create Target Button

This button provides three options to be selected from the attached drop-down list. The
button label will change to reflect whichever item has been checked on this list. 

Explore When "Explore" has been selected and the button is
depressed, an Explorer-type window will open displaying all
available directories. By default, this window will show the
folder whose path is currently designated in the Target field. If
the folder shown in this field does not exist, Profiler will
display a dialog alerting you to this fact and asking if you
would like to create it: you can do so by clicking the "Yes"
button located at the bottom of this dialog. Once you have
done so the newly created Folder will be shown in the
Explorer-type tree.

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Open When "Open" has been selected and the button is depressed,
a traditional MS navigation window is opened displaying the
contents of whichever folder is currently shown in the Target
Folder Field. If this folder does not exist, Profiler will display a
dialog alerting you to this fact and asking if you would like to
create it: you can do so by clicking "Yes" button located at the
bottom of this dialog. Once you have done so the newly
created Folder will be shown in the navigation window.  

Create When "Create" has been selected and the button is
depressed, a "Select Directory" dialog will open allowing you
to specify a Target Folder path by using the mouse to select a
desired drive, directory, and folder (See image in "Source
Folder Selection" topic above). Folder paths can also be
manually entered into the "Directory Name" field. If you enter
a path for a folder that does not exist and hit the ENTER key
or click "OK," a dialog box will appear allowing you to create
this folder.

Note:  This button is not available when selecting TCP for Source or Target.

Target Folder Popup Menu: Using Normal Mode

The Target Folder PopUp Menu is activated by right clicking on the Target Folder field.
The first four features allow the user to Browse for Target Folder, Explore, Open and/or
Create the Target Folder selection. 

Configure: Target
Folder

Selecting this option displays the Target Network Logon
Settings window. This allows the user to specify Network
Logon credentials for the Target Folder which enables
connection to directories that are not accessible with the
current logged on account. 

Edit: Target Variable
File

This will allow the user to view/edit Variable Data Import
and/or Job Data Import files that are used in the Target Folder
selection. This option is only available if using Job data import
files.

Create Auto Job Name This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are
automatically generated based on their Source and Target
paths which make it a simple task to organize the Job list. 

Set
Alternate/Additional
Targets

Selecting this menu item will open the Alternate/Additional
Targets selection window. This feature allows for alternate or
additional Target paths associated with the base Job. 

Force Source Folder
Root as Target Folder
Root

Appends the Source folder directory to the Target folder path.

Target Folder Popup Menu: Using TCP Mode
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The Target Folder PopUp Menu is activated by right clicking on the Target Folder field.
The first two features allow the user to Explore and Open the Target Folder selection. 

Configure: Target
Folder

Selecting this option displays the Target TCP/Port
Configuration window. This window provides a guided method
for entering the Target TCP path as well as TCP and/or Byte
Replicator settings (see TCP Configuration). 

Create Auto Job Name This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are
automatically generated based on their Source and Target
paths which make it a simple task to organize the Job list. 

Force Source Folder
Root as Target Folder
Root

Appends the Source folder directory to the Target folder path.

1. The TCP features listed above require the TCP WAN Connector option. Please visit
https://www.peersoftware.com or contact Sales for additional information.

2. The Browse for Target Folder and Create options are not available when using TCP Target Mode. 

Notes:  

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit
https://www.peersoftware.com or contact Sales for additional information.

2. The Browse, Explore, Create, and Set Alternate/Additional Target options are not available when using TCP.

This link will be enabled if you are using a Normal Target Mode Selection. By selecting this
link you can set and access your current Alternate Target Path Selections. Through this
feature, Jobs can now have alternate or additional Target paths associated with the base
Job. This allows for the ability to redirect data on a failed connection to the base Target
and/or easily setup, one-to-many scenarios for distribution purposes. Selecting this menu
item will open the Alternate Target Path Selection dialog.

To add an alternate or additional Target click "New," then type the desired path into the
field located at the bottom of the dialog or select the "Browse" button to select a path..
Repeat this process for each Target path you wish to add. Entries can be deleted by
selecting them from the list and clicking the "Delete" key at the bottom of the box. You can
also use the "Up" and "Down" buttons to reorder the paths.

Notes:

1. This feature requires the Enhanced Package. 

2. Alternate Target Path Selection is not available for TCP.

3. When using Alternate Target Path Selections you cannot use variables that are specific to the Job (i.e. %
JobName%, %SourcePath%, etc.) for the Move unmatched Target Files option.

If this check box is selected, all sub-folders contained within the Source Folder will be
synchronized to the Target.

This button reverses placement of the file paths shown in the Source and Target Folder
Fields (so that what was formerly a Source Folder now becomes a Target Folder, and vice

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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versa).

Represents the date/time the last scan started for the selected Job. This is the date/time of
the last bi-directional synchronization scan of a Job that will be used when comparing files
during the Bi-directional Synchronization Mode option on the File Options screen. This
feature is also displayed and can be reset from the Profile Job List Pop-Up Menu.

Represents the date/time and user when the selected Job was last saved. 

This section describes additional features related to the Folder Selection topic. The
features below apply to both the Source and Target folder selections and related
configuration options. 

Related Options
File/Folder Path Variables
Variable Data Import 
Job Data Import 
Dynamic Network Drive Mapping and Unmapping

Variable file/folder paths can be used to create:

1. Dynamic archives for yearly, monthly, weekly and/or daily backups
2. Dynamic synchronization based on date
3. Dynamic synchronization based on logged on user or machine name
4. Dynamic synchronization based on personal folders or other variables read in from the

registry
5. Log file storage, manipulation and organization
6. Administrative report file storage, manipulation and organization
7. Deleted file storage, manipulation and organization

File/Folder Path Variables

Depending upon the argument used, these folders will be dated, named after the
currently logged user, named for the PC from which synchronization was launched, or
based on a pre-determined variable stored out and read in from the registry. The
following variables can be used in any folder path Job setting available through the
Profiler:

Date %Date%

Time %Time% 

Date/Time %DateTime%

Minute %Minute%

Hour %Hour%

Day %Day%

Year %Year%

Month/Year %MonthYear%

Minute (all formats) %n, nn%

Hour (all formats) %h, hh%
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Day (all formats) %d, dd, ddd, dddd, ddddd, dddddd%

Month (all formats) %m, mm, mmm, mmmm, mmmm%

Year (all formats) %y, yy%

Custom Peer Variables

Logged On User Name %UserName%

Computer Name %ComputerName%

Job Name %JobName% 

Source Folder Path %SourcePath%

Target Folder Path %TargetPath%

Deletion Folder Path %DeletePath%

Report File Path %ReportPath%

Windows Variables

Windows Directory %WinDir%

Windows %Windows% (also %SystemRoot%)

System Temp Path %Temp%

System Temp Path %Tmp%

System Drive Letter %SystemDrive%

System 32 (WIN
9x/NT/00)

%System32%

Windows Variables from the
"HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\
Shell Folders" Registry

Desktop %Desktop%

Favorites %Favorites%

Fonts %Fonts%

Personal %Personal%

Programs %Programs%

Recent %Recent%

SendTo %SendTo%

Start Menu %Start Menu%

Startup %Startup%

Templates %Templates%
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Notes:  

You can also use any variables that are located in the registry under HKEY_CURRENT_USER. For example:

HKEY_CURRENT_USER\Environment (used by default default)
HKEY_CURRENT_USER\Volatile Environment (used by default) 

The HKEY_CURRENT_USERS locations can be modified in the PSDef.cfg file as follows: 

[Misc Options]
RegVarStr=\Environment;\Volatile Environment;

In addition, the %USERPROFILE% Environmental Variable is now also supported. 

Use the variable %Personal% to define the "My Documents" folder in Profiles that will be used on multiple
operating systems such as XP and Windows 7. Since the location of the My Documents folder is different on these
operating systems, using the %Personal% variable will dynamically resolve to the correct location on each
system. This simplifies configuration and keeps the Profile generic and deployable on multiple operating systems.

Note for PeerSync Jobs linked to PeerLock: PeerLock supports the usage of Windows System and Registry
variables in the Source and Target fields (i.e. %UserName%, %ComputerName%). Custom PeerSync variables
such as %JobName% are currently not supported and will not work in PeerLock. 

PeerSync now contains tools for importing data from files. The ability to extract specific
fields of data from a file has been included to allow unlimited scalability. Within an
organization, one generic Profile can now be created, and utilizing text files, specific
information about the user and the desired folders to be synchronized can be imported
dynamically. Variables can be used to dynamically introduce data from a file into various
fields throughout the interface including file paths, deletion paths, log file paths, log file
names, etc.

Field data is imported through: 

<<#FileName.txt [section] item#>>

In which the [section] is a defined field in a file, such as the example file content below.

[Info] 
Name=Cris Smith
Home=c:\mydocuments

Using <<#FileName.txt [Info] Name#>> will import "Cris Smith" into the path it was used in
and using <<#FileName.txt [Info] Home#>> will import "c:\mydocuments" into the path it
was used in. 

Note: This feature requires the Enhanced Package. 

PeerSync now contains tools for importing data from files to dynamically create Jobs. Within an
organization, one generic Profile can now be created, and utilizing text files, specific information
about the user and the desired folders to be synchronized can be imported dynamically. Lists
can be used in Source and Target path names as such:

Source: <<$FileNameSources.txt$>>
Target: <<$FileNameTargets.txt$>>

or: 

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Source: <<$C:\Path\To\File\FileNameSources.txt$>>
Target: <<$C:\Path\To\File\FileNameTargets.txt$>>

Corresponding entries of each delimited file entry will be used to dynamically create a Job
based upon the Jobs properties.

Note: This feature requires the Enhanced Package. 

PeerSync allows for the ability to dynamically map and un-map a Source or Target folder
selection. The way you do this is to add a letter to the beginning of the UNC path that you
wish to map the drive to. This can be done for the Source or Target selection (i.e. n\
\COMPUTER\SHAREDDEVICE\PATH).

For Example: n\\DELLSERVER\D\USERDATA 

The example above will map the D drive on the DELLSERVER to the N drive upon start of
PeerSync and will unmap the drive when PeerSync terminates. This is a quite useful
feature especially when running PeerSync as a service in the scenario where you want to
synchronize to a mapped drive. This feature will allow for it to occur seamlessly. 

Note: If you are going to run PeerSync as a Service it is advised to use UNC paths or
PeerSync's Dynamic Network Drive Mapping and Unmapping feature instead of using
mapped drives due to the fact that mapped drives are not understood when a user is not
logged on.

Next/Last Available Drive Mapping 

This feature allows for the dynamic mapping of the next (A) or last (B) available network
drive by using the following format in the Source or Target Fields:

Map Next Available Example:  A\\COMPUTER\SHAREDDEVICE\PATH
Map Last Available Example:  B\\COMPUTER\SHAREDDEVICE\PATH

Local Drive Mapping

This feature allows for the dynamic mapping of a local drive by using the following format in
the Source or Target Fields:

Map Local to N Example: N\\LOCALCOMPUTER\SHAREDDEVICE\PATH

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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1.1.3  Automation

Topics
Automation Overview
Automation Options

The Automation screen allows you to apply Real-Time Monitored or Scheduled
synchronization to individual Jobs within a given Profile. Real-Time operations (also
referred to as "File/Folder Change Detection") monitor Source Folders for any changes and
synchronize them to the specified Target as they occur. Scheduled operations
automatically launch synchronization according to a user-specified schedule. Through
these settings, PeerSync allows you to build a Profile with as many as 255 different Jobs --
each run according to a unique schedule or in Real-Time (Also see Command Line
Arguments for Global Automation Settings).

Scanning Options

The options listed on this page can be accessed from the Automation window. This
screen allows the user to set the frequency of scans as well as enable Real-Time
replication.

Scan Job Once at Start This feature directs PeerSync to run the current Job as an
Automatic Operation. An Automatic Operation allows you to
perform an immediate launch of the current Profile. As a non-
persistent process, Automatic Operations are run a single
time upon manual initiation by the user. We also refer to this
type of run as an Initial Sync. 

Scan Job every x
minute(s)

Checking this feature assigns a Scheduled operation to the
selected Job(s). The field associated with this feature allows
you to set an interval in minutes: after this time has elapsed
the selected folders will be synchronized. 5 minutes is the
default setting. Intervals in seconds can be specified through
the use of decimals, (i.e. 0.5, 2.5, etc.); the minimum interval
is 0.01.   
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Scan Job at x Checking this feature will allow for the synchronization of
Jobs at a specific times of the day for selected days of the
week. When selected the Daily Timer Options dialog will
appear with the following options: 

Run selected Jobs at
Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field.
Selecting this feature will run the Job at the selected time of
day.

List of Job Selections
Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field.
This is a list of the currently selected Daily Timer selections.
You can Add New selections by selecting the New button and
Delete existing selections by selecting the Delete button. 

Select days of week to run
Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field.
Allows you to turn on/off which days to run this schedule.

Selection Options
Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field.
This feature will give you the option to run the selected daily
timer schedules in a Recurring mode (synchronization will run
every time according to the set scheduled options) or Run
Once (synchronization will run only once).

Use Enhanced
Scanning (Enhanced
Scanning)

The Enhanced Scanning option is required for this feature to
be enabled. Enhanced Scanning provides the ability to build
multiple dynamic Jobs for parallel processing of folders during
scans.   This will significantly improve the time PeerSync
takes to scan trough directories.  By default PeerSync scans
through a Job sequentially, one folder at a time. With the
Enhanced Scan option enabled PeerSync will spawn a Job
Thread for each folder or subfolder encountered during a
scan. 

When the Use Enhanced Scanning checkbox on the
Automation window is checked the  Enhanced Scanning
dialog will open. By default the slider in the Enhanced
Scanning dialog is set to the Off position all the way to the left
side. To enable the Enhanced Scan feature move the slider to
the right. Each slide position represents a depth level of 1, 2,
3, 4, and 5 respectively. Each value represents the depth
level at which PeerSync will spawn a Job thread for each
folder it encounters.

Example:

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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If you set the Enhanced Scanning slider to Level 3, then
PeerSync will spawn 7 dynamic Jobs for the Users directory
depicted bellow. It will in essence create a dynamic Job for
each of the folders at Level 3 (Folder1, Folder2, Folder3, and
Folder4). It will then create a Job for the folders at Level 2
(Users1 and User2) but will exclude all their subfolders.
Lastly, it will create a Job for the directory at Level 1 (Users)
and exclude all the subfolders. 

Notes: 

1. The Enhanced Scanning and the Multi-Threading add-on options are
required for this feature. Please visit https://www.peersoftware.com or
contact Sales for additional information.

2. When using this option be sure you make available a large pull of Job
Threads to be used by PeerSync so that dynamic Jobs can be created
for each folder during a scan.

3. This feature is not supported when using the Enhanced Bi-directional
option.

Real-Time Event Detection Options

The options listed on this page can be accessed from the Automation window. This
screen allows the user to set the frequency of scans as well as enable Real-Time
replication.

Use Real-Time
Monitoring

Selects the current Job(s) for Real-Time Monitoring.

Real-Time Options... This button opens an "Additional Options" dialog box. Once
this box has opened, it allows you to choose from two Real-
Time operations. The first is a Folder Replication feature,
which monitors for changes to the Source Folder and
synchronizes the Target accordingly. The second, a Folder
Restoration feature, monitors for changes to the Target
Folder and restores files on the Target accordingly. To
properly use the restore feature, you will need to select the
"Always overwrite Target files" option. 

Notes:

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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1. Bi-directional will be ignored for Real-Time Jobs.

Enhanced Real-Time Monitoring

This feature allows the Real-Time feature in PeerSync to
detect individual changes to files and synchronize only the file
which has changed without scanning the entire folder where
the change occurred. Normally, synchronization software
scans and compares all files into a folder which is being
synchronized. This feature does not scan folders unless the
change is indeterminate. If a file or folder is renamed,
PeerSync will rename the corresponding Target File or folder
using rename functions as opposed to copying the newly
renamed Source Folder to the Target and then subsequently
deleting the outdated Target file/folder. This feature greatly
reduces the time required to synchronize files and also
reduces network band width requirements.

With this option enabled PeerSync will continue to detect real-
time events even during a scan. 

Notes:

1. Bi-directional, During comparison subtract/add x minute(s)
from Target, and Trigger Selections, as well as, other non
applicable features may be ignored during Enhanced Real-
Time.

2. It is recommended either use the Enhanced Real-Time
option for all or none of your Real-Time Jobs within a Profile.

3. Using Enhanced Real-Time will produce a different file
output format for all modes of reporting and message logging
(Reporting, Admin Reporting and Email Reporting). The
output will NOT contain a start and stop section or a
summary, each entry will also be initially marked with a date
and time stamp. If use summary is selected for Admin or
Email reporting then the standard selection will be used. The
reason this is done is due to the fact that processes will be running in
parallel.

Use Standard Real-Time Monitoring

When the Real-Time feature detects a change to
synchronize, this method will cause a scan to run on the root
folder, but not the subfolders. For folder manipulations such
as renames, the entire folder including its subfolders will be
scanned. 

Global Settings See Source Folder Global Options. 
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1.1.4  Blackout Settings

Topics
Blackout Settings Overview

Blackout Period

This screen will enable you to set a Blackout period during the daily synchronization. This
is a period in which the synchronization will stop and wait until the blackout period has
expired according to the specified settings. This would be a useful feature if you wish to
stop all the synchronization activities during a particular time when the Network
Bandwidth is busy with other activities (such as during working hours).

Suspend active scans
when a Blackout period
starts

Enabling this option will pause all the scheduled scans during
the specified Blackout and will resume after the Blackout
period ends.

What happens if PeerSync is performing a scan when it enters the
Blackout period?
If the option to "Suspend active scans when a Blackout period starts" is enabled the scan
will be suspended and resumed at the point it was left off after the Blackout period ends. If
this option is not enabled, the scan will be stopped during the Blackout period and will be
restarted from the beginning after the Blackout period ends.  

What happens if PeerSync was in the middle of transferring a large file
when it entered the Blackout period?
PeerSync will allow the transfer to complete but suspend any new events from being
processed until the Blackout period ends. The suspended events or scans will be
processed after the Blackout period ends.

What happens if a scan is scheduled to run during the Blackout period?
Regardless if the option to "Suspend active scans when a Blackout period starts" is
enabled the scan that is scheduled to run during the Blackout period will run after the
Blackout period ends. Multiple suspended scans for a single Job will be compiled into a
single scan that will run at the end of the Blackout period. 
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1.1.5  Scan Limitations

Topics
Maximum Duration of Scans
Initiate Scan on trigger File Change

Note:  Features listed on this page require the Enhanced Package.

Enabling the Set maximum duration to x minutes option allows you to specify a maximum
duration for each Job. This gives you the ability to limit the run time of a Job during initial,
interval, and scheduled scans. 

Trigger Files

These settings ensure that the Target Folders always remain updated to their
corresponding Source by comparing dates indicated by individual Trigger Files. For
example, if a Source Trigger is found to be newer than a corresponding Target Trigger, a
synchronization process will be allowed to proceed for the selected Job(s). If the files
date and time stamps match then the synchronization will not be processed. Therefore,
the run of the sync process is in essence, determined by the trigger files.

Use Trigger Files This feature is used to activate or trigger synchronization
based upon date comparison between an individual Source
Trigger File and a separate Target Trigger File. If the Target
Trigger File is older then the Source Trigger File, the entire
Source Folder(s) will be synchronized. 

Default File Name Displays the Default Global Trigger File Name:
GLBCHG.000

Source Trigger File This field allows you to specify a Global Trigger File by
entering it manually, or by selecting it using the browse button
located at the right side of the field. 

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Use Current Paths Automatically selects the current Trigger Files associated
with the Source and Target Folders.

Target Trigger File This field allows you to specify a Global Trigger File by
entering it manually, or by selecting it using the browse button
located at the right side of the field.

Note:  During Enhanced Real-Time, Trigger Selections will be ignored. 

1.1.6  File Options

Topics
Mode Selection
Event Options

Mode Selection

The options listed on this page can be accessed from the File Options window.

Standard (update
Target Files if Source
is newer)

With this mode selection, PeerSync will update files on the
Target only if the Source is newer.

Always overwrite
(Update Target Files if
the Source is newer or
older)

This feature automatically overwrites any files in the Target
Folder that have a different date\time stamp than their
corresponding Source File, even if the Target File is newer.
This feature can be used to restore folders to a previous state
either for backup/restore operations or to reset files after
training operations.  

Bi-directional (both
directions)

With this feature selected, PeerSync will merge the data of
the Source and the Target folders during Scan at Start,
interval and scheduled scans. This feature may be ignored
during Real-Time and Enhanced Real-Time modes. The
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following will happen when this feature is selected with the
Replicate - Delete unmatched files/folders option enabled:  

If a File exists in both Source and Target Folders
PeerSync will compare the Modified date/time of the files and
update/overwrite the older file with the newer file. If the
modified date/time is identical PeerSync will not perform any
action. 

If a File exists in only the Source or Target Folder
PeerSync will compare the Modified, Created and Accessed
date/time of the file with the stored Last Run On date/time of
the Job. If any of the three file date/times are newer than the
stored Last Run On date/time the file will be added, otherwise
the file will be deleted.  

If a Sub-Folder exists in only the Source or Target Folder
The Source will be seen as the primary folder and any sub-
folders with content existing on the Source will be added to
the Target. If the folder is empty or exists on the Target,
PeerSync will compare the Modified, Created and Accessed
date/time of the folder with the stored Last Run On date/time
of the Job. If any of the folder date/times are newer than the
stored Last Run On date/time the folder and all of its contents
will be added, otherwise the folder will be deleted. 

Note: 

PeerSync now also supports real-time or scheduled bi-directional replication
using our TCP replication mode. To achieve real-time bi-directional replication
across TCP, PeerSync and PSListener would need to be installed on both the
Source and the Target machines. For scheduled bi-directional replication
across TCP, PeerSync would need to be installed on one side, while the
PSListener on the other. This feature is not supported when using a
TCPTarget.

Related Options
Global Bi-directional Options

Notes: 

1. The Bi-directional feature is only supported when working with a Normal Source and a Normal or TCP Target.

2. The Bi-directional feature may be ignored when using TCP Source.

3. The Bi-directional feature is only valid during scans and will be ignored during Real-time monitoring.

4. Non NTFS partitions may behave differently using the Bi-directional mode. You may notice files being retained for up
to one day, even if you delete a file from the Source or Target.

5. Modifications, such as renames and deletes, of Target Folders are subject to restoration in the Bi-directional mode.

Event Options

The options listed on this page can be accessed from the File Options window.

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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Add - synchronize new
files to Target

If the Source contains files not found within the Target and
this feature is selected, those files will be added to the Target
Folder during synchronization. This feature is selected by
default. 

Update - synchronize
existing files in Target

If this feature is selected, Target Folder files which are also
found within the Source will be updated to match those
Source files during synchronization. This feature is selected
by default. 

Replicate - Delete
unmatched files

If this feature is selected, any unmatched files found in Target
Folders will be deleted automatically. 

CAUTION:  Use this feature carefully. If not configured
properly, needed files may be permanently deleted. A deletion
warning is NOT displayed by default: Profiler must be first set
to display this warning through the "Deletion Warning
Message" check box.

Related Options
Deletion Options
Move Options

Delete Options

The options listed on this page can be accessed by clicking on the Deletion Options
button from the File Options window. Once the Replicate - Delete unmatched files option
is turned on the Deletion Options button will be enabled for further configuration.
Clicking on the Deletion Options button opens the "Additional Options" dialog box which
contains the following features:

Deletion Warning
Message

The upper section of this screen allows you to enable or
disable a Deletion Warning Message, as well as set the
number of seconds for which a Message will be displayed (a
message is NOT enabled by default and is not available
during Enhanced Real-Time). In addition, you can also
choose to display a message requiring manual intervention in
order to activate deletions. 

The Require manual intervention option is only used during
single threaded operations and/or standard real-time. It will
also be ignored during real-time when using:
· Multiple Job Threads

· Multiple Copy Threads

· Enhanced Scanning

· FastSync

This option will also be ignored during real-time when using
Enhanced Real-time monitoring (File Level Change
Detection). However, it will be used (when not using the items
listed above) for Standard Real-time monitoring (Folder Level
Change Detection).
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Move Options

By clicking on the Move Options button in the File Options window you will be able to
access the Move Deleted File Options dialog which has the following settings available:

Move Deleted Files
Options

This section provides a field where the user can designate an
alternate folder to which unmatched files will be moved in
order to avoid permanent deletion. This folder path can be
typed manually, or selected using the browse button provided
to the right of the field. If the designated folder exists, all
unmatched files will be moved there, allowing you the
opportunity to recover files deleted from the Target. This field
also supports File/Folder Path Variables and when used, the
current path will be displayed above the field. Beneath this
field are path options.

We strongly recommend using a Deletion Folder that is
located on the Target host computer. Relocation to an
alternate drive or host adds unnecessary processing and
bandwidth overhead. For this reason PeerSync uses the
following Deletion Folder variables: 

%TARGETROOT%
This variable resolves to the root directory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the deletions path %TARGETROOT%\Deletions will resolve
to \\machine1\c$\Deletions. This variable is used by default. 

%TARGETPARENT%
This variable resolves to the parent directory of the target
path. For example if the target path is \
\machine1\c$\Target\Docs, the deletions path %
TARGETPARENT%\Deletions will resolve to \
\machine1\c$\Target\Deletions.

Relative Paths This feature will move files deleted by PeerSync from the root
folder to the root of the selected folder. Files deleted from sub
folders will be moved to corresponding sub folders below the
root selected deletion folder. This feature is intended (works
best) for a Profile with a single Job. 

E
x
a
m
p
l
e
:

Source Folder: C:\MyDocs\Files\

Target Folder: D:\MyDocs\Files\ 

Move Path: C:\DeleteFolder\

If you delete: C:\MyDocs\Files\Sub\File.txt

PeerSync will
move:

D:\MyDocs\Files\Sub\File.txt

To: C:\DeleteFolder\Sub\File.txt
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Preserve Paths This feature will recreate the original path of the deleted file
under the specified path. Therefore, a file deleted by
PeerSync will be moved into a folder that corresponds to the
file's original location: under the selected deletion folder. This
feature is intended (works best) for a Profile with Multiple
Jobs.

E
x
a
m
p
l
e
:

Source Folder: C:\MyDocs\Files\

Target Folder: D:\MyDocs\Files\ 

Move Path: C:\DeleteFolder\

If you delete: C:\MyDocs\Files\Sub\File.txt

PeerSync will
move:

D:\MyDocs\Files\Sub\File.txt

To: C:\DeleteFolder\D_MyDocs\Files\Sub\File.txt 

Use Recycle Bin This feature allows you to specify the Windows Recycle Bin
as a location for unmatched files. This feature is not intended
for use when file deletions made by PeerSync may occur on a
non-local machine or device. Only files deleted from a local
drive can be moved to the Recycle Bin, if this feature is used
all network files will be permanently deleted. 

Delete unmatched
Target Files older than
x days

This feature is intended for the cleanup of files that were
candidates for deletion but were selected to be moved to an
unmatched folder. By use of this feature, PeerSync can be
used to temporarily store files setup for deletion and then
have the files deleted after a specified number of days. By
default deletion folders are checked every 24 hours or
immediately after the initial scan (if Scan Job Once at Start is
enabled). This interval can be modified by using the /LH:n
argument where n is represented in minutes. 

Notes: 

1. Only one copy of any file can exist in your designated Recovery folder.

2. To avoid filling up your hard drive unnecessarily, you should periodically check this folder and delete
unwanted files or use the  Delete unmatched Target Files older than x days option.

3. Only files deleted from a local drive can be moved to the Recycle Bin, if this feature is used, all network files
will be permanently deleted.

4. The Deletion Warning Message option is not available during Enhanced Real-Time.

5. When using the Alternate Target Path Selections feature you cannot use variables that are specific to the Job
(i.e. %JobName%, %SourcePath%, etc.) for the Move unmatched Target Files option.
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1.1.7  NFS Settings

Topics
Use Unix/Linux system for Job Scans, Copy File and/or setting Permissions
Use Optional Target Unix/Linus system for use with rsync daemon
Modify NFS Default Options

Note: 

Features on this screen require an NFS and NetApp enabled license.  Please visit https://www.peersoftware.com
or contact Sales for additional information.

Use Unix / Linux system for Job Scans, Copy File and/or setting Permissions

IP Address Enter the IP address of a Unix/Linux system to use (i.e.
Ubuntu or Red Hat) for processing NFS commands.

User Name Provide the user name for a Unix/Linux system to use (i.e.
Ubuntu or Red Hat) for processing NFS commands.

Password Provide the password for a Unix/Linux system to use (i.e.
Ubuntu or Red Hat) for processing NFS commands.

Configure... Click this button to access the CIFS/NFS configuration
dialog.

Mount Folders Click this button to mount the current Source and Target
Folder selection on the selected Unix/Linux system.

Unmount Folders Click this button to unmount the current Source and Target
Folder selection on the selected Unix/Linux system.

Note: 

https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Features on this screen require an NFS and NetApp enabled license.  Please visit https://www.peersoftware.com
or contact Sales for additional information.

Use Optional Target Unix/Linux system for use with rsync daemon

IP Address Enter the IP address of a target Unix/Linux system to use
with rsync daemon (optional target side).

User Name Provide the user name for a target Unix/Linux system to use
with rsync daemon (optional target side).

Password Provide the password for a target Unix/Linux system to use
with rsync daemon (optional target side).

Setup/Test rsyncd Click this button to setup optional rsyncd (optional target
side).

Mount Target Path Click this button to mount the current Source and Target
Folder selection on the selected Unix/Linux system (optional
target side).

Unmount Target
Folders

Click this button to unmount the current Source and Target
Folder selection on the selected Unix/Linux system (optional
target side).

Note: 

Features on this screen require an NFS and NetApp enabled license.  Please visit https://www.peersoftware.com
or contact Sales for additional information.

Modify NFS Default Options

Check this option if you wish to modify the mount or rsync commands used by
PeerSync. Modifying the defaults should be done with caution as changes can drastically
affect expected results. 

NFS mount Options Lists the NFS mount options to be used when creating
source and target folder mounts on selected Unix/Linux
system. Please use caution if making changes to the
defaults:

soft,intr,posix,actimeo=5,rsize=65536,wsize=6

5536,vers=3

NFS rsync Options Additional options to use when executing rsync commands.
Some options may be dynamically added based on Profile
and/or Job settings such as: -a, -r, -l, -t, -D, -A, --update, --
partial, --inplace, --exclude, --include and -n. The defaults
are:

--progress -v -i -z -H

https://www.peersoftware.com
http://www.peersoftware.com/contact.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Note: 

Features on this screen require an NFS and NetApp enabled license.  Please visit https://www.peersoftware.com
or contact Sales for additional information.

1.1.8  Permissions

Topics
File/Folder Permission Options
Related Global Settings

File/Folder Permission Options

Transfer File and
Folder Permissions

Enable this option to transfer File and Folder Permissions
(NTFS security style via CIFS or UNIX security style via
NFS). When enabled, the NTFS Options and Global Settings
link will be enabled for further configuration.  

NTFS Options Click this button to open the ACL Options dialog. The
options in this dialog allow you to specify the types of
permissions you want PeerSync to detect and transfer. The
options include Owner, DACL: Discretionary Access Control
List (enabled by default), and/or SACL: System Access
Control List.

Global Settings Click this link to open the Global Settings dialog and set the
global permission settings.

Notes: 

1. Care must be exercised when using ACL options to synchronize files and folders between different domains.
File security transfers could make the target file inaccessible after transfer/update.

2. When you use a local drive letter (either for the source or target path) you need to make sure the drive is
assigned as an administrative share (i.e. D$) in order for ACLs to work properly.

3. This feature may be ignored when using an TCP Source or Target.

https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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4. Some features on this screen require an NFS and NetApp enabled license.  Please visit
https://www.peersoftware.com or contact Sales for additional information.

Related Global Settings

This section identifies the security style that has been globally set. The choices are
NTFS style (via CIFS) or UNIX style (via NFS).

Security style Click the Security style link to change the security style
permissions in the CIFS/NFS tab. 

Note: 

Some features on this screen require an NFS and NetApp enabled license.  Please visit
https://www.peersoftware.com or contact Sales for additional information.

1.1.9  Open Files

Topics
Open Files Overview
Managed Files
Global Settings

Open Files

The options listed on this page can be accessed from the Open Files window.

Include open files
(allow read & write
access to source file
during transfer)

Use this option when you want to include open files and allow
users to modify them while they are being transferred. For
locked files such as database files, PeerSync will first attempt
to process them using the Managed Files setting if enabled. 
If this process is not enabled or fails, locked files will be
retried based on the retry open/inaccessible files setting.

https://www.peersoftware.com
http://www.peersoftware.com/contact.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Note:  If PeerSync is able to synchronize files which are in use by other
applications, access to those applications may in certain instances be
temporarily lost during synchronization. 

Include open files
(allow read access to
source file during
transfer)

Use this option when you want to include files that are open
for read-only access. Users will be able to open source files
for read-only access while they are being transferred.   For
files that are being modified or are locked PeerSync will first
attempt to process them using the Managed Files setting if
enabled.  If this process is not enabled or fails, these files will
be retried based on the  retry open/inaccessible files setting.

Exclude open files
(allow read access to
source file during
transfer)

Use this option when you want to replicate only files that are
closed. Files that are opened or locked will be retried based
on the  retry open/inaccessible files setting. Users will be
denied write access to source files that are being transferred
but may have the option to open them in read-only mode. 

We recommend you use this option when doing
replication/collaboration from one source to multiple
destinations. This option allows PeerSync to replicate files
from one source to multiple destinations, in parallel, while at
the same time protecting the source files from write access
during their transfer. 

Exclude open files
(deny all access to
source file during
transfer)

Use this option when you want to replicate only files that are
closed. Files that are opened or locked will be retried based
on the  retry open/inaccessible files setting. Users will be
denied complete access to the source files that are being
transferred. 

We recommend you use this option when doing real-time bi-
dirrectional synchronization/collaboration between two hosts.
For collaboration between more then two machines we
recommend you use the Exclude open files (allow read
access to source file during transfer) option. 

Related Options
Managed Files
Global Settings

Note: In order to replicate locked files you will require the VSS add-on module. If you do not configure the
Managed Files setting to use VSS, locked files will be retried based on the  retry open/inaccessible files setting. 

http://www.peersoftware.com/products/recommended_options/vss.aspx
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1.1.10  Managed Files

Topics
Managed Files Options
Managed Files - Global Settings

Note:  Features listed on this page require the VSS option.

Managed Files

The options listed on this page can be accessed from the Managed Files window. 

Enable Managed File
Access (Source Files
Only)

Enabling this option will allow you to reliably backup open and
locked files while users continue to work on them. For this
feature to be available you will require the Volume Shadow
Copy Service (VSS) add-on module. This technology has
been integrated with PeerSync to allow synchronization of
critical data such as system files and databases. By default
this feature is enabled at the end of a manual synchronization
and is run every 2 hours during persistent (Real-Time or
scheduled) modes. This interval can be modified from the
Global Settings screen via the Global Managed Files Options
link to a minimum interval of 30 minutes. For more features on
configuring this option please view the Managed Files
Arguments.

Synchronize
open/locked files via
Managed Files

Through the use of this feature PeerSync will enable
processing of the Open and Locked Files from the local
machine, through the use of the Volume Shadow Copy
Service (VSS) technology. Please note VSS will delay
processing of files to the specified interval.  VSS is an add-on
module.

Synchronize ALL files
via Managed Files

Through the use of this feature, you can force PeerSync to
send all the file processing through the Volume Shadow Copy
Service (VSS) technology. Please note VSS will delay

http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
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(including files that are
not open/locked)

processing of files to the specified interval. VSS is an add-on
module.

Related Options
Global Settings

Notes: 

1. These options require the VSS add-on module. Please visit https://www.peersoftware.com or contact Sales for
additional information.

1.1.11  Performance

Topics
Performance Overview
Options/Commands

Performance Options

The options listed on this page can be accessed from the Performance window. 

File Read/Write Buffer
Size

This feature allows you to change the read/write buffer sizes to
optimize performance/speed across various network
environments or on the local machine. In most cases this will
increase performance dramatically but you will probably need
to test this feature in your environment to determine what
advantages can be gained from altering this size.

The minimum value is 256 bytes.
The default value is 64 KB.
The maximum value that can be set using the track bar is 128
KB.
The maximum value that can be set using the up arrow or by
manually typing in the spin edit field is 128 KB

http://www.peersoftware.com/products/recommended_options/vss.aspx
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Buffer Size Upper Limit
(* Multi Threading
Optionng Option)

A higher upper limit of 1 MB is available with the Multi
Threading Option option. This value can be set using the up
arrow or by manually typing a set value into the spin edit
field. 

Throttle bandwidth -
Use x percent of
available bandwidth

This feature is designed to limit or slow down the pulse of
reads and writes performed by PeerSync, at the percentage
specified, in order to keep bandwidth available for other
applications to use. This is done at the file level and is
performed by each Copy Thread during the transfer of each
file. As we copy a file we track how long it takes to read and
write data from the source to the target. Every 100
milliseconds from the start of a file transfer we calculate how
much time to allot for processing and sleeping based on the
percentage set for the option.

Examples:

100% Always Process
90% Process for 90 milliseconds Sleep for 10 milliseconds
every 100 milliseconds 
50% Process for 50 milliseconds Sleep for 50 milliseconds
every 100 milliseconds
10% Process for 10 milliseconds Sleep for 90 milliseconds
every 100 milliseconds

In summary, PeerSync determines bandwidth throttling by
calculating the amount of time required to send a packet of
data across your network and then applying a delay based on
the throttling percentage specified. 

Time & Day Options
Limit Bandwidth Trottling between the hours and days defined
for the selected Job. Using a W+ switch in the /Q8B
argument (i.e. /Q8BW+) will display/report bandwidth % used
for file add and update events as part of the remarks field.

Notes: 
1. This methodology should dynamically allow for PeerSync to transfer data

at a fast pace when no other applications are using bandwidth and allow
it to back off when other applications are using bandwidth.

 
2. This methodology is more accurate when using smaller Read/Write Buffer

settings. 

3. This methodology does not include small files that take less than 100
milliseconds to process. 

Enable intelligent
network load balancing
(when applicable)

The network load balancing option will automatically set a
read/write buffer size based on recommendation from NIC
network cards (Installed network cards must also support this
feature).

Set maximum number
of copy threads to x (*
Multi Threading Option)

This feature will limit the number of copy threads to be
spawned and used for the selected Job during folder scans.
This thread limit does not apply to enhanced Real-Time

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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events. By using limits for scanning, it helps the Profile to
better process Enhanced Real-Time events during heavy
scan operations.

Related Options
Options/Commands

Note:  Some features described on this page require the Multi Threading Option. Please visit
https://www.peersoftware.com or contact Sales for additional information.

1.1.12  Byte Replicator

Topics
Byte Replicator Options 

Note:  Features listed on this page require the Byte Replicator options.

<%REPLICATOR%> Options

The Byte Replicator screen enables and configures Block/Byte level synchronization for
the selected Job. Through the use of this feature PeerSync will be able to transmit only
the bytes/blocks of a file that have changed instead of transferring the entire file. 

Use block/byte level
synchronization

Select this option to enable/disable block/byte level
replication. If this is disabled, PeerSync will use the standard
copy method to synchronize the file. If the Byte Replicator
fails to synchronize a file, i.e. On Failure, PeerSync will
either: 
1. Log Messages & Use Recovery Intervals (if applicable)
2. Use Default File Copy for Synchronization 

Block Size Selection This slider controls whether either Performance or Bandwidth
Utilization is most important. Files synchronized with the

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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slider set Low will take longer to complete than with the slider
set High. 

File Exclusions Clicking on the Exclusions button in the Byte Replicator
window opens theByte Replicator File Exclusions dialog.
Files that match types in the exclusion string (types by file
extension) or files that have a size lower than the Minimum
File Size will use the default file copy method instead of the
Byte Replicator feature.

Excluded File Types by Extension
Field containing a list of file types that will use the default file
copy method instead of the Byte Replicator. This feature can
be configured by clicking the button to the right of this field.
For example, to exclude files with the extension LOG you may
add either .log or log to the exclusion list. Multiple entries
need to be semicolon (;) delimited.

Minimum File Size
Files with sizes lower than the value in this field will be copied
using the default file copy method instead of using the Byte
Replicator. 

Port Configuration Clicking on the Port Configuration button in the Byte
Replicator window displays the Port Configuration dialog.
This window allows for a common TCP and/or Byte Replicator
configuration option for both the Source and Target paths
(see the TCP Port Configuration tab for more information). 

Note: The TCP WAN Connector (TCP) is an optional feature which may not
be included in your package. Please visit https://www.peersoftware.com or
contact Sales for additional information. 

Note: The Profiler will not support Well Known Port numbers 0 - 1023. You
must use port numbers that are greater than or equal to 1024. 

Notes: 

1. The Byte Replicator is an optional feature which may not be included in your package. Please visit
https://www.peersoftware.com or contact Sales for additional information. 

2. When you use a local drive letter (either for the source or target path) you need to make sure the drive is assigned
as an administrative share (i.e. D$) in order for the Byte Replicator to work properly.

3. In order for Byte Replicator to be enabled, the following criteria must be present:  

· The PS Listener Service has been installed on the remote machine

· The PeerSync license has the Byte Replicator add-on feature

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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1.1.13  Revisioning

Topics
Revisioning Options

Revisioning

The options listed on this page can be accessed from the Revisioning window. Through
the use of this feature, you can use PeerSync to keep multiple versions of each file. This
is a great feature for recovering a previously saved version of a file. 

Revisioning - Keep
backup files of
overwritten Target
Files

Select this option to enable/disable the use of Revisions. 

Number of backup files
to keep

Designates the number of revisions to keep for each file.
PeerSync revisions each file by adding a ".PSBAK1"
extension to the existing Target File before replacing it with
the updated Source File.

Example:  "MyFile.txt" will become "MyFile.txt.PSBAK1"

If more than one backup is selected, each file will be renamed
to the next revision when an update occurs:

Example:  "MyFile.txt.PSBAK1" is renamed to
".MyFile.txt.PSBAK2" 

The newest revisions (backup files) will bear the lowest
number while the oldest will have the higher number:

Example:  Newer... PSBAK1, PSBAK2, PSBAK3, PSBAKn
...Older
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Note:  If the "Delete Unmatched" option is selected and the Source File that
has corresponding PSBAK files deleted, all associated PSBAK files will also
be deleted.

Keep files in Target
Folder

By default, revisions will be stored in the Target Folder where
the updated Target Files reside. 

Keep files in Deletion
Folder

You also have the option of using the Deletion Folder for
storing revisions. This is quite useful when used in
conjunction with the Delete unmatched Target Files older
than x days option, which is used for automatic cleanup of old
revisions. 

Keep files in Alternate
Folder

You may specify the folder path where you would like the
revisions stored to. This option will give you the ability to
specify a separate revision folder per Job. We strongly
recommend using a Revisions Folder that is located on the
Target host computer. Relocation to an alternate drive or host
adds unnecessary processing and bandwidth overhead. For
this reason PeerSync uses the following Revisions Folder
variables: 

%TARGETROOT%
This variable resolves to the root directory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the revision path %TARGETROOT%\Revisions will resolve to
\\machine1\c$\Revisions. This variable is used by default. 

%TARGETPARENT%
This variable resolves to the parent directory of the target
path. For example if the target path is \
\machine1\c$\Target\Docs, the revisions path %
TARGETPARENT%\Revisions will resolve to \
\machine1\c$\Target\Revisions.
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1.1.14  Miscellaneous

Topics
Temp Files
Source File/Folder Alterations
Additional Event Options

Target File/Folder Alterations

These options can be found in the Miscellaneous window. 

Use intermediate file
during copy

If this box is checked, a temporary file will be created in the
Target Folder: the contents of the Source File will then be
copied into this temporary file. After a successful copy, the
Target File will be deleted and the temporary file will be
renamed to bear the Target File name. This feature ensures
that the updated file will only replace the Target File if copy is
successful. If the copy process should be interrupted
because of some outside factor (network down, power
outage, etc), the original Target file will still be preserved.
This option is enabled/disabled automatically when the Bi-
directional or Revisioning options are enabled/disabled.

Trigger additional
event after successful
copy

When this option is checked PeerSync will apply the time
stamp of the target file after successfully completing the file
transfer in order to trigger an event on the target side. This
action will cause the PeerSync installed on the Target to take
further action with the file such as transferring it to another
location that is not accessible from the originating machine. 

Force target file
attribute settings

If this feature is selected, the File Attributes Options dialog
will be displayed. In this dialog, you may select to force any
attribute on or off for the Target files that are synchronized
within the selected Job(s).

File Attribute Options This dialog provides the user the selection to ignore, force on,
or force off attribute settings on Target files that are
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synchronized within the selected Job(s). 

Related Options
Global Settings

Source File/Folder Alterations

These options can be found in the Miscellaneous window. 

Move Files - Delete
source file after
successful copy to
target

This feature will delete the Source file after the file is copied
to its corresponding Target folder. 

Note:  This feature should not be used with the Delete
Unmatched Target Files option on the File Options screen
because conjunct use of the two options will greatly increase
the chance of data loss.

Turn file archive
attribute off after
synchronization

This feature resets the archive flag on the Source and Target
file after synchronization. The Windows file system
automatically sets the archive bit for every file that has
changed; normally, this is used to indicate that a given file
has been modified since the last time its archive bit was set.
Most tape back-up programs use this flag to determine which
files have changed since the last backup. This option will alter
Source files. PeerSync uses this feature to reduce the
number of files that are checked on the Source drive. 

Notes: 

1. Source files that are not being synchronized to Target folders will NOT have their archive flags reset. This
process only occurs after successful synchronization of a changed file.

Hint: To reset all Source file archive flags, use the "Always Overwrite Target Files" feature.
This configures all files for synchronization and consequently qualifies them for the reset of
archive flags. This feature only needs to be selected once to be applied to existing sync
operations.

Additional Event Options

This option can be found in the Miscellaneous window.

Include attribute
change as
synchronization criteria

This feature allows for the synchronization of files that have
different attributes. If this feature has been selected, a Source
file whose attributes do not match the Target will still be
included in the synchronization process. 

Notes:
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1. By default this option only works during scans. Use the /LA command line
argument if you wish to enable attribute detection in real-time. 

1.1.15  Additional Features

Topics
Additional Options
Validation Options
File Time Change Options

Note:  Features listed on this page require the Enhanced Package.

Additional Options

The options on this page can be accessed from the "Additional Features" window,
available only with the Enhanced Package.

Enable file recovery This enables the file recovery option to continue a file copy
which may have been interrupted. If the Source and Target
file name and date match but the Target file is smaller,
PeerSync will start the copy operation from the last byte that
was sent the next time a sync operation is executed on the
folder. 

Replace in-use files
upon reboot

If this feature is selected, once a file is open and locked on
the Target Folder, it will be set to be replaced the next time
the machine is rebooted. 

Note:  This option is only applicable for Jobs with a local
Target Folder.

Reboot Options Button This button opens the Reboot Options dialog box. The default
option is "Do not reboot", you may also choose to "Display
reboot dialog", or to "Automatically reboot".

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Note:  Features described on this page require the Enhanced Package.

Validation Options

These settings can be accessed from the "Additional Features" window, available only
with the Enhanced Package.

Perform binary
comparison on all files
(using CRC32)

Option to check all Source and Target files for binary match
during folder scan/compare cycle (using CRC32). This check
ensures that what is on the Target matches the Source at a
binary level.

Validate target file
(using CRC32)

Option to validate file using CRC32 binary comparison after
successful file copy operation. Clicking on the Retry
Options... button opens the Validate File Copy Options dialog
box. In this window you may set PeerSync to continue re-
validating a file a set number of times. 

Retry file copy until CRC of target files is validated
Checking this option will enable the CRC Retry cycle, where,
if a file is not validated, PeerSync will retry the CRC32
validation x times. The default retry value is 1. 

Set maximum number of tries to
Specify the number of times PeerSync will perform CRC32
validation on a file if the initial validation fails. The default retry
value is 1. 

Note:  Features described on this page require the Enhanced Package.

File Time Change Options

These settings can be accessed from the "Additional Features" window, available only
with the Enhanced Package.

During comparison
subtract/add x minute(s)
from target

Option to add or delete time from Target file during folder
comparison. This allows for synchronization of files between
dissimilar time zones or to allow for some time difference
between Source and Target in case Target machine date is
slightly different from Source.

Note:  This feature may be ignored during Enhanced Real-
Time.

Convert file times to
GMT for comparison
between time zones

Option to convert file times to GMT for comparison between
time zone differences of the Source and Target folders. This
feature is quite useful way of synchronizing data between
machines located in different parts of the world. 

After synchronization
subtract/add x minute(s)
from target

This option can add or delete time from Target file after
synchronization. This allows for synchronization of files
between dissimilar time zones, or to allow for some time
difference between Source and Target in case Target
machine date is slightly different from Source.

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Note:  Features described on this page require the Enhanced Package.

1.1.16  Exceptions

Topics
Exceptions Overview
Include Files
Exclude Files

Exclude Folders
Exclude File by Size
Exclude Files by Attributes
Exclude Selected File Dates

The Exceptions screen is used after you have selected a Job or Multiple Jobs from the
Profile Job List and then created an associated Source and Target Folder on the Folder
Selection screen. Through Exception options, PeerSync allows you to selectively apply
synchronization to files contained within the Source Folder according to a wide range of
explicit criteria. 

Include Files

The options on this page can be accessed from the Exceptions window. 

Include Files Use this field to determine which file types will be included as
part of synchronization. File Type Inclusions are specified by
a star command followed by the file extension (i.e. *.doc). You
can also specify specific file names and/or sub strings using
the * wildcard character. 

The default setting *.* includes all files with extensions.
Changing this to * will include all files with and without
extensions. 

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Multiple Inclusions can be used and are semicolon delimited
(i.e. *.doc;*.txt;*.exe). 

Inclusions are not case sensitive, (i.e. "A" = "a"). 

Exampl
es

*.doc  - includes any file ending with the extension
.doc 

docs - includes any file that contains the string docs
copy*   - includes any file starting with the string copy
file;dat
a;   

- includes any file containing the strings file or
data 

You may also use the ? wildcard character to further narrow
down your inclusions. The ? wildcard character can be used
to substitute any single character in the file name including
numbers. 

Exampl
es

????.*
  

- includes files that have extensions and
contain only 4 characters in the name

June??
??.*   

- includes files that have extensions, start with
the word June, and are  followed by 4
characters

??
ne????
* 

- includes files that have the characters ne in
the 3rd and 4 th positions followed by at least
4 characters

Inclusions can be typed manually, or can be specified using
either the Include File Types button or drop-down list located
to the right of the field.

Include Files Button Opens an "Exceptions" dialog box into which file extensions
may be entered. The "include all files" command * will be
shown by default. 

To add an extension, click "New." Next, type the desired
extension into the field located at the bottom of the dialog.
Repeat this process for each desired file type. Inclusions can
be deleted by selecting them from the list and clicking the
"Delete" key at the bottom of the dialog box. Once you have
finished, click the "OK" button. The dialog will close and all of
the Inclusions you have specified will automatically appear in
the Include File Types field in the proper format (separated by
semi-colons). 

The drop-down list located to the right of this field will be
dynamically populated with Inclusions as they are set through
the "Exceptions" dialog described above. They are also
added to the list when you exit the field after manually editing
the Include File Types field. Inclusions can then be specified
by selecting them from this list. This provides a way to store
and/or retrieve sets of Inclusions for later use with other Jobs.

Exclude Files
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The options on this page can be accessed from the Exceptions window. 

Exclude Files Through this field, files can be selectively excluded from
synchronization using sub strings or using wild cards. 
Exclusions are set by specifying individual characters (i.e. ~),
sets of characters (i.e. copy*), or file extensions (i.e. *.tmp)
which, if found within a file name, will exclude that file from
synchronization.

Multiple characters and strings can be used and are
semicolon delimited (i.e. ~;*.tmp;copy*) 

These settings are not case sensitive, (i.e. "A" = "a")

Exampl
es

~          - excludes any file containing the character ~

tmp - excludes any file that contains the string tmp
copy* - excludes any file starting with the string copy
*.tmp  
 

- excludes any file ending with the extension
.tmp

.tmp;.b
ak;~ 

- excludes any file bearing the strings
.tmp, .bak or the character ~

You may also use the ? wildcard character to further narrow
down your exclusions. The ? wildcard character can be used
to substitute any single character in the file name including
numbers. 

Exampl
es

*tmp?
*.*    

- excludes all files that contain the string tmp
followed by at least one character before the
extension

Exclusions can be typed manually, or can be specified using
either the Exclude Files Button or drop-down list located to
the right of the field.  

Exclude Files Button Opens a dialog box into which Exclusions may be entered.

To add an Exclusion click "New," then type the desired
character or string into the field located at the bottom of the
dialog. Repeat this process for each Exclusion. Entries can
be deleted by selecting them from the list and clicking the
"Delete" key at the bottom of the box. Once you have
finished, click the "OK" button. The box will close and all of
the Exclusions you have specified will automatically appear in
the Exclude Files field. 

The drop-down list located to the right of this field will be
dynamically populated with Exclusions as they are set
through the dialog box described above. They are also added
to the list when you exit the field after manually editing the
Exclude Files field. Exclusions can then be specified by
selecting them from this list. This provides a way to store
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and/or retrieve sets of Exclusions for later use with other
Jobs. 

Exclude Folders

The options on this page can be accessed from the Exceptions window. 

Exclude Folders Use this field to exclude folders from synchronization by
specifying a folder name in file path format, (i.e. \TEMP\ or C:
\WINDOWS\). These examples will exclude any folder path
that contains these strings including sub-folders. 

If you wish to exclude only a specific or root folder such as
"C:\WINDOWS\" but include sub-folders you must include a
"#" in front of the complete folder path (i.e. "#C:
\WINDOWS\"). This example will exclude any files in this
directory but include any files in its sub-folders. A semicolon
separates multiple folder exclusions. 

If you wish to exclude multiple folders that contain the same
string do not include the "\" at the end of the folder exclude
(i.e. \Docs). 

These settings are not case sensitive, (i.e. "A" = "a")

Exampl
es

\Docs - excludes files and sub-folder in folders
starting with Docs (i.e. Docs, Docs1, DocsA,
etc.)

\Docs\ - excludes files and sub-folder in folders
named Docs

C:
\Docs\

- excludes files and sub-folder in the folder C:
\Docs\

#C:
\Docs\

- excludes files in the folder C:\Docs\ but
includes files in its sub-folders

Exclusions can be typed manually, or can be specified using
either the Exclude Folders Button or drop-down list located to
the right of the field. 

Exclude Folders Button Opens a dialog box into which Folder Exclusions may be
entered. 

To add an Exclusion, click "New," then type the desired folder
name into the field located at the bottom of the dialog. Repeat
this process for each Exclusion. Entries can be deleted by
selecting them from the list and clicking the "Delete" key at
the bottom of the box. Once you have finished, click the "OK"
button. The box will close and all of the Exclusions you have
specified will automatically appear in the Exclude Folders
field. The drop-down list located to the right of this field will be
dynamically populated with Exclusions as they are added.
Exclusions can then be specified by selecting them from this
list. This provides a way to store and/or retrieve sets of
Exclusions for later use with other Jobs.
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Exclude empty source
folders

This feature will exclude and will not sync empty Source
Folders to the Target.

Exclude File by Size

The options on this page can be accessed from the Exceptions window. 

Exclude File Sizes Use the "Less Than" or " Greater Than" fields to exclude files
based on their size in bytes. Zero, by default, includes all
files.

Include Files by Date

The options on this page can be accessed from the Exceptions window. 

Selected File Dates Use this field to specify files set for synchronization according
to their date stamp. The default setting includes all file dates.
Clicking the button to the right of this field opens a "Select
File Dates" screen. This screen allows you to include all files,
include files more than x days old, include files bearing the
current and past x day's date, or specify a range of the dates.
The Set Today's Date button automatically updates the
existing range to reflect the current day.

Include Files by Attributes

The options on this page can be accessed from the Exceptions window. 

Current Attributes This field displays "Default" or "Customized" to indicate
whether the default attributes have been changed. Clicking
the button to the right of this field opens a window from which
file/folder attributes may be included. All attributes are
selected by default. Uncheck the file/folder attributes you do
not wish to be used as criteria for synchronization. 

Exclude Files by Attributes

The options on this page can be accessed from the Exceptions window. 

Current Attributes This field displays "Default" or "Customized" to indicate
whether the default attributes have been changed. Clicking
the button to the right of this field opens a window from which
file/folder attributes may be excluded. All attributes are
unchecked by default. Select the file/folder attributes you
wish to be used as criteria for exclusion. 
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1.1.17  Reporting

Topics
Reporting Overview
Report File Content
Log File Size/Content
SNMP Options

Reporting

The options listed on this page can be accessed from the Reporting window. PeerSync
automatically generates Log Files providing a detailed history of all synchronization
events. This screen is used to view Log Files and set their reporting characteristics. 

Use Log File This feature enables or disables Log file generation. The
default file, PeerSync.Log, is located in the path in which
PeerSync has been installed. This field also supports
File/Folder Path Variables and when used the current path
will be displayed above the field.

Overwrite Existing Log
File

Use this feature to report only the most recent PeerSync
activity in the Log File. If this feature is not selected, all
PeerSync processes will be reported in succession. 

View Log File This button allows you to view Log reports by opening the file
in a text editor. 

Clear Log File This button allows you to clear Log reports. 

Reporting File Content

The options listed on this page can be accessed from the Reporting window. Using the
check boxes provided in this section of the Reporting screen, you can specify what will
be reported in the Log File. The Default setting is to include all items except Folder
Names.
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Added Files This feature adds an entry for any file that has been added to
the Target.

File Date Includes date associated with each file contained in the Log.

File Size Includes size of each file contained in the Log.

Updated Files This feature adds an entry for any file that has been updated
in the Target.

File Time Includes time associated with each file contained in the Log.

Transfer Time Includes time it takes to transfer the file in milliseconds.

Summary Appends a summary of activity to the end of the report.

Folder Names Indicates the names of synchronized folders.

Folder Creation This feature creates an entry for any folders that did not exist
in the Target and had to be created during the
synchronization process.

Messages This feature logs any messages or application errors found
during synchronization.

Exceptions This feature logs any file/folder exclusion found during
synchronization. 

ACLs This feature logs any file/folder ACL updates during scans
and real-time.

Note:  Application errors are additionally written to a file called "PS Error.log," regardless of whether or not that
option has been selected.

Log File Size/Content

The options listed on this page can be accessed from the Reporting window.

Set the maximum log
file size to x bytes

By entering an amount into this field you can limit the size of
Log Files created by PeerSync. When this limit is reached,
the next reporting session will first rename the existing file to
FILENAME.BAK1.Log and then create a new, blank Log File
to which subsequent data will be added. Two backups
FILENAME.BAK1.Log and FILENAME.BAK2.Log will be kept
for each unique Log file. To customize the number of log files
to backup add the following entry in the PSDef.cfg file:

[Misc Options]
LogBackUpFileCount=3

Unicode content This option will enable the reporting of Unicode content.

SNMP Options

The options listed on this page can be accessed from the Reporting window, available
only with the Enhanced Package.

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Use SNMP reporting
(errors only)

Use Simple Network Management Protocol error reporting.

SNMP Options Button This button opens the SNMP Options dialog box. Once this
box has opened, it allows you to select the Destination IP and
Trap Prefix to be used for SNMP reporting. Please refer to
your SNMP management software for more details. 

Note: To properly use the installed mib file you need to
rename the psi_def.mib to psi.mib.

Note:  Features described on this page require the Enhanced Package.

1.1.18  Admin Reporting

Topics
Admin Reporting Overview
Report File Content
Report File Name
Report File Path
Admin Report Cycle Options
Advanced Settings

Admin Reporting

The options listed on this page can be accessed from the Admin Reporting window. This
screen allows you to create a unique report for administration purposes. Admin Reports
generated during sync operations can be saved to a specific administrative folder (in a
local or network path). Admin Reports are made uniquely identifiable through a choice of
naming conventions, (i.e. Computer Name or User Name with date\time stamps). 

Create administrative
report files

This feature enables or disables the Administrative Reporting
feature.

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Note:  Admin reporting files do not display Unicode characters.

Report File Content

The options listed on this page can be accessed from the Admin Reporting window. 

Summary/Messages
only

Appends a summary of activity to the end of the report. This
option will also log messages.

Standard report file
content

This feature directs Report content to follow those
conventions also utilized in PeerSync Log Files. 

Messages only Only reports messages and application errors. 

Note:  When in enhanced Real-Time or when using Multiple Job Threads standard reporting will be used if
summary is selected. 

Report File Name

The options listed on this page can be accessed from the Admin Reporting window. 

Report file name Allows you to choose between a "Local Computer" or
"Logged-On User" Administrative Report. The reports will
bear the selected name as a prefix, followed by the created
date and time of the Report (i.e.  COMPUTER-
111507172625011_00001.RPT). 

Report File Path

The options listed on this page can be accessed from the Admin Reporting window. 

Report file path This field displays the location of Admin Report files. This
field also supports File/Folder Path Variables and when used
the current path will be displayed above the field.

Admin Report Cycle Options

The options listed on this page can be accessed from the Admin Reporting window. 

Create a report for
every event

This option allows for a report to be generated on every event
(Add/Update/Delete/Message).

Create a report on an
interval

This option allows for a report to be generated at a specific
interval. You may specify the interval from the input field to
the right of this option.

Create a report once a
day

This option allows for a report to be generated once a day.
You may specify the time of the day from the input field to the
right of this option.

Create a report once a
week

This option allows for a report to be generated once a week.
You may specify the day of the week from the drop down list
to the right of this option.
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Only use Advanced
Settings

This option allows for a report to be generated based on the
configuration of the Advanced Settings only. 

Advanced Settings

The options listed on this page can be accessed on the "Advanced Settings" button from
the Admin Reporting window. 

At the start of this
Profile

This option allows for a report to be created at the start of the
Profile.

At the stop of this
Profile

This option allows for a report to be created at the stop of the
Profile.

For each individual
error message as it
occurs

This option allows for a report to be created for each error.

After each scan (log all
non-scan events on the
cycle specified)

This option allows for a report to be created once a day. You
may specify the time of the day from the input field to the right
of this option.

After each scan/cycle
even if no events
occurred

This option allows for a report to be created after each scan
even when no events occurred.

1.1.19  Email Reporting

Topics
Email Reporting Overview
Report File Content
Report File Name
Email Configuration
Email Report Cycle Options

Email Reporting
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The options listed on this page can be accessed from the Email Reporting window. This
screen allows you to create a unique report for administration purposes. Email Reports
generated during sync operations can be sent to an administrator, shared mailbox or a
specified user. Email notification of synchronization activity can be sent upon completion
of entire Profile or during persistent synchronization operations. Email Reports are made
uniquely identifiable through a choice of naming conventions, (i.e. Computer Name or
User Name with date\time stamps). 

Create administrative
Email messages

This feature enables or disables the Email Reporting feature.

Note:  Email reporting messages do not display Unicode characters.

Report File Content

The options listed on this page can be accessed from the Email Reporting window.

Summary/Messages
only

Appends a summary of activity to the end of the report. This
option will also log messages.

Standard report file
content

This feature directs Report content to follow those
conventions also utilized in PeerSync Log Files. 

Messages only Only reports messages and application errors.

Note:  When in enhanced Real-Time or when using Multiple Job Threads standard reporting will be used if
summary is selected. 

Report File Name

The options listed on this page can be accessed from the Email Reporting window.

Report file
name

Allows you to choose between a "Local Computer" or "Logged-On User"
Administrative Report. The emails will bear the selected name as part of
the Subject filed. For example: "PeerSync Summary Report for
COMPUTER (PeerSync Started)". 

Email Configuration

The options listed on this page can be accessed by clicking on the "Email Configuration"
button from the Email Reporting window.

Attach log
files

Allows you to attach the reporting section log file to emails generated by
this application.

Delete after
successful
send

Deletes the log file after a successful email attached send.

Email
Configuration
Button

This button opens the Email Configuration dialog box:  Once this box
has opened, it allows you to select the SMTP Host, User ID, Port, who to
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send to, and who to send Carbon Copies to and what email address to
send from.

SMTP Host
The host name or IP address of the SMTP mail server to send alert
emails to.

User ID
The username to authenticate with the SMTP mail server. This is
normally not needed. (Optional)

Port 
TCP/IP connection port. It is recommended that you leave the default
setting unless your email server requires otherwise.

To
The email address of the person who is to receive the email.  This user
sometimes needs to be a valid user on the SMTP mail server. You may
add multiple email addresses in this field. Use a semicolon (;) as a
delimiter. 

CC
The email address of the person who is to receive a Carbon Copy of the
email. You may add multiple email addresses in this field. Use a
semicolon (;) as a delimiter. 

From 
The email address that will appear in the From field of the email. This
email does not need to be a valid email. For example it can be used to
identify the Job that generated the email by using the %JobName%
variable (i.e. %JobName%@MyCompany.com).

Send Test Email
Clicking on the Test Connection button will send a test email to the
configured email address(es) and let you know if PeerSync was able to
successfully connect and send an email via the configured SMTP mail
server. It is highly recommended that you test the configuration before
saving the options.

Email Report Cycle Options

The options listed on this page can be accessed from the Email Reporting window.

Create a
report for
every event

This option allows for an Email to be sent on every event
(Add/Update/Delete/Message)

Create a
report on an
interval

This option allows for an Email to be sent at a specific interval. You may
specify the interval from the input field to the right of this option.

Create a
report once
a day

This option allows for an Email to be sent once a day. You may specify
the time of the day from the input field to the right of this option.
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Create a
report once
a week

This option allows for an Email to be sent once a week. You may specify
the day of the week from the drop down list to the right of this option.

Only use
Advanced
Settings

This option allows for an Email to be sent based on the configuration of
the Advanced Settings only. 

Send Email Reports

The options listed on this page can be accessed by clicking on the "Advanced Settings"
button on the Email Reporting window.

At the start
of this
Profile

This option allows for an Email to be sent on every event
(Add/Update/Delete/Message).

At the stop
of this
Profile

This option allows for an Email to be sent at a specific interval. You may
specify the interval from the input field to the right of this option.

For each
individual
error
message as
it occurs

This option allows for an Email to be sent at a specific interval. You may
specify the interval from the input field to the right of this option.

After each
scan (send
all non-scan
events on
the cycle
specified)

This option allows for an Email to be sent once a day. You may specify
the time of the day from the input field to the right of this option.

After each
scan/cycle
even if no
events
occurred

This option allows for an Email to be sent after each scan even when no
events occurred.

Email Report Content

The options listed on this page can be accessed by clicking on the "Advanced Settings"
button on the Email Reporting window.

Send
content in
the body of
the Email

This option will write the content for the email report into the body of the
email.

Send
content as
an

This option will generate a file with the content of the email report and
attach the file to the email.
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attachment
to the Email

Place
content in a
file and send
a link in the
Email

This option will generate a file with the content of the email report and a
link to the file will be sent within the body of the email.

1.1.20  Pre/Post Process

Topics
Pre/Post Process Overview

Pre/Post Process

The options listed on this page can be accessed from the Pre/Post Process window. This
screen allows the user to choose external applications / scripts to be run before and after
the processing of a given Job. 

Before Use this field to specify (by file path) which application or script you
would like to run before processing a Profile. File paths can be manually
entered, or the open folder icon can be used to locate files.  You may also
use pre defined configuration commands. See our support page for a list
of available options.

After Use this field to specify (by file path) which application or script you
would like to run after processing a Profile. File paths can be manually
entered, or the open folder icon can be used to locate files. You may also
use pre defined configuration commands. See our support page for a list
of available options.

Wait for
application
to end
before
continuing

Check this feature if you want PeerSync to wait for the applications
specified in the "Before" and "After" fields to close before processing
additional tasks. 

https://kb.peersoftware.com
https://kb.peersoftware.com
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Use
maximum
wait time of
x seconds

Selecting this feature sets a limit (in seconds) for how long PeerSync will
wait for the applications specified in the "Run Before" and "Run After"
fields to close. In order to activate this function, the "Wait for Application
to Terminate" function must be checked. The default, when this feature is
not checked, is to wait indefinitely.

1.2  Advanced Options

Advanced Options
Migrate Shares
NetApp Settings
Global Migrate Shares Options
Global Advanced File Xfer Options 

1.2.1  Migrate Shares

Migrate Shares

The following settings can be accessed from the Advanced Options window. 

Add Shares: Do Not
Update or Delete

Copy shares from the source folder to the relative target
folder, where non-matching shares within the target folder are
left on the target. 

Match Shares: Add,
Update and Delete

Copy shares from the source folder to the relative target
folder, where non-matching shares within the target folder are
removed. 

Replace Shares: Add
and Overwrite

Copy shares from the source folder to the relative target
folder, where existing matching shares on the target system
are overwritten.

Add Shares with the
selected Prefix

Copy shares from the source folder to the relative target
folder, with the selected prefix.

Add Shares with the
selected Suffix

Copy shares from the source folder to the relative target
folder, with the selected prefix.
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1.2.2  NetApp Settings

NetApp Settings

While share migration between most platforms can be accomplished using standard
Windows API calls, NetApp cDOT requires the use of ONTAPI calls to read and write
share configuration. 

The following settings can be accessed from the Advanced Options window and facilitate
the connection to ONTAPI for handling share information. Platforms other than NetApp
cDOT do not require these settings. 

Source Configuration Provide the Username and Password log on settings for the
Source NetApp cDOT system. Optionally, the Management
IP address can also be provided. Click the Get Info button to
validate the source system information. These settings are
necessary if trying to Migrate Shares from a cDOT source
system. 

Target Configuration Provide the Username and Password log on settings for the
Target NetApp cDOT system. Optionally, the Management
IP address can also be provided. Click the Get Info button to
validate the target system information. These settings are
necessary if trying to Migrate Shares to a cDOT target
system. 

1.2.3  Global Migrate Shares Options

Global Migrate Shares Options (For All Jobs with Migrate Shares Enabled)

The following settings can be accessed from the Advanced Options window. 

Process Migrate
Shares after each scan

If the Migrate Shares option is checked, this setting will
process the selected share migration setting after each scan.

Process Migrate
Shares every x
minute(s)

If the Migrate Shares option is checked, this setting will
process the selected share migration setting every x
minutes. 

1.2.4  Global Advanced File Xfer Options

Global Advanced File Xfer Options (For All Jobs)

The following settings can be accessed from the Advanced Options window. 

Admin Backup Provides the ability to replicate files and folders that are
denied access because of their current ACL settings.

Advanced Backup Select this option to replicate files such as Symantec
Enterprise Vault stub files or files/folders which may be
Reparse Points, Sparse, Offline, Stub Files, etc.

Alternate Data Stream
(ADS) Backup

Replicate hidden Alternate Data Streams (ADS) which may
be stored behind a filename. 



PeerSync Help 108

Copyright © 1993-2021 Peer Software Inc. All Rights Reserved.

1.3  PeerSync Global Settings

PeerSync Global Settings
Global Recovery/Offline Options
Global Performance Options
Global ACL Options
Global Bi-directional Options
Global Managed Files Options
Current Command Line Argument Selection
Options/Commands

1.3.1  Global Recovery/Offline Options

Retry Open and Inaccessible Files

The following settings can be accessed from the Global Settings window. Alternatively
you can access them from the Options > "Global Settings" > "Global Recovery/Offline
Options" menu. 

Retry
open/inaccessible files
every x second(s)

Use this feature to specify, in seconds, how often PeerSync
will attempt to synchronize Source Files that are in use. If the
"Include open files" option on the File Options screen has not
been checked and "Retry" is selected, PeerSync will continue
attempting to synchronize files that are opened by other
applications. "Retry" will also work when "Include open files"
has been checked and a file is read-locked by another
application. When the "Retry" option is on, PeerSync will
synchronize the open file within x seconds after the file has
been closed.

Set maximum number
of retries to x

This feature sets a limit indicating how many times to attempt
to process open files. If the maximum number of retries gets
exceeded for a particular file PeerSync will remove it from the
retry-list until another real-time event occurs on the file or a
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scan detects that the file needs to be added/updated. Setting
the retry cycle to 0 will check the file indefinitely.  

Failed Event Reprocess Options

The following settings can be accessed from the Global Settings window. Alternatively
you can access them from the Options > "Global Settings" > "Global Recovery/Offline
Options" menu. 

Reprocess Failed
Events every x
minute(s)

Use this feature to specify, in minutes, how often PeerSync
will reprocess failed events.

Reprocess Failed
Events once a day at

Use this feature to specify the time each day for PeerSync to
reprocess failed events.

Report Level Specify the Failed Event Reprocess Report level:
0 - Report a message to all log files 
1 - If Failed Events are reprocessed
2 - Always: Even if no Failed Events needed to be
reprocessed

Pre Failed Condition Options

The following settings can be accessed from the Global Settings window. Alternatively
you can access them from the Options > "Global Settings" > "Global Recovery/Offline
Options" menu. 

Wait before failing
connection for x
second(s)

Use this feature to specify, in seconds, how long PeerSync
will wait before failing connections. 

Number of times to
wait and check

This feature sets a limit indicating how many times to wait and
check for failing connections. 

Failed Connection Options

The following settings can be accessed from the Global Settings window. Alternatively
you can access them from the Options > "Global Settings" > "Global Recovery/Offline
Options" menu. 

Retry failed
connections every x
minute(s)

PeerSync monitors persistent Jobs (Real-Time, scheduled,
interval) for connectivity, and suspends the Job until a
connection is resumed. This allows PeerSync to ensure that
synchronizations are only attempted when a connection
exists. This feature is set by default to a 1 minute interval and
can be modified or disabled. 

Always run a scan on
reconnect

This feature will initiate a full scan on every reconnect to
process any file/folder changes which may have occurred
during the connection failure. May be useful for Laptop bi-
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directional scenarios and/or to pull missed data from the
target system on reconnect.

Run a scan on
reconnect (if needed)

This feature will initiate a full scan at reconnect to process
any file/folder changes which may have occurred during the
connection failure. A scan will be performed only if a failure
occurs in the middle of scan or if a scan was missed when the
connection was lost. 

Store missed events
and process on
reconnect

This feature pertains to any Job running in a Real-Time mode.
Having this option enabled will store Real-Time events during
failed connections and will process these events at
Reconnect, eliminating the Source/Target Folder scan. This
associates with the /YW command line argument. 

Note: This action will run a scan on reconnect (if needed), if a
failure occurs in the middle of scan or a scan was missed
when the connection was lost.

Note: These settings are Global. Global Settings are global to the current Profile. These settings and options
pertain to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles
via the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the
Options/Commands screen. 

1.3.2  Global Performance Options

Global Performance Options

The options listed on this page can be accessed by clicking on the "Global Performance
Options" link on the PeerSync Global Settings window as well as the Options/Commands
window and the Options menu. Please visit Global Performance Options for more
information on this topic.

Application Priority
Selection

Move the slider to adjust the Application Priority allowing
PeerSync to run at a higher or lower priority then other
applications. 

Exclude Common Job
Exceptions in Event
Processing

This option checks the global exclusions list before file hits
such as before event processing and before adding the event
to the visual list.The command line argument for this option
is /QR. 

Performance Options

The options listed on this page can be accessed by clicking on the "Global Performance
Options" link on the PeerSync Global Settings window as well as the Options/Commands
window and the Options menu. Please visit Global Performance Options for more
information on this topic.

Use Enhanced Event
Processing

This option provides the ability to parallel process real-time,
retry or any other non-scan events. Enabling this feature will
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improve the speed of synchronization during real-time or any
other non-scanning scenarios. 

Exclude Common Job
Exceptions in Event
Processing

This option checks the global exclusions list before file hits
such as before event processing and before adding the event
to the visual list.The command line argument for this option
is /QR. 

Notes: 

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain
to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via
the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the
Options/Commands screen. 

2. Some features described on this page require the Multi Threading Option. Please visit
https://www.peersoftware.com or contact Sales for additional information.

3. Using Multiple Job Threads will produce a different file output format for all modes of reporting and message
logging (Reporting, Admin Reporting and Email Reporting). The output will NOT contain a start and stop
section or a summary, each entry will also be initially marked with a date and time stamp. If use summary is
selected for Admin or Email reporting then the standard selection will be used. The reason this is done is due
to the fact that processes will be running in parallel.

4. We have exhaustively tested PeerSync operations using 50 Job threads and 10 Copy threads. Setting your
threads over this limit may lead to potential operational issues.  We strongly discourage the use of more then
50 threads, however, you do have the option to exceed this limit by placing a greater than symbol ">" before
your desired thread value (maximum allowed is 200).  We  recommend you test your setting to ensure
PeerSync continues to operate acceptably in your environment. 

5. The Include open files (if possible) option should be used if you are using the Performance Options: Multiple
Job Threads and Multiple Copy Threads. 

6. When setting the Application Priority to High, PeerSync will use more then average CPU, you may want to use
the Set Processor Affinity argument in this scenario.

1.3.3  Global Permission Options

Global Permissions Options

This screen is activated by clicking on the Global Settings link located to the right of the
NTFS Options ... button in the Permissions window as well as from the PeerSync
Global Settings window or the Options menu. This window has the following features:

Monitor File Permission
changes during real-
time

This global feature will enable real-time monitoring to detect
and process file permission changes. 

Monitor Folder
Permission changes
during real-time

This global feature will enable real-time monitoring to detect
and process folder permission changes. 

Check for Permission
changes during scans

This global feature will validate and apply file and folder
permission during scans.

Notes:

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain
to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via
the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the
Options/Commands screen.  

2. The Monitor Folder Permission changes during real-time option turns on/off the /LG1 command line
argument. 

3. If you enable or disable Inheritance at the folder level, these changes will only get replicated during a scan.  

1.3.4  Global Bi-directional Options

Global Bi-directional Options

This screen is activated by clicking on the Global Settings link located to the right of the
Bi-directional option in the File Options window as well as from the PeerSync Global
Settings window or the Options menu. This window has the following features:

Always create a super-
set during bi-directional
synchronization

This feature will alter the way the Enable bi-directional
synchronization mode option functions by always creating a
super-set of the data on the source and target. In this mode
folders and files will always be added and not deleted. 

Use enhanced bi-
directional
synchronization mode
options

This feature will alter the way the Enable bi-directional
synchronization mode option functions by using enhanced
features to track all file and folder adds, updates, deletions,
renames and moves between scan cycles. In this mode,
PeerSync will use a hidden system trigger file within each
sub-folder to store information about the last scan cycle for
that sub-folder. Using this trigger file, PeerSync can
determine if a Folder was added, deleted, renamed or moved
since the last scan.

Note: This feature is not supported when using the Enhanced
Scanning option.

Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain
to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via
the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the
Options/Commands screen. 

2. Please refer to our White Papers page for step-by-step tutorials to achieve real-time or scheduled bi-
directional synchronization. 

3. When the "Always create a super-set during bi-directional synchronization" option is NOT selected (i.e. doing
standard or enhanced bi-directional synchronization) we recommend you add /YO- and /QYD:0 to your list of
command line arguments. These options will ensure that during standard or enhanced bi-directional
synchronization, deleted files from one side are not re-added by the other side. These arguments should NOT
be used if there are more than two machines involved in a bi-directional synchronization.  

1.3.5  Global Managed Files Options

File Manager Interval

By clicking on the Global Settings link from the Managed Files window you will be able to
configure the File Manager Interval option. Alternatively you can access this screen
from theGlobal Settings window or from the Options menu. 

https://kb.peersoftware.com
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PeerSync uses the Volume Shadow Copy Service (VSS) in order to allow
synchronization of open/locked files. In order to enable this feature you will require the
Managed Files add-on module. Developed by Microsoft, VSS is a storage management
framework designed to create a point-in-time copy/snapshot of a volume. This method
works well with applications that are VSS compliant. VSS does not support Novell
NetWare systems.

Run Managed Files List
Manager every x
minutes

By default the Managed Files is set to run on an interval of
120 minutes. This interval may be changed by simply
changing the interval time. By default, Managed Files will run
at the end of the initial scan if Scan Job once at start is
enabled. Subsequent open and locked files detected in real-
time or during scans will be thrown into the Managed Files list
to be processed based on the Managed Files interval.

Notes: 

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain
to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via
the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the
Options/Commands screen. 

2. These options require the VSS add-on module. Please visit https://www.peersoftware.com or contact Sales for
additional information.

3. The minimum Managed Files interval is 30 minutes.

4. This feature only works for local Source folders.

1.3.6  Current Command Line Arguments

Global Command Line Arguments List

From the Options/Commands window, double-clicking on the "Command Line
Arguments" filed or selecting the button to the right of it will open the Command Line
Arguments dialog. The Command Line Arguments dialog can also be accessed from the
PeerSync Global Settings window as well as from the Options/Commands window or the
Options menu. 

Command Line
Arguments

In this dialog you can modify, add or delete arguments to be
used when launching PeerSync through any of the modes
described in the Startup/Service screen or via the Run/View
Current Profile Activity screen. This dialog displays the
current arguments selected for the Profiler and will also allow
for the selection and modification of additional Command Line
Arguments by double-clicking this field or selecting the
Current Arguments Button to the right of the field.

Note: These settings are Global. Global Settings are global to the current Profile. These settings and options
pertain to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles
via the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the
Options/Commands screen. 

http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
https://www.peersoftware.com
http://www.peersoftware.com/contact.html
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1.3.7  Global Display Options

Profiler Options 

Options located on this screen can be accessed from the  Options/Commands > Display
Options window and the Options > Global Settings > Display Options menu.

Enable
Basic
Display

This feature will have PeerSync open the Profiler, if it is not already open,
and send status messages to be displayed on the Run/View PeerSync
screen. 

Enable
Advanced
Display

This option activates the Show Advanced Display link at the bottom
right corner of the  Run/View PeerSync screen. When this link is clicked,
the PeerSync Advanced Display panel will be shown. The advanced
display contains a Jobs Stats panel on the top and an Advanced
Run/View PeerSync  panel at the bottom. The command line argument
to disable this option is /QQ<<.

PeerSync Options (Application Runs Only)

Options located on this screen can be accessed from the  Options/Commands > Display
Options window and the Options > Global Settings > Display Options menu.

Display
status in
PeerSync

This feature will show the PeerSync Status Display dialog box during
synchronization to view activity, status and other information while
PeerSync is running. 

Display
status in
PeerSync
upon
completion

This feature will have PeerSync pop-up the PeerSync Status Display
dialog at the end of synchronization (only in non-persistent modes) to
view activity, status and other information upon completion. 

 Profiler/PeerSync Options

Options located on this screen can be accessed from the  Options/Commands > Display
Options window and the Options > Global Settings > Display Options menu.

Job Stats This feature allows for the Jobs Stats panel in the PeerSync Advanced
Display to get updated. Use /QP to disable this option via the command
line.

Job Scans When enabled, this option adds a Job Scans tab to the Advanced
Run/View PeerSync panel. This table lists Base/Root,
Enhanced/Expanded, and RT/Sub-folder scans with statistics and
progress for all the Jobs or only the selected Job. The command line
argument for this option is /Q8BJ+.

File Copy
Progress

This feature will show the progress of a file transfer in the PeerSync
Status Display or the Advanced Run/View PeerSync panel. This
feature requires the Multi-Threading Option. The command line argument
for this option is /QQ.

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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Historical
Data 

When enabled, this option adds a Historical Data tab to the Advanced
Run/View PeerSync panel. This tab contains a subset of data from the
PeerSync Jobs Stats panel (Xfer Rate, Bytes and Event Averages) and
is broken down into total, hourly, daily, and weekly statistics for all the
Jobs or only the selected Job. The command line argument for this option
is /Q8BH+.

Related Options
Performance Options
Command Line Arguments

Notes:  

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain
to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via
the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the
Options/Commands screen. 

1.3.8  Global Reporting Options

Messages By Profile

Options located on this screen can be accessed from the  Options/Commands >
Reporting Options button and the Options > Global Settings > Reporting Options...
menu.

Create a
message log
file for this
Profile

Use Profile message log file.

Messages By Jobs

Options located on this screen can be accessed from the  Options/Commands >
Reporting Options button and the Options > Global Settings > Reporting Options...
menu.

Create a
message log
file for each
Job

Use Job message log file.

Global Admin/Email Reporting Options

Options located on this screen can be accessed from the  Options/Commands >
Reporting Options button and the Options > Global Settings > Reporting Options...
menu.
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Send
messages
for failures
only

When sending messages for admin/email reports filter on failures only (F
switch in the /Q8E argument - i.e. /Q8EF).

Append
Global Stats
Information

Append Global Stats to admin/email reports (G switch in the /Q8E
argument - i.e. /Q8EG).

Append Job
Stats
Information

Append or attach Job Stats information to admin/email reports (S+ switch
in the /Q8E argument - i.e. /Q8ES+). Note: To attach a csv file instead
use a V+ switch in /Q8E argument - i.e. /Q8ES+V+

Append
Historical
Data
Information

Append or attach Historical Data information to admin/email reports (H+
switch in the /Q8E argument - i.e. /Q8EH+). Note: To attach a csv file
instead use a V+ switch in /Q8E argument - i.e. /Q8EH+V+.

1.3.9  Options/Commands

Topics
Display/Reporting Options
Performance Options
Command Line Arguments

Display/Reporting Options - All Jobs

Options located on this screen can be accessed from the  Options/Commands window.

Show tray
icon

If enabled, PeerSync will display an icon in the system tray for PeerSync.
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Enable
display
options

If enabled, the following Command Line arguments will be
set: /Progress, /GO, /GL, /TD, /QP, and /QQ.

Enable
reporting
options

If enabled, one of the following Command Line arguments will be
set: /YLP or /YLF

Set Access
Password...

Sets a password for access to the Profiler. Once set, the password must
be entered in order to make changes to the Profiler, 

Display
Options...

See Global Display Options for details.

Reporting
Options...

See Global Reporting Options for details. 

Performance Options - All Jobs

Options located on this screen can be accessed from the  Options/Commands window.

Enable
FastSync

Enable FastSync for improved scan performance (/GFX>Y>... Command
Line Argument). Checking this box will show you a list of PeerSync
features that are not supported by FastSync, as well as bring up a dialog
for tuning FastSync behavior. See FastSync Settings for details.

Use Multiple
Job Threads
- Set
maximum
number of
threads to

Enable this option to allow multiple Job threads to be used for parallel
processing of Jobs. Without this feature each Job will run sequentially in
the order it is listed, scheduled to run, or in the order that events are
received.

Use Multiple
Copy
Threads -
Set
maximum
number of
threads to

Enable this option to allow multiple Copy Threads to copy multiple files in
parallel processes (i.e. Simultaneous Distribution - Synchronizing from
one server to multiple servers simultaneously in a Web Farm type
environment).

Set
Application
Priority

Adjust the Application Priority allowing PeerSync to run at a higher or
lower priority then other applications. 

Related Options
Performance Options
Command Line Arguments

Notes:  
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1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain
to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via
the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the
Options/Commands screen. 

FastSync Level of Aggressiveness

Options located on this screen can be accessed from the  Options/Commands > Enable
FastSync option.

Aggressiven
ess Slider

Select the level of aggressiveness to be used by FastSync sessions. The
slider controls background threads, folder depth level, and maximum
RAM allowance. 

Retain
FastSync
data files
(for
troubleshoot
ing)

When enabled, this will leave behind FastSync data files (configuration
and reporting) for each FastSync session in the
INSTALLPATH\FastSync\Runs folder to be used for analysis, extended
reporting and/or troubleshooting.

Enable
detailed
reporting/dis
play (will
impact
performance
)

When enabled, you will see normal reporting and display at the expense
of performance. 

Note: When disabled, there will be no tracking, reporting, or display of individual add/update
events during scans as seen when not using FastSync. 

2.  PeerLock

2.1  PeerLock Job Settings

Topics
PeerLock Job Settings Overview
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2.1.1  PeerLock Job Settings Overview

PeerLock Job Settings

If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will now
be able to configure PeerLock directly from the PeerSync Profiler.  The following options
allow you to link the selected Job to PeerLock as well as append the PeerSync exceptions
to PeerLock. The options in this window can be accessed from the PeerLock > PeerLock
Job Settings window.

Include this Job in
PeerLock

Select this checkbox to automatically add the selected Job to
PeerLock. This option can be enabled automatically when
selecting the Bi-directional setting. In general PeerLock is
used in a collaboration environment where PeerSync is
configured for real-time bi-directional synchronization. 

Append Default
File/Folder Exclusions
from PeerLock

This option is enabled by default. When checked, the
PeerSync Exception settings (Include Files, Exclude Files,
and Exclude Folders) will be appended to the default/existing
list of Exceptions in PeerLock. 

Note: PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields
(i.e. %UserName%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not
supported and will not work in PeerLock. 

2.2  PeerLock Global Settings

Topics
PeerLock Global Settings Overview

2.2.1  PeerLock Global Settings Overview

PeerLock Global Settings

If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will now
be able to configure PeerLock directly from the PeerSync Profiler.  The following options

http://www.peersoftware.com/solutions/file-locking-for-ms-dfsr.html
http://www.peersoftware.com/solutions/file-locking-for-ms-dfsr.html
http://www.peersoftware.com/solutions/file-locking-for-ms-dfsr.html
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allow you to add the selected PeerSync Jobs to PeerLock and launch the PeerLock
application or Global Options for configuration. The options in this window can be
accessed from the PeerLock > PeerLock Global Settings window.

Link this Profiler to
PeerLock

If this global setting is enabled, all the Jobs that have the
"Include this Job in PeerLock" option selected will be added
to PeerLock. These Jobs in PeerLock  will be managed by
PeerSync and cannot be edited/removed directly from the
PeerLock interface.  Un-checking this option will remove all
PeerSync managed Jobs from the PeerLock interface. 

Disable Jobs that are
Not Configured from
this Profiler

Selecting this option then saving the PeerSync Profiler or
clicking on the "Save Changes in PeerLock" link will
remove/delete any existing Jobs from the PeerLock
configuration. Only Jobs that are managed by PeerSync will
be maintained.

Save Changes in
PeerLock

Click on this link to commit your PeerSync Job/Profile
updates to PeerLock. This link becomes available when you
make Job or Profile changes that need to be saved and
applied to PeerLock (i.e. Source/Target path update,
Exceptions, ...). This can be achieved also by clicking on the
Save button from the Toolbar or File Menu. If there are no
Profile updates to be saved, this link will be unavailable. 

Global Options Selecting this link will open the PeerLock Global Options
dialog that contains the configuration settings for all the Jobs
in PeerLock. When the application is terminated/closed this
link will become available. 

Show PeerLock You can run PeerLock as an application or as a service.
Clicking on this link will launch the PeerLock interface where
you can start PeerLock to run as an application or as a
service. You can also start/stop the PeerLock service directly
from the PeerLock Run/View window in the PeerSync
Profiler. 

Through the PeerLock interface  you will be able to view the
files that are Locked or Released by PeerLock when it is
running as an application.  This status information is not
available when PeerLock is running as a Service. The
PeerLock Jobs that are managed by PeerSync will be un-
editable. When the application is terminated/closed this link
will become available. 

Note: You will need the Peer Administrator product In order to view the
PeerLock status while running as a service. 

Notes: 

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain
to all of the Jobs in the current Profile.

2. PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e.
%UserName%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not
supported and will not work in PeerLock. 

http://www.peersoftware.com/products/management-monitoring/peer-administrator.html
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3.  Startup/Service

3.1  PeerSync Startup/Service

Topics
PeerSync Startup/Service Overview

3.1.1  PeerSync Startup/Service Overview

PeerSync Startup/Service Options

The options in this window can be accessed from the "Startup/Service" > PeerSync
Startup/Service window. This screen allows the user to specify whether or not PeerSync
will be run upon startup of the active PC, while also defining its interaction with the
network (if applicable). This screen provides shortcuts for installing PeerSync as a
service, adding it to the Windows StartUp list, or to the Windows registry for automatic
loading upon startup. 

Disable all Startup
Options

Check this feature to prevent PeerSync from automatically
loading at Windows startup/logon.

Create Shortcut on
Desktop

This button will place the current Profile into a shortcut on
your desktop (See "Scan at Start of Profile List,"
Options/Command). A Profile Shortcut will need to be created
through this feature in order to use PeerSync's Command
Line Mode.

Add to Windows
StartUp

This button opens the Windows StartUp folder, showing links
to files and programs that open automatically upon user
logon. This button is only accessible when "Add to Windows
Startup Folder" is checked.

Add to Windows
registry

Check this feature if you want PeerSync to run automatically
when Windows boots through specification in the Windows
registry.

Run RegEdit This button opens the Windows Registry Editor. This button is
only accessible when "Add to Windows registry to run at boot"
is checked.  

Install as an NT
Service

Check this feature if you want PeerSync to run automatically
as a service under Windows NT. Click here for a Tutorial on

http://www.peersoftware.com/support/knowledgebase/item/setup-peersync-to-run-as-a-service.html
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how to install PeerSync to run as an NT Service.

To configure and run the service you must go to "Services"
located in the "Control Panel" and select "PeerSync
Professional Series Software." By default the service is
installed with the "Local System account" selected for the
service "Log on as:" option. 

Caution: If any of your Source or Target Folder Selections are not located on
the local machine, then you will have to configure the service to "Log on as:"
an alternate (Domain Admin) account on your domain so that the service has
the rights to access the remote machines and/or devices.  If you do not do
this the service may not run properly.

Notes: 
 
1. If PeerSync is running as a Service it is advised to use UNC paths or

PeerSync's Dynamic Network Drive Mapping and Unmapping feature
instead of using mapped drives do to the fact that mapped drives are not
understood when a user is not logged on.

2. You can add the argument /LSE (Log Service Events to NT Application
Log) to the following entry in the registry
(HKEY_LOCAL_MACHINE\Software\PeerSoftware\PeerSync\Service\Par
ameters). This will have PeerSync log all changes to be reported to
application log in addition to the normal logging of the start, stop, pause
and continue of the service.

3. If PeerSync is running in Real-Time mode as a service, subsequent real-
time Profiles will interfere with service operation and should not be
employed. Both Scheduled Operations and Manual (non-persistent)
operations should perform without interference to a service installation of
PeerSync.

4. The service can run without any Jobs configured or selected.

Details This button is used to view the details of the currently
installed PeerSync service. 

Remove This button is used to remove the currently installed
PeerSync service.

Create SNC extension
association for Profiler

Checking this feature causes any file with the extension .SNC
to be associated with PeerSync: PeerSync Profiles bear this
extension by default. Once this feature has been selected,
double/clicking on any SNC file will open Profiler and load that
particular file. 

Add Quick-Sync Folder
option to Explorer
menu

Checking this feature adds or removes the Quick-Sync Folder
selection from Windows Explorer. This feature is a quick and
easy way to synchronize folder(s) on the fly to backup
location(s) with the option to modify your Job settings at a
later time.

PeerSync Application
Path

This field is used to specify the location of the PeerSync
executable file. You can use the open folder icon to browse
drives in order to locate this executable file.

Starting Profiles
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The following describes ways in which PeerSync can be launched or started. 

From the Profiler By using the Launch Profile Menu Item in the Run Menu
By using the Launch Current Profile button on the Tool
Buttons Toolbar
By using the Launch Current Profile button on the Run/View
Current Profile Activity screen

Externally without the
Profiler

Setup/run from a Shortcut on the Desktop
Setup/run from the Startup Folder
Setup/run at boot from the Registry
Setup/run as a NT Service
Setup/run using the Windows Task Scheduler

Notes:

1. Individual Jobs can be synchronized using the 'Synchronize Selected Jobs' feature, found in the Profile Job List
Popup Menu. 

2. Another way of running PeerSync is by using the Quick-Sync Folder feature by right-clicking on a folder from
MS Windows Explorer.

3.2  PeerLock Startup/Service

Topics
PeerLock Startup/Service Overview

3.2.1  PeerLock Startup/Service Overview

PeerLock Startup/Services Options

If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will now
be able to configure PeerLock directly from the PeerSync Profiler.  This window provides a
way in which you can install the PeerLock service directly from the PeerSync Profiler

http://www.peersoftware.com/solutions/file-locking-for-ms-dfsr.html
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interface.  The options can be accessed from the "Startup/Service" > PeerLock
Startup/Service window.

Install PeerLock
Service

Check this feature if you want PeerLock to run automatically
as a service under Windows NT. To configure and run the
service you must go to the Services window by clicking on the
"Details" > "Show Services" button and select "PeerLock
Utility Software" item.  By default the service is installed with
the "Local System account". If your Source or Target folder is
not located on the local machine, then you will have to
configure the service to "Log on as:" an alternate (Domain
Admin) account on your domain so that the service has the
rights to access the remote machines and/or devices. 
Otherwise the service may not run properly.

Note: It is advised to use UNC paths if you plan to run PeerSync or PeerLock
as a Service do to the fact that mapped drives are not understood when a
user is not logged on.

Details This button is used to view the details of the currently
installed PeerLock service. 

Remove This button is used to remove the currently installed PeerLock
service.

PeerLock Path This field is used to specify the location of the
PeerSyncPeerLock executable file. You can use the open
folder icon to browse drives in order to locate this executable
file.

Note: 

PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e. %
UserName%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not supported
and will not work in PeerLock. 

4.  Run/View

4.1  PeerSync Run/View

Topics
Basic Display
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Advanced Display

4.1.1  Basic Display

Run/View PeerSync - Basic Display

PeerSync can be run as an Application or as an NT Service, if available and installed
from the Startup/Service screen.

This screen is used to launch the current Profile and to view current Profile activity. If the
Display Status in Profiler option is turned on from the Options/Commands screen this
screen will be shown upon execution of a Profile and will dynamically show the status of
synchronization of the current Profile as the process occurs. This screen will also be
shown upon using the Synchronize Selected Jobs feature, found in the Profile Job List
Popup Menu to display the Current Activity of the Jobs sent to PeerSync as a temporary
Profile.

Profile Displays the name of the Profile actively being processed.
This label may not match the name of the Profile currently
being configured through Profiler.

Job This indicator will dynamically display the name of whichever
Job is presently being processed for the Active Profile.

Mode This indicator will dynamically display the name of whichever
Job is presently being processed for the Active Profile.

Launch Current
Profile/Terminate
Active Profile

This button allows you to launch the current Profile. Once a
Profile has been launched, its processing may also be
terminated through this button (the label will change to read
"Terminate Active Profile"). This button offers one of three
ways to initiate an Automatic Operation. 

View Active Profile This button allows you to connect to and view the Active
Profile. 

Run as a service If PeerSync is installed as a Service you have the option of
running it as an Application or as a Service from this screen.

Start/View Service This button allows you to start the current Profile as a
Service or view the Active Profile. It is only visible if
PeerSync was installed as a service. 

Stop Service This button allows you to stop the current Profile as a
Service.  It is only visible if PeerSync was installed as a
service. 

Pause Service This button allows you to pause the current Profile as a
Service. It is only visible if PeerSync was installed as a
service. 

Resume Service This button allows you to resume the current Profile as a
Service.  It is only visible if PeerSync was installed as a
service. 

Scanned Folders Displays the total number of folders that have been scanned
using a representation of X of Y, where X indicates the
number of folders that have been scanned so far and Y
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represents the total number of folders that need to be
scanned. When the X and Y values match, the scan is
considered as complete. The progress bar to the right of
these values is a visual representation of the folders that
have been scanned. These values are reset on subsequent
scans if applicable and do not include excluded folders.

Scanned Files Displays the total number of files that have been scanned
using a representation of X of Y, where X indicates the
number of files that have been scanned so far and Y
represents the total number of files that need to be scanned.
When the X and Y values match, the scan is considered as
complete. The progress bar to the right of these values is a
visual representation of the files that have been scanned.
These values are reset on subsequent scans if applicable
and do not include excluded folders.

Scanned Bytes Displays the total number of bytes that have been scanned
using a representation of X of Y, where X indicates the
number of bytes that have been scanned so far and Y
represents the total number of bytes that need to be
scanned. When the X and Y values match, the scan is
considered as complete. The progress bar to the right of
these values is a visual representation of the bytes that have
been scanned. These values are reset on subsequent scans
if applicable and do not include excluded folders.

Large File or
Compression Status

This caption will be displayed to the right of the file name that
is currently synchronized for large files and during
compression. The caption will show the size of the file that
has been copied to the Target and/or compression status.

Checked This indicator displays the total number of files contained in
the selected Source Folders. 

Excluded Indicates the number of files that were excluded from
synchronization (See Exceptions). 

Messages Indicates the number of error messages generated during
Profile processing. 

Updated Indicates the number of Target Files that were updated
during synchronization of Profile Jobs. 

Added Indicates the number of new files added to Target Folders
during synchronization of Profile Jobs. 

Deleted Indicates the number of files deleted (or moved) during
synchronization of Profile Jobs. 

Current Job Status This indicator displays the status of the active Job. The
indicator may display one of the following: Blackout,
Source/Target disconnected (Job name), Connecting to
Target Folder (Folder), or Normal.

Pending Event Status This indicator displays the number of pending items.The
indicator may display one of the following: Pending Items
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(Events: n) (Managed Files: x) or No Pending Items

Current Event Status This indicator display the status of the events pertaining to
Job/Copy thread information or Job automation (such as
next scheduled interval, daily timer info etc.). The indicator
may display one of the following: Running Items (Job Scans:
x) (Copy Threads: y) (Failed Events: z)

Total Transferred Indicates the the total amount of bytes transferred for the
entire running Profile. 

Elapsed Time Indicates the amount of time that has elapsed during the
current Profile activity.

Show
Advanced/Normal
Display

Click on this link to toggle between the Normal and
Advanced Run/View PeerSync panels.

Refresh Click on this link to force a manual reload of the Run/View
PeerSync panel and the statistics that are being displayed.

4.1.2  Advanced Display

Jobs Stats

To see this panel, click on the Show Advanced Display link at the bottom right corner of
the Run/View PeerSync window. The Enable Advanced Display option must be
checked in order for this link to be active. The Jobs Stats display is the top panel and
contains runtime statistics for all the Jobs configured within the Profile. Clicking on a Job
will update the bottom Advanced Run/View PeerSync panel. Click on the All Jobs
entry to display all the Job statistics, cumulatively, in the bottom panel.

# Represents the automatically assigned Job number for
each Job. An icon represents the state of the Job
(Green, Yellow, or Red):

Green
 

Running with no failed events

Yello
w

Warning state indicates the Job is running with
failed events

Red Failed connection and/or offline/stopped

Job Name Lists the unique name for each Job.

Source Displays the path to the source folder.

Target Displays the target path.

Last Scan (Status:
Duration)

Displays the date and time of the last scan along
with a description of the scan state and duration.
For example: 11/17/2011 4:28:31 PM
(Completed Successfully: 00:06:05)

In Sync Displays whether each Job is in sync. In order for the In
Sync state to be set to Yes, the following criteria needs to
be satisfied:
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1. There should be zero Failed Events
2. The status starts should be Normal (i.e. source/target not

disconnected and/or not in a Blackout etc.)
3. The Last Scan (Status: Duration) for the Job has

Completed Successfully and does not contain messages
4. There are zero active events for the Job
5. The In Queue stats for the Job starts with [Processing: 0]

==> [Event File: DNE and contains [In Queue: 0
6. The Scan Needed column value is set to No

Examples of possible In Sync states:

· Yes

· Yes (As of Last Scan)

· Yes (Job Stopped - Manually)

· Yes (Job Stopped - Manually; As of Last Scan)

· No (Failed Events: 1)

· No (See Status for Details)

· No (Scan Running)

· No (Scan Pending)

· No (See Last Scan for Details)

· No (Last Scan has Messages)

· No (Active Events)

· No (Items In Queue)

· No (Scan Needed)

· No (Scan Running; Items In Queue)

Trending Displays information regarding the trending state of the In
Sync column (Up, Down, or Flat). If the number of events
within a cycle is 500 or less, the Trending status will be
Flat. If the number of events increased by 1,000 or more
within a cycle, then the Trending status will be Up. If the
number of events decreased by 1,000 or more within a cycle,
then the Trending status will be Down. 

Notes:
1. The column will show N/A if you have not reached the cycle yet and/or

there is no difference in events within the last cycle.
2. The TrendingUpValue and TrendingDnValue items are event differences

per second for Processing and In Queue event items from the In Queue
stats.

3. To adjust the default values based on desired results (i.e. you may be
stuck in the Flat state too often if you are looking for a difference in
changes), modify the TrendingDnValue and TrendingUpValue values in

the PSDEF.cfg file. 

[Misc Options]
TrendingCycle=60
TrendingUpValue=10
TrendingDnValue=10
TrendingAlwaysShowUpDnValue=0

Next Scan (Run in) Count down to the next scan for scheduled or interval scans.



PeerSync Help129

Copyright © 1993-2021 Peer Software Inc. All Rights Reserved.

Xfer Rate Determines the transfer rate in megabits per second for each
Job. Takes into account the Event Averages rate and Total
Transferred and Total Saved bytes (bottom right corner of
Run/View PeerSync) to determine the transfer rate for each
Job. The more events and the larger the average file size
calculated in the Event Averages the more accurate the
transfer rate will be.  This also shows a cumulative transfer
rate for all Jobs. 

Bytes Displays the total number of bytes that were transferred for
the specific Job or all the Jobs.

Events Shows the total number of events detected for the Job or all
the Jobs as well as number of active events currently being
processed.

Event Averages Displays the average number of events that occurred per
minute. The average size of the events are also noted.

In Queue: Scan The number of files in queue that are generated by a scan. 

In Queue: RT The number of files in queue that are real-time events.

In Queue The total number of files in queue. The queue represents the
backlock of real-time events for each job. When the queue is
empty the In Sync column is set to Yes.

Updated Counter indicating the total number of files that were updated
and their size in bytes.

Added Counter indicating the total number of files that were added
and their size in bytes.

Deleted Counter indicating the total number of files that were deleted
and their size in bytes.

Excluded Counter indicating the total number of files that were
excluded and their size in bytes.

Messages Counter indicating the total number of messages. 

Failed Events The number of failed events for each Job or all Jobs.

Real-Time Displays the state of Real-Time detection (On or Off).

Interval Scans Information when the next interval scan is to occur.

Daily Timer Scans Information when the next scheduled scan is to occur.

Status Shows the status of each Job or all Jobs.

Scan Needed Lets you know if a scan is needed (Yes) or not (No) after a
connection failure. 

Log File Path Displays the location of the log file. Used in pop-up menu.
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Jobs Stats (Right-Click Pop-Up Menu)

To see this menu, right-click on the Job Stats panel.

Select Columns.... Add or remove columns from the Jobs Stats display.

Scan Job: JobName Issues a one-time scan of the selected Job.

Scan All Jobs Issues a one-time scan of all the enabled Jobs in the Profile.

Stop Job: JobName Stop the selected Job without stopping or interrupting any
other potentially running Jobs in the Profile. 

View Log File View the log file for the selected Job.

Open Source Folder:
Path

Opens the source folder in a Windows Explorer window.

Open Target Folder:
Path

Opens the target folder in a Windows Explorer window.

Save As Saves the current Jobs Stats list into a CSV file format (i.e.
PSJobStats.csv). 

Reprocess Failed
Events

If the Job is running in a Warning state (Yellow), the Job has
failed events. Selecting this option will notify PeerSync to re-
process any failed events. This option is also available in the
Run menu.

Advanced Run/View PeerSync

To see this panel, click on the Show Advanced Display link at the bottom right corner of
the Run/View PeerSync window. The Enable Advanced Display option must be
checked in order for this link to be active. The Advanced Run/View PeerSync display
is the bottom screen. In addition to containing the same information as the Basic
Display, the Advanced Display contains the following additional tabs:

Status Containing the same information as the Basic Display
view/panel.

Updated Lists the total number of files that were updated for the
selected Job or all the Jobs. Right-click and select Save As
to export the list into a CSV file format (PSUpdated.csv).

Added Lists the total number of files that were added for the
selected Job or all the Jobs. Right-click and select Save As
to export the list into a CSV file format (PSAdded.csv).

Deletions Lists the total number of files that were deleted for the
selected Job or all the Jobs. Right-click and select Save As
to export the list into a CSV file format (PSDeleted.csv).

Excluded Lists the total number of files that were excluded for the
selected Job or all the Jobs. Right-click and select Save As
to export the list into a CSV file format (PSExcluded.csv).
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Messages Lists the total number of messages for the selected Job or all
the Jobs. Right-click and select Save As to export the list
into a CSV file format (PSMessages.csv).

Job Scans Lists how many scans are running at a Job level either for the
selected Job or for all the Jobs. Right-click and select Save
As to export the list into a CSV file format (PSJobScans.csv).

Managed Files List Lists the total number of files that are in the Managed Files
List for the selected Job or all the Jobs. Right-click and
select Save As to export the list into a CSV file format
(PSManagedFilesList.csv).

Failed Events Lists all the failed files for the selected Job or all the Jobs.
You can right-click the list and select Reprocess Failed
Events to notify PeerSync to re-process them for all the Jobs
(not Job specific). To reprocess only a specific file, you can
click the Reprocess Selected button from the Failed
Events tab within the PeerSync Status Display (when
running as an application only).  Right-click and select Save
As to export the list into a CSV file format
(PSFaileEvents.csv). 

File Copy Progress Visually displays the file copy progress for each file for the
selected Job or all the Jobs. Right-click and select Save As
to export the list into a CSV file format
(PSFileCopyProgress.csv).

Historical Data This panel displays a subset of the Job Stats table (Xfer
Rate, Bytes and Event Averages) in an hourly, daily, weekly,
and total format for all the Jobs or only the selected Job.
Furthermore, it displays a Running Event Count, a Running
Event Average and Peak Count, and a Running Job Count.
Right-click and select Save As to export the list into a CSV
file format (PSHistoricalData.csv).

Job Control This tab is available from the Advanced Run/View
PeerSync panel. It shows the Job Control Bar which allows
every Job to be stopped, started, or restarted individually. In
addition, this tab displays all Pending Jobs in a grid from
where they can be individually selected and started. This tab
can also be seen in the PeerSync Status Display panel under
the Job Stats and Control tab. 

Notes:  

For efficiency purposes, only when you click on the screens/tabs within the Advanced Run/View PeerSync
panel will the values get updated. A Cache folder within the PeerSync installation folder maintains the necessary
event files that will be loaded into the advanced display screens/tabs.
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4.2  PeerLock Run/View

Topics
Basic Display
Advanced Display

4.2.1  Basic Display

Run/View PeerLock  - Basic Display

If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will now
be able to configure PeerLock directly from the PeerSync Profiler. This window will allow
you to start/stop/pause/resume the PeerLock service. Click here for information on how to
install the PeerLock service or run PeerLock as an application. The following options can
be found in the Startup/Service window.

Launch PeerLock This button allows you to launch the PeerLock application
and monitor the files that are Locked or Released by
PeerLock. When the application is terminated this button will
become available. 

Run as a service This option is available only if the PeerLock service has been
installed and the Run as a Service option is enabled. Check
this option to run PeerLock as a Service. When checked,
you will have the options to Start, Stop, Pause and Resume
the Service. Uncheck the "Run as a service" option run
PeerLock as an Application. When this option is uncheck
you will have a "Launch PeerLock" button available. 

Start Service This button allows you to start PeerLock as a Service. This
option is available if the PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerLock
service is stopped or not running. 

Stop Service This button allows you to stop the PeerLock Service.  This
option is available if the PeerLock service has been installed,

http://www.peersoftware.com/solutions/file-locking-for-ms-dfsr.html
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the Run as a Service option is enabled, and the PeerLock
service is running. 

Pause Service This button allows you to pause the PeerLock Service. This
option is available if the PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerLock
service is running. 

Resume Service This button allows you to resume the PeerLock Service. 
This option is available if the PeerLock service has been
installed, the Run as a Service option is enabled, and the
PeerLock service is paused. 

Show
Advanced/Normal
Display

Click on this link to toggle between the Normal and
Advanced Run/View PeerLock panels.

Refresh Click on this link to force a manual reload of the Run/View
PeerLock panel and the statistics that are being displayed.

4.2.2  Advanced Display

Jobs Stats

To see this panel, click on the Show Advanced Display link at the bottom right corner
of the Run/View PeerLock window. The Enable Advanced Display option must be
checked in order for this link to be active. The Jobs Stats display is the top panel and
contains runtime statistics for all the Jobs configured within the Profile. Clicking on a Job
will update the bottom Advanced Run/View PeerLock panel. Click on the All Jobs
entry to display all the Job statistics, cumulatively, in the bottom panel.

# Represents the automatically assigned Job number for each
Job. An icon represents the state of the Job (Green, Yellow,
or Red):

Green
 

Running with no failed locks

Yello
w

Warning state indicates the Job is running with
failed locks

Red Failed connection and/or offline/stopped

Job Name Lists the unique name for each Job.

Locks (Active) Represents the total number of locks created by the specific
Job. The total number of locks that are actively being held
are also shown.

Releases Shows the total number of releases created by the specific
Job.

Lock Average Represents the number of locks that are created on average
ever minute for the specific Job.

Release Average Represents the number of locks that are released on
average ever minute for the specific Job.



PeerSync Help 134

Copyright © 1993-2021 Peer Software Inc. All Rights Reserved.

Failed Locks Shows the total number of locks that failed to be created for
the specific Job.

Status Displays the status of the Job (i.e. Stopped, Starting and
Normal).

Source The folder which is monitored for open activity.

Target The folder which is contains the files for PeerLock to lock.

Jobs Stats (Right-Click Pop-Up Menu)

Select Columns.... Add or remove columns from the Jobs Stats display. 

View Log File: Path Open the log file in the default editor for the selected Job.

Open Source Folder:
Path

Opens the source folder in a Windows Explorer window.

Open Target Folder:
Path

Opens the target folder in a Windows Explorer window.

Save As Saves the current Jobs Stats list into a CSV file format (i.e.
PLSelectionList.csv). 

Advanced Run/View PeerLock

To see this panel, click on the Show Advanced Display link at the bottom right corner
of the Run/View PeerLock window. The Enable Advanced Display option must be
checked in order for this link to be active. The Advanced Run/View PeerLock display
is the bottom screen. In addition to containing the same information as the Basic
Display, the Advanced Display contains the following additional tabs:

Target File Path Shows the file name complete with folder path for a target
file that is locked, if the file exists and/or can be locked.

Locked Display the date/time when the target file was locked.

Duration Displays the amount of time that the source file has been
opened.

Accessed By The name of the user who has opened the file or accessed
the resource.

Target Access Allowed Displays the permissions that are allowed on the opened
target file which are applied by PeerLock.

Source File Path Displays the file name complete with folder path for the
source file that has been detected as an open file.

Job Number Represents the automatically assigned Job number for each
Job.
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# Locks Displays the number of locks on the source.

Application Displays the application that has been detected as opening
the source file. 

Detection Type This column represents the PeerLock detection mode used
to detect what source files are locked/opened. This will
either be File Server Mode Detection or Local Detection. 
Note: Starting with version 3.0, PeerLock supports File
Server Mode Detection only.

Idle Time Shows the amount of time the target file will remain locked
once the source file has been released. When the source
file is closed PeerLock will wait the number of Idle Time
seconds specified before releasing the target file. During the
Idle Time period the file entry in the Locked list will be
highlighted Yellow. The Idle Time value can be set in the
Release Options dialog. This feature is intended to protect
the releasing of files during file opens and saves. Certain
applications may temporary release files during these
procedures. With this feature enabled PeerLock will wait the
set period of time to make sure the file is fully released
before unlocking the corresponding target files

Lock File Handle Displays the handle value created that is being used to lock
the temporary Lock File created by PeerLock to Interact
with other Peer Software Products. If the Interact features
are disabled then this will display 'None'.

Release Detected Shows the date and time when PeerLock detected the
source file was closed. This value will be cleared if the file is
reopened within the Idle period and the target file handle is

not released. 

Source Access Allowed Displays the permissions that are allowed on the opened
source file. 

Source Attributes Shows the attributes of the source file. 

Source Handle Displays the handle value created when the source file was
opened.

Source Modified Shows the modified date/time of the source file when it was
detected as being open.

Source Open Mode Displays the permissions that were used to open the source
file.

Target Handle Display the handle value created that is being used to lock
the target file by PeerLock. 

Target Open Mode Displays the permissions that were granted when the target
file was locked by PeerLock.

Temporary Releases Shows the number of times the source file was closed
during the Idle period. 
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Notes:  

For efficiency purposes, only when you click on the screens/tabs within the Advanced Run/View PeerLock
panel will the values get updated. A Cache folder within the PeerSync installation folder maintains the necessary
event files that will be loaded into the advanced display screens/tabs.

Command Line Arguments

PeerSync's Command Line Mode offers users the ability to configure a truly "hands-off"
installation, where operation and distribution occurs from within an easily manageable,
administrative environment. This mode allows Profiles to be executed from logon scripts,
system batch (BAT) or command (CMD) files, detailed shortcuts, and shell commands --
while also providing full access to the Profiler features through command line arguments.

Profiles will need to be created through the Profiler first in order to be further modified
through the arguments described in this topic (See Profiler Overview and related Help
Topics).  

Command Line Arguments are entered into a Profile shortcut, created during build through
the "Add to Desktop" button found on Profiler's Startup/Service screen.

Notes:  

1. For the command line arguments described in this topic, note that attention is paid to punctuation, to the order
in which arguments are entered, and that appropriate spaces are used to separate these arguments. Follow
the format outlined in the examples provided.

2. Profile .SNC file names are the only command line variables associated with operation of the Profiler. All other
arguments described in this topic are used to configure operation of the PeerSync and its execution of
Profiles.   

Profiler Command Line Arguments

As noted above, Profile (.SNC) file names are the only variables associated with operation
of Profiler. To change an .SNC file name through the command line: 

1. Right click the Profile shortcut you created during build (see StartUp/Service, "Add to
Desktop" button). 

2. Select the "Properties" item from the pop-up menu. 
3. Select the "Shortcut" tab. As shown in the following sample, the "Target" field will contain

a command line for the Profile, where "Profile One" represents a sample Profile name: 
"C:\Program Files\PeerSync\PeerSync.exe" "C:\Program Files\PeerSync\Profile

One.SNC" /USEPROFILEARG

4. Manually change the Profile Name to reflect that of the new .SNC file
5. Click the "OK" button

PeerSync Command Line Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M).

Topics
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Configuration Arguments
Performance Arguments
Reporting and Display Arguments
Automation Arguments
Synchronization Arguments
Real-time Arguments
Managed Files Arguments
Bi-directional Arguments

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page may require the Enhanced Package. 

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will
display both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html. 

1.  Configuration Arguments

Configuration Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/0:Profile
Set SNC File to Load (Profile = File):  If the /0 argument is used in a shortcut or from
the command line, PeerSync will load the Job information specified in the file.

Examples:
/0:"C:\My SNC\MyBackups.snc"
/0:MyBackups.snc
MyBackups.snc

Full path to file
Will use install directory
Will use install directory (Must be first argument)

/1:source
Set Source Path (source = Folder):  If the /1 argument is used in a shortcut or from the
command line, PeerSync will use it in conjunction with /2 to define a Source and Target
path for a Job.

Example:
/1:c:\source /2:c:\target c:\source to c:\target

/2:target
Set Target Path (target = Folder):  If the /1 argument is used in a shortcut or from the
command line, PeerSync will use it in conjunction with /2 to define a Source and Target
path for a Job.

Example:
/1:c:\source /2:c:\target c:\source to c:\target

/C:cfile

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/support/submit-a-case.html
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Load Alternate Configuration File (cfile = File):  If the /C argument is enabled,
PeerSync will use the values specified in cfile for synchronization information instead of
using the default configuration file: PSDef.cfg which is located in the install directory.

Example:
/C:C:
\PeerSync\configs\altconfig.cfg 

Use alternate configuration file 

/USEPROFILEARG
Use Arguments from Profile:  If the /USEPROFILEARG argument is used in
conjunction with a /0:Profile, PeerSync will use the arguments specified in Profile, for
synchronization. By default, when you create a shortcut on the desktop or in the startup
folder from the StartUp Options screen this argument is used.

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Command line arguments can also be identified through hints displayed on the Profiler. 

3. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will
display both a description of the feature as well as its related command line argument (if any).

4. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

2.  Performance Arguments

Performance Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/GE:x

Set Shared Process Delay:  The /GE argument is used to set the shared process delay
to allow more/less CPU utilization. This value ranges from 0 -10 where 0 (less CPU) will
use the most delay and 10 (more CPU).will use the least amount of delay.

/GK:x

Copy Thread Utilization:  If the /GK argument is enabled, PeerSync will allow up to x

threads to watch the queue that manages changes allowing for increased Copy Thread
utilization.

/GP:x

Set Email Threads:  If the /GP argument is enabled, PeerSync will allow up to x threads
to be used for email tasks.

/LK:x
Set Multitasking Delay:  The /LK argument is used to adjust the delay during
multitasking. This value may be set between 1 and 10 where 10 is the highest amount of
delay and 1 is the least amount of delay. The default value is 4.

/LN:x

http://www.peersoftware.com/support/submit-a-case.html
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Set Processor Affinity:  If the /LN argument is enabled, PeerSync will allow you to limit
which CPUs to use in a multi-processor environment, where each CPU is represented by
2 to the x value:

/LN:1 = Use CPU 1 /LN:16 = Use CPU 5
/LN:2 = Use CPU 2 /LN:32 = Use CPU 6
/LN:4 = Use CPU 3 /LN:64 = Use CPU 7
/LN:8 = Use CPU 4 /LN:128 = Use CPU 8

Examples:
/LN:1 Use CPU 1
/LN:3 Use CPU 1, CPU 2 (/LN:1 + /LN:2 = /LN:3)
/LN:4 Use CPU 3
/LN:5 Use CPU 1, CPU 3 (/LN:1 + /LN:4 = /LN:5)
/LN:15 Use CPU 1, CPU 2, CPU 3,

CPU 4
(/LN:1 + /LN:2 + /LN:4 + /LN:8
= /LN:15)

Note: By default all CPUs will be used. 

/MCT:x 
Set Copy Threads:  If the /MCT argument is enabled, PeerSync will allow up to x file
copy threads to be spawned for file copy tasks. These copy threads will be shared by
one or more Jobs during the synchronization process. 

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/MFT:x 
Set Job Threads:  If the /MFT argument is enabled, PeerSync will allow up to x Job
threads to be spawned for managing Job tasks.

Note:  This item is selectable from the Profiler via the Options/Commands Screen.

/OPTIMIZE
Optimize Performance:  If the /OPTIMIZE argument is enabled, PeerSync will disable
status screen windows used for outputting status information. This will minimize memory
allocation for the User Interface.

/PERFORMANCE:x

Set Application Priority:  If the /PERFORMANCE argument is enabled, PeerSync will
set the application's priority based on the following value of x

0: Lowest Priority
1: Below Average Priority
2: High Priority. 

Notes: 

1. This item is selectable from the Profiler via the Options/Commands Screen.

2. If the /PERFORMANCE argument is not used, PeerSync will use a default priority.

3. When setting the Application Priority to High, PeerSync will use more then average CPU, you may want to
use the Set Processor Affinity argument in this scenario.

/YK:n  
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Set Real-time Copy Thread Pool: Used to set the percentage of Copy Threads to
reserve for Real-Time events, where n can be set between the values of 1 and 99. The
default value is 10.

/YX:n  
Set File Read/Write Buffer Delay:  Used to set a delay in n milliseconds between each
file read/write cycle to allow the limiting of CPU usage and system resources during file
transfers. The higher the delay value, the less CPU used but the slower the performance
or speed of PeerSync. 

/QR
Exclude Common Job Exceptions in Event Processing: Checks the global exclusions
before file hits such as before event processing and before adding the event to the visual
list. This option creates a global file exclude list based on the file exclude list from all the
Jobs. The filter applies to real-time add and update events. Since they are applied early
in event processing there are no log entries for these exclusions. Remove the /QR option
to achieve logging. 

/Q70
Exclude Common Job Exceptions in Event Processing for FPolicy Jobs Only: This
argument is the equivalent of the /QR option but applies to FPolicy Jobs only. In the user
interface, set the Exclude Extensions list to %AUTO% to achieve the same result. 

/Q70:s
Exclude Extensions: Provide a list of comma (,) delimited file extensions to exclude
when using NetApp FPolicy detection during scans or in real-time. This can be done in
the user interface or via the command line. Use use /Q70:s, where s represents the
comma (,) delimited list of extensions to exclude (i.e. /Q70:tmp,dwl,dwl2). 

/Q7-s
Exclude Volumes: Provide a list of comma (,) delimited volumes to exclude when using
NetApp FPolicy detection during scans or in real-time. This can be done in the user
interface or via the command line. Use /Q7-s, where s represents the comma (,)
delimited list of volumes to exclude (i.e. /Q7-vol3,vol4).

/Q7+s
Include Volumes: Provide a list of comma (,) delimited volumes to include when using
NetApp FPolicy detection during scans or in real-time. This can be done in the user
interface or via the command line. Use /Q7+s, where s represents the comma (,)
delimited list of volumes to include (i.e. /Q7+vol1,vol2).

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Command line arguments can also be identified through hints displayed on the Profiler. 

3. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will
display both a description of the feature as well as its related command line argument (if any).

4. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

3.  Reporting and Display Arguments

Reporting and Display Arguments 

http://www.peersoftware.com/support/submit-a-case.html
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The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/AP
Run Pre-Sync Report:  If the /AP argument is used a Pre-Sync Report will be
generated and files/folders will not be synchronized. If you add an O to the /AP then the
previous Pre-Sync report will be Over written, if you exclude the O then the file will be
appended to an existing Pre-Sync report. If you add an S to the /AP then the Pre-Sync
report will be Shown at the end of the run (i.e.: /AP, /APO, /APOS or /APS). 

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/GL[S] 
Display status in Profiler:  If the /GL argument is used, PeerSync will open the Profiler,
if it is not already open, and send status messages to be displayed on the Run/View
Current Profile Activity screen using mail slot messaging to communicate with the
Profiler. By adding an S you can suppress the initial connection of PeerSync to the
Profiler upon activation of PeerSync.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/GM:x

Enable MSMQ messaging:  If the /GM argument is used, PeerSync will use x as the
location to manage messages in the queue. 

Example: /GM:DIRECT=TCP:209.51.171.142\PRIVATE$\MYQUEUE

/GO[F:y][C:group]
Enable Peer Administrator Broadcasts:  If the /GO argument is used, PeerSync will
use mail slots to broadcast activity across the LAN to the Peer Administrator utility for the
centralized viewing of all PeerSync activity on the network. You can launch the Peer
Administrator utility, if it is installed/available from the View Menu.

y: Identifies the number of seconds between each broadcast. The default is 3 seconds.
group: Identifies a group for the current Profile. The default is the Profile Name.

Example: /GOF:5C:MyProfiles Enabled and broadcasted every 5 seconds with a group name of

/GQ:[file][maxsize]
Create and Append Summaries into One Report:  If the /GQ argument is used,
PeerSync will append summaries into one log file.

/GR
Report Non Standard Events:  If the /GR argument is used, PeerSync will report non -
add,update, and delete actions.

/GS:x

Enable Summary Statistics Collection:  If the /GS argument is used, PeerSync will
use x as the file location to save summary statistics.

/H 
Hide Splash Screen:  Available through all registered versions of PeerSync, this
argument will suppress and hide the splash screen from the Taskbar for both the
PeerSync and Profiler applications.

http://www.peersoftware.com/products/management-monitoring/peer-administrator.html
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/H-
Only Hide the about screen:  Available through all registered versions of PeerSync,
this argument will suppress and hide the About screen for both the PeerSync and Profiler
applications.

/H+
Skip setting of main form visible: Available through all registered versions of
PeerSync, this argument will no set the main form visible and always hide the application
from the Taskbar for both the PeerSync and Profiler applications.

/LSE 
Log Service Events to the Event Viewer:  If the /LSE argument is used, PeerSync will
log events to the Event Viewer. The following options are available for this argument:

/LSEE Log messages as errors
/LSEEW  Log messages as warnings
/LSEEM  Only log messages and log them as errors

/LSEEWM  Only log messages and log them as warnings

/M 
Show Tray Icon:  If the /M argument is used, PeerSync will display an icon in the
system tray for PeerSync. 

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/PROGRESS 
Display status in PeerSync:  This feature will show the PeerSync Status Display dialog
box during synchronization so the user can see activity, status and other information
while PeerSync is running. 

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/SNMP
Enable SNMP Error Reporting:  If the /SNMP argument is used, PeerSync will use
SNMP reporting to report any errors that occur during the synchronization process.

/TD 
Display status in PeerSync upon completion:  This feature will have PeerSync show
the PeerSync Status Display dialog box at the end of synchronization (only in non-
persistent modes) so the user can see activity, status and other information upon
completion. 

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/YL 
Log Messages Only to a Log File by Filter and/or by Profile:  If the /YL argument is
used, PeerSync will log messages only to a log file based on the Filter and/or Profile. The
following options are available for this argument:
 
/YL   
/YLF 
/YLP   

Log messages for Both
Log messages by Filter Only
Log messages by Profile Only

When logging by Filter (/YL or /YLF), the Filter message log file will reside in the same
directory as the primary log file, with the same file name as the primary log file but with a
"flt.log" file extension. 
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When logging by Profile (/YL or /YLP), the log file will reside in the same directory as the
Profile, with the same file name as the Profile but with a "snc.log" file extension. 

/QP
Don't Display Job Stats: If the /QP argument is used, PeerSync will not display any Job
statistics in the Status Display window. Disabling this option reduces the amount of
overhead work PeerSync is doing. 

/QY7
XML File Creation Interval: By default PeerSync stores Profile and Job related
statistics into an easily readable XML files on an interval of every 60 seconds (if
applicable) as well as during the completion of a Job scan. This interval can be adjusted
using the /QY7:n command line argument where n represents the interval in seconds of
how often you want PeerSync to update the Profile related XML statistics. 

/QY7:(T-)(C-)(A-))(n)

n (Interval to write out statistics (60 is the default))

T
-

(Suppress .tot file creation)

C
-

( Suppress .cur file creation)

A
-

(Suppress all XML file creation and new logic for tracking file extensions)

/YB:x
Disable Tray Icon Menu Items: If the /YB argument is enabled, PeerSync will allow you
to limit which Tray Icon menu items to be disabled, where each menu item is
represented by 2 to the x value. 

Note: To disable multiple menu items simply add the /YB values together for the items
you wish to disable. 

EXAMPLES
/YB:512 Disables the Exit PeerSync menu option
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/YB:24 Disables the Open Source Folder and Open Target Folder
options
8+16=24

/YB:767 Disables All Menu Options except About PeerSync
1+2+4+8+16+32+64+128+512=767

/QP
Disable Job Stats: If the /QP argument is enabled, the Job Stats option will be
unchecked, resulting in no Job statistics being shown in the PeerSync Advanced Display
panel. 

/Q8BJ+
Enable Job Scans Tab: If the /Q8BJ+ argument is set, a Job Scans tab will be created
in the Advanced Run/View PeerSync panel showing Base/Root, Enhanced/Expanded,
and RT/Sub-folder scans with statistics and progress for all the Jobs or the selected Job.

/QQ
Enable the File Copy Progress Tab: If the /QQ argument is set the File Copy
Progress tab will be created in the Advanced Run/View PeerSync panel to show the
progress of a file transfer.  This feature requires the Multi-Threading Option.

/Q8BH+
Enable the Historical Data Tab: If the /Q8BH+ argument is set, the Historical Data tab
will be shown in the Advanced Run/View PeerSync panel. This tab contains a subset of
data from the PeerSync Jobs Stats panel (Xfer Rate, Bytes and Event Averages) and is
broken down into total, hourly, daily, and weekly statistics for all the Jobs or only the
selected Job. 

/QQ<<
Disable the Show Advanced Display link at the bottom right corner of the  Run/View
PeerSync screen.

/Q7O
Share Migration reporting levels: The default behavior with no arguments is to report
Share Errors, Share Totals, Share Actions and Share Permission Errors. 

/Q7OR- Report Share Errors and Share Totals only
/Q7OR Report Share Errors, Share Totals, Share Actions, Share Permission

Errors and Extended Share Information
/Q7OR+ Report Share Errors, Share Totals, Share Actions, Share Permission

Errors, Extended Share Information, Get and Set of Shares, Share
Permission Matches and Share Permission Skips 

/Q7OR++ Share Errors, Share Totals, Share Actions, Share Permission Errors,
Extended Share Information, Get and Set Share Information, Share
Permission Matches, Share Permission Skips and Share Permission
Actions

/Q7OV Report source and target system information
/Q7O- Use previous Share Migration Logic from v9.0
/Q7OR- - Same as /Q7OR- and disables share migration starting information
/Q7OI- Disable share migration starting information
/Q7OE Report all activity at the end of share migration, instead of during

/Q8B:
In Queue Display Options: Track pending events at the Job level and help determine if
a Job is in sync. 

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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Q+ Enable real-time stats (including RT Scans: x/y where x is RT Scans Pending and y
is RT Scans Running)

Q- Disable collection of RT Scan stats
Q++ Get the file size for RT Stats and display Bytes. This option may decrease

performance. If this is disabled (i.e. no Q++ switch in /Q8B) then bytes will show as
N/A

Q> Enable scan stats. This option may slightly decrease performance
R+ Track and display In Queue Retries
M+ Track and display In Queue Managed Files
>>
or
>>>

Enable all Scan, RT, Retry and Manged Files stats, as well as other debug stats

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Command line arguments can also be identified through hints displayed on the Profiler. 

3. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will
display both a description of the feature as well as its related command line argument (if any). For more
information on the latest features and how to implement specific scenarios please goto our support page at:
http://www.peersoftware.com/support/submit-a-case.html 

4.  Automation Arguments

Automation Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/A 
Scan at Start:  If the /A argument is appended to the command line, the Profile can be
run through its associated shortcut. As non-persistent processes, Automatic Operations
are run a single time upon manual initiation by the user. 

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/D(H):x

Delay Start of Profiler:  If this argument is used, PeerSync will delay the load/start of
PeerSync by  x seconds. With this option enabled synchronization can be canceled via a
dialog box if done within the designated interval. For example, /D5 would provide you
with a 5 second delay during which the operation can be canceled. If the /D argument
includes an H, i.e. /DH60, then the delay timer dialog will be hidden. This argument is
useful for allowing PeerSync to begin after other applications have been loaded if you are
running PeerSync at Windows startup.

/R[OyCz] 
Real-time Monitoring Argument:   The /R argument activates Real-Time Mode.
The Oy and Cz arguments are optional and specify the following retry values during Real-
Time Mode:

y = The retry count if the file is open or network is unavailable 
z = The retry count maximum 

http://www.peersoftware.com/support/submit-a-case.html
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Note: This item is selectable from the Profiler via the Options/Commands Screen.

/S 
Run Scheduled Operation:  The /S argument enables or disables Scheduled Operation
Mode for the entire Profile. This feature must be selected in order for all Scheduled
Operations set for individual Jobs to be recognized. Scheduled Mode does not apply a
global schedule to the entire Profile: rather, it enables those schedules set for all
individual Jobs on to run at their specified intervals. 

All Scheduled Operations set for individual Jobs will be ignored if this mode is not
selected. If none of the Jobs within a Profile are set for Scheduled Operation and this
mode is selected, all active Jobs within the Profile will be assigned a default
synchronization schedule of five minutes. 

/Sx 
Synchronization Timer Argument:  The /Sx option is used to run PeerSync
automatically at regular intervals. This argument sets PeerSync to synchronize the
selected Profile every x minutes. Through this feature PeerSync remains persistent and
will not terminate upon completion.

Examples: /S10 Synchronization will be performed every 10 minutes

/TIME
Daily Timer:   This argument will allow for scheduling of PeerSync for specific times of
the day down to the minute for selected days of the week and selected Jobs within a
Profile.  If you use a /TIMEF argument all selections at the Job level from the Automation
screen will be used. You can also specify Global Daily Timer selections for the entire
Profile from the Options/Commands Screen or by using the following format:

1. Select the time of day (by default all Jobs will be run all days)

/TIME:HH:MM
Where HH is replaced with the value of 00-23 in military time and MM is replaced with 00-59 in minutes

Examples:
Every Day at
12:00 am:
Every Day at
1:00 am: 
Every Day at
8:00 am: 
Every Day at
12:00 pm: 
Every Day at
8:00 pm: 

/TIME:00:00
/TIME:01:00
/TIME:08:00
/TIME:12:00
/TIME:20:00

2. (Optional) - To select the days of week to run append the following:

D:SMTWTFS where the days are substituted with 1 (On) and 0 (Off)

Sunday:
Monday: 
Tuesday: 
Wednesday:
Thursday: 
Friday: 
Saturday: 

D:1000000
D:0100000
D:0010000
D:0001000
D:0000100
D:0000010
D:0000001
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Examples:
M, W & F at
8:00 am:
Sat & Sun at
5:15 pm: 
Mon - Fri at 3:30
am: 

/TIME:08:00D:0101010
/TIME:17:15D:1000001
/TIME:03:30D:0111110

3. (Optional) - To select the Jobs to run append F:f1;f2;f3

Where f1-fn are the Job numbers.

Examples:
Job 1 Every day
at 6:00 am:   
Jobs 1 - 5 Every
day at 8:25 pm:
Jobs 1, 3 & 5
Mon - Fri at 3:30
am: 

/TIME:06:00F:1
/TIME:20:25F:1;2;3;4;5
/TIME:03:30D:0111110F:1;3;5

Note: Will accept multiple command lines.

Example:
Job 1 Every day at 8:00 am, Jobs 1 - 5 Every day at 8:25 pm and Jobs 1, 3 & 5 Mon - Fri at 3:30 am
/TIME:08:00F:1 /TIME:20:25F:1;2;3;4;5 /TIME:03:30D:0111110F:1;3;5

Sample: 
Complete command line to run PeerSync with Test.snc, all Jobs, at 3:00 am Mon -Fri, (M)inimized on the tray.
"C:\Program Files\PeerSync\PeerSync.exe" "C:\Program
Files\PeerSync\test.snc" /TIME:3:00D:0111110 /M 

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/UDD 
Use Device Driver method:   This argument uses of the Windows NT device driver for
real-time detection. When using this argument PeerSync can detect changes made to
remote Source folders but only when the changes are made by the machine where
PeerSync is installed.

/< 
Applications to Ignore:  If using the Device Driver method for Real-Time detection you
can select applications to ignore by appending application names (semicolon delimited)
to the /< argument.

Example: /<Explorer.exe;Word.exe  Will ignore any Real-Time changes made by Explorer.exe and
Word.exe.

Note: When using this option and monitoring a remote Source folder, the Transfer NT security descriptions
(ACLs) is ignored in Real-Time.

/X 
Disable Initial Synchronization During Startup:  The /X command line argument
disables initial synchronization during /A /M /R operations at PeerSync startup. 

/Q0
Save Events Options: On close of a Profile, if there are failed, pending, and/or running
events, a dialog will prompt the user to store the events and process them on restart. The
following options can be configured:

/Q0 Do not prompt the user.
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/Q0+ Always prompt the user.
/Q0? (Default) Ask only if running as an application and off as a service.
/Q0S+ Ask only if running as an application and on as a service.

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Command line arguments can also be identified through hints displayed on the Profiler. 

3. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will
display both a description of the feature as well as its related command line argument (if any).

4. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

5.  Synchronization Arguments

Synchronization Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/GC:x

Set File Comparison Value:  If the /GC argument is used, PeerSync will add x seconds
to the Target File date and time stamp to use during comparison.

/GD:n,z:n,z 

Set Job Comparison Delta:  If the /GD argument is used, PeerSync will add or subtract
z seconds from the Target File date and time stamp during a comparison for Job number
n.

Example: /GD:1,+30:2,-60:

/GF 
Use Alternate Copy File Methods:  The following copy file methods may be invoked:

/GFC Use CopyFile API method
/GFS Use File Stream method
/GFE Use CopyFileEX method
/GFA Transfer Alternate Data Streams - The same functionality can be used at a Job

level by using the SETVAR INCLUDEALTFILESTREAMS  switch in the
Pre/Post paths. 

/GI(S)(D) 
Ignore File Size and/or Date Comparison:  If the /GI or /GIS argument is used,
PeerSync will ignore file size during folder scans (if date matches then skip file). If
the /GID argument is used, PeerSync will ignore file date comparison during folder scan
(if size matches then skip file).f the /GISD argument is used, PeerSync will ignore file
date and size comparison during folder scan (always replace Target file even if they are
identical).

/GT 

http://www.peersoftware.com/support/submit-a-case.html


PeerSync Help149

Copyright © 1993-2021 Peer Software Inc. All Rights Reserved.

Get Remote PC Time:  If the /GT argument is used, PeerSync will attempt to get the
time from the Target PC as well as the local PC and automatically compensate for time
differences.

Note:  /GT is only applicable in an NT/2K Environment

/GX 
Use Delete Path for Revisions:  If the /GX argument is used, PeerSync will use the
deletions path for all PSBAK revision files.

/I 
Ignore Target Space During File Copy:  The /I argument sets PeerSync to ignore
Target space available during file copy.

/J 
Move Files:  If the /J argument is used, PeerSync will move files - deleting them from the
Source after they have been successfully transferred.

/KA:x 
Active Connection Interval:  If the /KA argument is used, PeerSync will attempt to
connect every x minutes to Target machine(s).

/LH:x

Set Deletion Move To Folder Cleanup Interval:  If the /LH argument is used,
PeerSync will check the Move To Folder (the folder where deleted files are move to),
every x minutes to see if files needed to be deleted on the cycle specified by the Delete
unmatched Target Files older than x days option. 

/LI [ R | T | A ]
Target In-Use Replacement:  If the /LI argument is used, PeerSync will perform the
following operation if Target File is unavailable:

R Force rename of open Target File
T Force terminate of open Target File application
A Force terminate of all open Target applications

/LM:xOyCz

Set Failed Connection Timer:  If the /LM argument is used, PeerSync will use the
following variables to determine retry frequency:

x Approximate time, in minutes, for retry of failed connection (time may vary as
much as a few minutes).

y Frequency to retry files
z Maximum Retry Count

Example: /LM5O25C100 Checks failed connections every 5 minutes, retries files every 25
seconds, to a maximum retry count of 100.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/LMD
Disable Failed Connection Timer:  If the /LMD argument is used, PeerSync will not
check for failed connections:

Example:  /LMD Does not check for failed connections.

Note: This item is selectable from the Profiler via the Options/Commands Screen.
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/LR:file

Run application at start of PeerSync:  If the /LR argument is used, PeerSync will
execute an application or shell script specified by file at the initialization of PeerSync.

Example:   /LR:C:\WINNT\notepad.exe

/LW
Enable Last Access Compare:  The /LW argument allows you to use the last access
date/time instead of the modified date/time for comparisons to determine file updates.

/NODELFLDR 
Do not delete folders:  If the /NODELFLDR argument is used, PeerSync will not delete
folders during synchronization.

/O 
Set Target File Overwrite:  The /O argument sets Target File overwrite on all Jobs.

/QB
Use Full Access File Copy:  If the /QB argument is used, PeerSync will only copy files
it can gain full access to during synchronization.

/QFn
Shadow Time Range:  This argument will use an n second time range for file time
stamps during comparison. If the Source and corresponding Target File time stamps fall
in the range then the file time stamps will be seen as equal.

 n = Time in seconds

Note: /QF:1 is equivalent to a value between 1 to 3 seconds depending on the file systems being used. 

/QF[+][++][+++]
Precision Comparison: Use this argument to remove minutes, seconds, or milliseconds
from files during comparison. 
 
/QF+ Removes/ignores the milliseconds from both the source and target file time

stamps during comparison
/QF++ Removes/ignores the milliseconds and seconds from both the source and target

file time stamps during comparison
/QF++
+

Removes/ignores the milliseconds, seconds, and minutes from both the source
and target file time stamps during comparison

/QG
Always use the local machine time for the Last Run Time:  If this argument is used,
PeerSync will always uses the local machine time for the Last Run Time, instead of using
the minimum time of the Source and Target machines involved in the synchronization.

/QH:n
Force Flush File Buffers:  Forces the file data that has been written across the network
to be fully committed to disk before continuing. The Interval n is the number of buffers
worth of data to write before forcing a disk write of the data, if n is not used the default is
100 cycles. 

Note:  This is expected to naturally occur without this argument, but on some systems across slower networks it
is necessary to force the commit of data to correctly gauge process of writing the file.

/QHD
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Direct Disk Write:  Forces the file data that has been written across the network to be
fully committed to disk before continuing. This will occur for each buffer worth of data that
is transferred. 

Note:  You may use this argument or the /GFC option to resolve Windows "Delayed Write Failed..." messages. 

/QI:ext

Ignore Matching/Locked File Extensions:  This argument will ignore an add/update of
a file, if a matching file with the same base name and the specified extension ext exists.

Example:  /QI:dwl

Note:  One instance of this example is if a file called MyFile.dwg is updated it will be excluded from
synchronization while MyFile.dwl exists.

/QJ:str

Ignore Matching/Locked File Postfix Replacement:  This argument will ignore an
add/update of a file, if a matching file with the same base name with the specified postfix
replacement str exists.

Example:  /QJ:~$

Note: One instance of this example is if a file called MyDocument.doc is updated, it will be excluded from
synchronization while ~$Document.doc exists.

/T
Terminate All Instances of PeerSync:  The /T argument terminates all running
instances of PeerSync, including itself. 

/VRBn

Verify User-Name:  If the /V argument is used, PeerSync will verify logged on User-
Name defined in the local user file list, specified by the following options:

R Require user to be in the user file list 
B Bypass the request to add to list dialog
n Maximum number of user allowed

/W:x

Set Queue Directory Change Count:  If the /W argument is used, PeerSync will set
queue directory change count, events to wait for action x.

/WPFIX 
Disable application associated with active file synchronization:  When a file is being
synchronized, this option searches all active windows on the desktop for a caption that
contains the path/filename of the active file. PeerSync then disables the active
application in one of two ways. The command lines "/WPFIX or /WPFIX2" disables the
entire application and" /WPFIX1" disables the save toolbar and file menu save item.
(This option also verifies that the word "WordPerfect" is in the caption before disabling).
Both options will append "(Synchronizing)" to the existing caption and when the file is
synchronized, the caption will be restored. 

/YC:x
Folder Queue Watch Interval:  Change the default timer interval for checking the folder
queue to x seconds (the default is .5 seconds).

Example:  /YC:3

/YD
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Allow Replication During Dynamically Created Jobs:  This argument will allow
dynamically created Jobs (i.e. Job scans triggered by Folder Additions) to use the
replicate option.

/YF:ext1;ext2;extn
Partial Locked File Extensions List:  This argument is used for file types that are
partial locked when open by other applications (i.e. Outlook PST files). If the /YF
argument is used, and Volume Shadow Copy Service (VSS) is enabled PeerSync will
always process files with the specified extensions as though they are open and locked
files. If VSS is not enabled, then PeerSync will pre-scan the files to ensure complete
access before file copy. PST files are included in this list by default and can be changed
via this command line.

Example:  /YF:.pst;.dba;

/YN
Use Network Password Dialog:  If the /YN argument is used, PeerSync will display a
network password dialog if you do not have right to access the Source or Target Folder. 

/YR
Delete Empty Source Folders After Move:  This argument will delete all empty Source
Folders after a synchronization scan when using the Move Files - Delete Source File
after successful copy to Target option.

/YV
Do Not Validate Connections Before Profile is Loaded: This argument will not try to
validate Source and Target Folder connections during the load of a Profile. It will assume
that the connections will be available upon start of each Job. This option is useful if you
are running a Pre Process that will establish a connection and/or create a Source or
Target Folder. This argument should be used when using the /LJP (Always Run Post
Process) argument or when needing to dynamically create the source and or target
paths.  

/Z:ext1;ext2;extn

Ignore Open File Extensions:  If the /Z argument is used, PeerSync will ignore files
with the specified extensions that are currently opened where the full name of the file is
displayed in the caption of another window. This argument may be ignored if Multiple Job
or multiple copy threads are enabled. 

Example:  /Z:.wpd;.txt;

/LJU:x
Exclude Folders that have a Reparse Point: By default PeerSync will exclude folders
that have a Reparse Point object, which are common in Windows Vista. Use this
argument to alter this behaviour: 

/LJU:0 Don't exclude folders that have a Reparse Point object
/LJU:1 Exclude folders that have a Reparse Point object recursively pointing back to

itself (Default)
/LJU:2 Exclude all folders that have a Reparse Point object

/LJP
Always Run Post Process:  If the /LJP argument is used, PeerSync allows for the
ability to process Post commands even if the Job fails. This argument is useful for non
persistent Profiles that need to execute or start other processes regardless whether or
not its Job was able to run. This argument should be used in conjunction with the /YV



PeerSync Help153

Copyright © 1993-2021 Peer Software Inc. All Rights Reserved.

command which allows for the Profile to be loaded before the source and target folder(s)
are validated. 

/LX:R
Listener Alternate Route Path: Adding this option will create an Edit: Listener
Alternate Route Path option when right-clicking on either the Source or Target folder
selection paths. This creates and opens a file called %PROFILENAME%.psl in the
Profiles directory used to configure alternate route(s) for the PSListener. Here is an
example of what the content of the %PROFILENAME%.psl file should look like: 

[LISTENER]

NetAppA=Win2008A

NetAppB=Win2008B

The first column contains the name or IP address of the remote non-Windows server.
The second column lists the name or IP address of the Windows server where the
PSListener is running.

/LZS|A|S|I-|I+|T-|T+|WN 
Compare and Set File Attributes from Windows to NetApp: Arguments to support the

comparing and setting of file attributes from Windows to NetApp.

A Includes fixes to check for the I attribute to see if the setting of attributes was
successful and logging of failed setting of attributes. 

S Suppresses the logging of failed setting of attributes due to the above additions
(i.e. /LZAS will run all the new logic but will not log failures).

I- Force off the I attribute when setting target files.
I+ Will force on the I attribute when setting target files. 
T- Will force off the T attribute when setting target files.
T+ Will force on the T attribute when setting target files.       
WN WN will use A, I- and T- for a potential fix for Windows to NetApp systems.  This

is the recommended workaround for this scenario for now especially for TCP
routing.

For a Windows to NetApp Fix use: /LZS:WN

Possible alternatives are to use: /LZSA or /LZSAS

When routing via TCP and not using the WN  (or I- and T-) switches you may require the

following entry in the PSListener93.CFG file:

[Application Settings]

RevalidateSetFileAttributes=1

/LJFK
Convert Well-Known SIDs: Set this option to convert well-known SIDs (WNS) when

using ACLs over TCP to act similar to Normal (non-TCP) Jobs.

/LJFK Enable this feature.
/LJFK+ Will Report failures to PSError.log
/LJFK+
+

Will Report converted items to PSError.log

/LJFK+
++

Will Report skipped items to PSError.log
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/LJFK+
+++ 

Will Report converted WNS parts to PSError.log

/LJFI Use alternate method.
/LJFIK Uses default and alternate method.

/Q7O
Share Migration support for cDOT 8.3: Add this option to enable Share Migration

support for cDOT 8.3. 

/Q7OM
<

Revert to incrementing message count for the Job for successful share migration
messages. 

/Q7OR
-  

Report Share Errors and Share Totals only

/Q7OR Report Share Errors, Share Totals, Share Actions, Share Permission Errors and
Extended Share Information

/Q7OR
+

Report Share Errors, Share Totals, Share Actions, Share Permission Errors,
Extended Share Information, Get and Set of Shares, Share Permission Matches
and Share Permission Skips

/Q7OR
++

Share Errors, Share Totals, Share Actions, Share Permission Errors, Extended
Share Information, Get and Set Share Information,  Share Permission Matches,
Share Permission Skips and Share Permission Actions

/Q7OV Report source and target system information.
/Q7O- Use previous Share Migration Logic from v9.0.
/Q7OR
- -

Same as /Q7OR- and disables share migration starting information.

/Q7OI- Disable share migration starting information.
/Q7OE Report all activity at the end of share migration, instead of during
/Q7OC
C

PeerSync will use the cDOT 8.2 method which requires user/pass (and optional
Management IP) for source and target cDOT 8.3 systems.

/Q7OC
W

PeerSync will use the cDOT 8.2 method which requires user/pass (and optional
Management IP) for source cDOT 8.3 systems

/Q7OW
C

PeerSync will use the cDOT 8.2 method which requires user/pass (and optional
Management IP) for target cDOT 8.3 systems

/Q7OC
W+

PeerSync will use the cDOT 8.2 method which requires user/pass (and optional
Management IP) for source cDOT 8.3 systems and force on unsupported
scenarios.

/Q7OW
W

PeerSync will use the Windows and/or 7-Mode method for source and target
cDOT 8.3 systems even for the current scenario that seems to fail for Windows
to cDOT 8.3. 

/LZR:A|V+
NFS Replication: Use these options to enable NFS FPolicy real-time detection,
scanning, and the ability to transfer/compare UNIX permissions between NetApp 7-Mode
and cDOT systems.

A Base argument for using rsync for scanning (turned on via the interface)
V+ Turn on debug verbose logging to report why files are excluded

/LZTX
Remove Failed Events If Successfully Re-Processed: Removes Failed Events from
the Failed Event list after they were successfully processed.

/Q7L
cDOT Optimizations: This command line argument provides cDOT detection with the
ability to connect to specific nodes, exclude specific shares, and automatically create and
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exclude the recommended $ admin share to achieve optimal bi-directional
synchronization. 

Example:  

/Q7L:"nodesToConnect=NODE1;NODE3|nodesToRequire=NODE3;"
/Q7L:"adminOverrideShare=PeerSync$|validateAdminOverrideShare=true|
autoCreateAdminOverrideShare=true|sharesToExclude=share1;share2"

Notes:

1.Use "|" for delimiter between items and ";" for delimiter between sub items

2.Quotes are required for strings with "|" in them

3.RegisterForEvents and UnRegisterForEvents are used if /Q7L string is not set

4.RegisterForEventsExtended and UnRegisterForEventsExtended are used if /Q7L string is set

/LZF:
Transfer Folder Information: Transfer additional folder information such as modified,
created, accessed time and attributes. This option can diminish performance. 

A+ Enable comparing of Date accessed time (off by default)
U- Disable reporting of Updates
M- Disable reporting of Messages
M+ Enable reporting of Compare Matches to the Updated tab for debugging/analysis
D- Skip processing after each Directory scan
F- Skip processing after each File Copy (the parent folder is checked)
I- Skip processing after each Set Folder Info call (used for Enhanced Bi-Sync) and

is done after real-time / event folder adds (on by default)
E- Skip processing after Folder Renames (on by default)
G- Skip processing parent folder after File/Folder Deletes (on by default)
I+ Force processing after each Set Folder Info call (used for Enhanced Bi-Sync)
P+ Enable processing after each Security Permission check (off by default)
C+ Enable processing after certain Create Folder calls 
R- Not include the Root watch folder

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Command line arguments can also be identified through hints displayed on the Profiler. 

3. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will
display both a description of the feature as well as its related command line argument (if any).

4. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

6.  Real-Time Arguments

Real-Time Arguments

http://www.peersoftware.com/support/submit-a-case.html
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The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/GA:x

Set Empty File Delay:  If the /GA argument is used, PeerSync will delay x milliseconds
before synchronizing empty (zero size) files that are detected in Real-Time.

/GB:x
Set Shadow Detection:  If the /GB argument is used, PeerSync will delay x milliseconds
to synchronize subsequent updates of the same file during Real-Time.

/LA 
Real-time Attribute Change:  If the /LA argument is used, PeerSync will monitor
attribute changes to files in Real-Time and use these changes as triggers for file
synchronization.

/LF
Use Update Sensitivity:  If the /LF argument is used, PeerSync will use the update
section of PSChangeNotify to detect file changes during real-time. 

Note: This feature is generally too sensitive, and will create multiple detections.

/LG
Folder Change Detection:  If the /LG argument is used, PeerSync will detect folder
changes, and in Enhanced Real-Time will force  the security description to be validated.
Any change to the folder will trigger a scan of the folder including its sub folders, so that
more CPU will be required. This option is not recommended for non-enhanced Real-
Time.

/LG1
Folder ACL Detection: If the /LG1 argument is used PeerSync will detect folder
changes, and in Enhanced Real-Time will force only  the ACLs and attributes to be
validated.  Any change to the folder (i.e. file/folder adds or deletes) will force a
comparison of security descriptors and attributes.  This argument is more efficient then
the /LG option above because it will not perform a scan of the folder.  Use this argument
if you wish to detect and replicate ACLs in real-time for empty folders or folders that
contain files for which inheritances has been disabled. Without the /LG1 argument
PeerSync would need to perform a scan in order to replicate the permissions for such
folders.  

/LL
Disable Real-time Security Change:  If the /LL argument is used, PeerSync will not
trigger updates in Real-Time when a file's security has changed. 

/LPC:x

Set Maximum Number of Events to Process within each Enhanced Real-Time
Queue Check:  If the /LPC argument is used, PeerSync will set the maximum number of
events to process within each Enhanced Real-Time queue check to x events. The default
is 25 events and the minimum is 5 events.

/LPC:x+

Set Maximum Number of Events to Process within each Enhanced Real-Time
Queue Check:  Adding the + argument PeerSync will process the events currently in the
list at the time of queue checking set by LPQ. 
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Example: To queue events for 30 minutes (1800 seconds) and process them on that interval use the following
arguments: /LPQS1800 /LPC+

/LPD:x

Set Delay between Enhanced Real-Time Deletions:  If the /LPD argument is used,
PeerSync will delay the deletion of files x milliseconds during Enhanced Real-Time. 

/LPE:x

Set Delay between Enhanced Real-Time Event Processing:  If the /LPE argument is
used, PeerSync will delay the processing of each event x milliseconds. 

/LPM:x

Set Enhanced Real-Time Event Upper Limit:  If the /LPM argument is used,
PeerSync will set the maximum number of items x to allow in the Enhanced Real-Time
event queue before reverting to non-enhanced Real-Time. If this value is set to 0 then the
option is disabled (the default is 20000 events). If and when the Upper Limit is reached
PeerSync will clear all Enhanced Real-Time events that have not been processed and
scan the directories for changes. 

/LPW:x:y

Set Enhanced Real-Time Event Queue Delay:  If the /LPW argument is used,
PeerSync will set the number of items x in the enhanced real-time event queue to wait for
before processing, as well as, the maximum time to wait for to y milliseconds.

/LPQ:x

Set Delay between Enhanced Real-Time Queue Checking:  If the /LPQ argument is
used, PeerSyncwill delay x milliseconds before checking the Enhanced Real-Time queue
for new events.

/LPX:x

Set Process Delay for Enhanced Real-time Changes:  The /LPX argument allows
you to set the delay time for Enhanced Real-Time changes to be processed to x

milliseconds. This value will be applied directly for adds and updates and will be
multiplied by 3 for deletions. The default is 1000 milliseconds for adds/updates and 3000
milliseconds for deletions 

/YK:n
Set Real-time Copy Thread Pool:  Used to set the percentage of copy threads to
reserve for Real-Time events, where n can be set between the values of 1 and 99. The
default value is 10 percent.

/QR
Real-Time Global Exclusions: Use this argument when you want to exclude real-time
events earlier in the process and throw the events away. This argument will not log/report
the exclusions. Improves performance when a high amount of events need to be
excluded.

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Command line arguments can also be identified through hints displayed on the Profiler. 

3. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will
display both a description of the feature as well as its related command line argument (if any).
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4. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

7.  Managed Files Arguments

Managed Files Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/QD
Always Use Partial Locked File Extensions List for VSS:  If the /QD argument is
used, any file that is in the Partial Locked File Extension List (default: .pst files) will
always be synchronized using VSS without scanning the file for partial locks. 

Note: Please refer to the /YF argument for more detail on the Partial Locked File Extensions List. 

/GY:x 
VSS Interval:  The /GY argument is used to set the interval to try open and locked files
via E The Default is every 2 hours and the minimum value is every 30 minutes.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/YY:n
Set VSS Try Count: This argument is used to set the amount of times n to try and lock
down a drive for full access via VSS during each cycle. The default is 5 times.

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Command line arguments can also be identified through hints displayed on the Profiler. 

3. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will
display both a description of the feature as well as its related command line argument (if any).

4. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

8.  Bi-directional Arguments

Bi-Directional Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/GV 
Always Create Superset during Bi-directional Synchronization:  If the /GV argument
is used, PeerSync will not use the TLR value, and therefore always create a superset of
data during a bi-directional synchronization.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/GW 

http://www.peersoftware.com/support/submit-a-case.html
http://www.peersoftware.com/support/submit-a-case.html
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Enable Temp Files:  If the /GW argument is used, PeerSync will enable the use of
temporary files during file/folder renames and deletes. This is useful during 'Real-time Bi-
Directional Synchronization' in order to prevent oscillation. 

/LB 
Bi-directional Folder Deletion:  If the /LB argument is used, PeerSync will delete
folders that have been deleted from Target or  Source during bi-directional scans.

/LC 
Use Last Access File Time:  If the /LC argument is used, PeerSync will always use last
access file time for bi-directional synchronization.

/LD [ M | A | T | R ]
Set Trigger Folder File Name:  If the /LD argument is used, PeerSync will set
enhanced bi-directional synchronization trigger folder filename extension to:

M Use machine name as extension
A Use LastAccessTime for TLR comparison
T Use "~FLDR" extension in place of TLR
R Reset/Delete all trigger folder-files

/LE
Use Enhanced bi-directional synchronization mode:  The /LE argument is equivalent
to /LDMAT mode. This will alter the way the bi-directional synchronization option
functions by using enhanced features to track all file and folder adds, updates, deletions,
renames and moves between scan cycles. In this mode PeerSync will use a hidden
system trigger file within each sub-folder to store information about the last scan cycle for
that sub-folder. Using this trigger file PeerSync can determine if a Folder was added,
deleted, renamed or moved since the last scan.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/YO- 
Retain Last Access Time for Two Machine bi-directional synchronization: 
The /YO- argument will store the original Last Access time of the Source File before
synchronization and then it will set the Source and Target files' Last Access Times with
the stored time after a file add or update. This will allow bi-directional scans between two
machines to properly track file adds then subsequent file deletes within the next scan
cycle.

Notes:

1. When using standard or enhanced bi-directional synchronization we recommend adding /YO- as well
as /QYD:0 to your list of command line arguments to ensure deleted files from one side are not re-
added by the other side.   

2. The /YO- argument should NOT be used if there are more than two machines involved in a bi-
directional synchronization due to the need of the Last Access Time to be used by the third, fourth
etc. machine during comparison with either of the other two machines.

/QYD:n
Set Safety Value for Last Run Time: By default PeerSync uses /QYD:5 during
standard or enhanced bi-directional synchronization. With this option enabled deletion
events are programmatically delayed by approximately 10 seconds to account for any
time differences between machines. This can be problematic when performing standard
or enhanced bi-directional synchronization where a deleted file from one side can be re-
added by the other. In this scenario we recommend using /QYD:0 which represents a
safety value of 0 seconds for deletions. 
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n = 0 safety value = 0 seconds
n = 1 safety value = approximately 2 seconds
n = 2 safety value = approximately 4 seconds
...
n = 5 safety value = approximately 10 seconds

Note: When using standard or enhanced bi-directional synchronization we recommend adding /QYD:0 as
well as /YO- to your list of command line arguments to ensure deleted files from one side are not re-added
by the other side.   

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Command line arguments can also be identified through hints displayed on the Profiler. 

3. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will
display both a description of the feature as well as its related command line argument (if any).

4. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

Other Components

1.  PeerSync Status Display

Status Display Screen

This screen is used to view Current Profile Activity within the PeerSync application. The
Status Display window can only be viewed when PeerSync is running as an Application
and not as a Service. Enable the "Display status in PeerSync" option available in the
Options/Commands > Display Options... dialog to have the Status Display show
automatically at the start/launch of PeerSync or right-click on the Tray Icon and select
"Show Status Display". 

Profile Displays the name of the Profile actively being processed.
This label may not match the name of the Profile currently
being configured through Profiler.

Job This indicator will dynamically display the name of whichever
Job is presently being processed for the Active Profile.

Mode Displays the Operation Mode (Real-time Mode, Scheduled
Operation, etc.) applied to synchronization of the Active
Profile. 

Source Displays a file path for the Source Folder presently being
synchronized.

Target Displays a file path for the Target Folder presently being
synchronized from the Source indicated above.   

Folders This indicator provides a count of all unsynchronized folders
contained within the Source, and will decrease as each folder

http://www.peersoftware.com/support/submit-a-case.html
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is synchronized. An additional "thermometer" indicator will
also track the progress of folder synchronization.

Files This indicator displays the total number of files contained
within the Source while also providing a count of
synchronized files. In addition, a "thermometer" indicator will
show file synchronization progress by increasing according to
the size of the current folder, with 100% representing the
cumulative size of files contained within the Source Job set.

File Indicates the name of the file currently being synchronized.

Large File or
Compression Status

This caption will be displayed to the right of the file name that
is currently synchronized for large files and during
compression. The caption will show the size of the file that
has been copied to the Target and/or compression status.

Skip File This button will appear once the active Profile has been
launched. This feature allows you to skip synchronization of
the file currently displayed in the indicator described below.
Skip Files enables you to avoid delays caused by large files
on slow network or dial-up connections.

Size Indicates the size (in bytes) of the file currently being
synchronized. A related "thermometer" indicator tracks the
progress of synchronization for that file.

Checked This indicator displays the total number of files contained in
the selected Source Folders. 

Excluded Indicates the number of files that were excluded from
synchronization (See Exceptions). 

Messages Indicates the number of error messages generated during
Profile processing. 

Updated Indicates the number of Target Files that were updated during
synchronization of Profile Jobs. 

Added Indicates the number of new files added to Target Folders
during synchronization of Profile Jobs. 

Deleted Indicates the number of files deleted (or moved) during
synchronization of Profile Jobs. 

Target Space Indicates the Target Folder space remaining during
synchronization of Profile Jobs. 

Elapsed Time Indicates the amount of time that has elapsed during the
current Profile activity.

Hide Will hide this display, which can be re-accessed via the Tray
Icon Men.

Quit Allows you to close/exit the current session of PeerSync.

Other Screen Features
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Processed Lists The Updated, Added, Deletions and Excluded screens will
display statistical information in the above format. Each
screen will have statistical information (File Name, Size,
Modified Date/Time, Path, Duration, etc.) about the changes
that have occurred during the current PeerSync session.

Item Count Display of the amount of changes that have occurred for the
current screen.

Maximum List Size Allows you to select the maximum amount of changes that
you wish to store for the current screen. It is recommended to
keep this value low because each entry requires memory to
be used by PeerSync.

Status Display Popup Menu

Activated by right clicking on the PeerSync Status Display. The Status Display window
can only be viewed when PeerSync is running as an Application and not as a Service.
Enable the "Display status in PeerSync" option available in the Options/Commands >
Display Options... dialog to have the Status Display show automatically at the start/launch
of PeerSync or right-click on the Tray Icon and select "Show Status Display". 

View Log File  Allows you to access, launch and view Log files in the default
text editor for the current Profile.

View Admin Folder Allows you to access, launch and view Admin log file Folders
in Explorer for the current Profile.

Open Source Folder Allows you to access, launch and view Source Folders in
Explorer for the current Profile.

View Target Folder Allows you to access, launch and view Target Folders in
Explorer for the current Profile.

Print Allows you to print the current screen information.

Save As Allows you to save the current screen information to file.

Clear List Allows you to clear/reset the current screen information.

Re-Load Profile Allows you to re-load the current Profile if any changes have
occurred.

About PeerSync Will display an about screen, that contains information about
the current PeerSync you are running.

Quit Allows you to close/exit the current session of PeerSync.

2.  PeerSync Remote Control

PeerSync Remote Control Screen Features

This feature allows you to connect to and monitor any PeerSync currently running on
your LAN. Including PeerSync running as an application or a service on the local machine
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and/or any instances of PeerSync running on any machine that is accessible from the
local machine. 

Profile Selection The field located to the left of the Add Button. This field is
used to add a Profile to the Profile Selection List. The format
for a Profile selection is: MACHINENAME:PROFILENAME
(i.e. DELLSERVER:Profile.snc).

Profile Selection List The list located below the Profile Selection, which contains
Profile Selections that can be connected to and monitored by
selecting the item and using the Connect button.

Add This button will add the current Profile Selection to the Profile
Selection List.

Connect This button will connect to the current Profile Selection and
display its activity on the screen.

Disconnect This button will disconnect the current Profile Selection and
stop the display of activity.

Refresh This button will refresh the current Profile Selection activity.

Pause/Resume This button will pause/resume the current Profile that is
selected.

Query This button will search for and add all Profiles that can be
found to the Profile Selection List.

Clear List This button will clear out all entries from the Profile Selection
List.

Remote Connection
Information

Displays the computer, user and last response for the current
connection. 

Close This button will close this dialog.

Note: The features described on this page require the Enhanced Package. 

3.  Quick-Sync

This feature is a quick and easy way to synchronize folder(s) on the fly to backup
location(s) with the option to modify your Job settings at a later time. 

Simply right click on any folder you wish to sync and select "Quick-Sync Folder...".  This
will launch the Wizard, which will ask you to select a Target Folder to sync to...and your
ready to run the Quick-Sync. You also have the options to edit and/or add the current sync
Job to your Quick-Sync Profile or any other selected Profile. Then the next time you select
a folder if it matches any Source or Target selection in the Quick-Sync Profile the Jobs will
be listed to pick from or you have the option to add a new Job. 

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Choose external applications/scripts to be run
before and after the processing of a given Job    
105

CIFS - Permissions     50

CIFS - Scan Method     50

CIFS/NFS Security Style     79

Clear List     160

Clear Log File     97

collect real-time events     69

Command Line Argument Selection     113

Command Line Argument Selection from the
Interface     114, 116

Command Line Arguments     114, 116, 136

Compare and Set File Attributes from Windows to
NetApp     148

Compare Time Change     91

Compression - TCP Target     57

Compression Status     160

Computer Name Variable     61

Configuration Command Line Arguments:     137

Alternate Configuration File     137

Load Alternate Configuration File     137

Set SNC File to Load     137

Set Source Path     137

SNC File     137

Use Arguments from Profile     137

Configuration Entries     8

Configure - NFS Settings     76
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Configure Normal Source Folder     53

Configure Normal Target Folder     59

Configure TCP Source Folder     53

Configure TCP Target Folder     59

Connect As - Network Logon Setting     45

Connect to and monitor any PeerSync currently
running on your LAN     162

Connection Manager    

Only include connections that are set for
real-time monitoring     44

Scan real-time Jobs on reconnect if "Scan Job
once at start" is enabled     44

Connection Manger for Failed Connections - Source
Folder:     44

Disabled     44

Enabled for Source and Target Connections    
44

Enabled for Source Connections Only     44

Enabled for Target Connections Only     44

Convert to GMT for comparison purposes     91

Copy File Method - Global:     50

Admin Backup     50

Advanced Backup     50

Advanced Backup with Permissions     50

CIFS - CopyFile API - /GFC Argument     50

CIFS - CopyFileEx API - /GFE Argument     50

CIFS - Default     50

CIFS - File Stream Method - /GFS Argument    
50

NFS - Unix/Linux cp command     50

NFS - Unix/Linux rsync command     50

Copy Jobs     15

Copy Thread Utilization     138

Copy Threads     110, 138

Copyright     3

CRC32     91

Create a report for every event     100

Create a report on an interval     100

Create a report once a day     100

Create a report once a week     100

Create administrative Email messages     101

Create administrative report files     100

Create and Append Summaries into One Report    
140

Create Email messages     101

Create Normal Souce Auto Job Name     53

Create Normal Target Auto Job Name     59

Create Pre Sync Report     27

Create Shortcut on Desktop     121

Create SNC extension association for Profiler     121

Create Source Folder     36

Create Target Folder     54

Create Target TCP Auto Job Name     59

Create TCP Source Auto Job Name     53

Current Arguments     113

Current Arguments Button     113

Current Attributes     96

Current Command Line Argument Selection     108,
113

Customize Selection Tree     31

Customized View     31

- D -
Daily Timer     145

Daily Timer Options     65

Date variables for Folder Paths     61

Date/Time Variable     61

Dates Exceptions     96

Day variables for Folder Paths     61

Days of the week scheduling     65

Default inclusion     92

Default Read/Write Buffer Size     82

Delay between Enhanced Real-Time Deletions    
155

Delay between Enhanced Real-Time Event
Processing     155

Delay between Enhanced Real-Time Queue
Checking     155

Delay Scan at Start     145

Delayed Write Failed     148

Delete 7-Mode FPolicy     52

Delete Empty Source Folders After Move     148

Delete fPolicy on Close - NetApp Settings     45

Delete Jobs     15

Delete log file after successful send     102

Delete Unmatched Target Files     73, 74

Delete unmatched target files older than x days    
74

Deleted file storage  manipulation and organization  

 
 61

Deleted Indicator     160

Deletion Folder     74

Deletion Options     72, 73, 74

Deletion Options Button     73, 74

Destination IP     99

Detection Method Options:     41
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Detection Method Options:     41

Allow for remote real-time configuration     41

Exclude Users     41

Detection Method:     41

Default     41

EMC CEE Celerra/VNX     41

EMC CEE Isilon     41

NetApp FPolicy 7-Mode     41

NetApp FPolicy cDOT     41

Device Driver method     145

Disable all Startup Options     121

Disable Alternate Share Lookup - cDOT Options    
46, 50

Disable application associated with sync     148

Disable cDOT FPolicy     52

Disable Failed Connection Timer     148

Disable Initial Synchronization During Startup    
145

Disable Install Reboot     8

Disable Jobs that are Not Configured from this
Profiler     119

Disable Real-time Security Change     155

Disabled - Connection Manager     44

Display status in PeerSync     140

Display status in PeerSync upon completion     140

Dissimilar time zone synchronization     91

Distribution     3

Do Not Validate Connections Before Profile is
Loaded     148

Drag and Drop Source Folder Selection     36

Drag and Drop Target Folder Selection     54

Drive Mapping     64

During comparison subtract/add x minute(s) from
target     91

Dynamic  Network  Drive Mapping and Un-mapping

 
   64

Dynamic archives     61

Dynamic synchronization based on date     61

Dynamic synchronization based on logged on user
or machine name     61

Dynamic synchronization based on personal folders
or other variables read in from the registry     61

- E -
Easy way to synchronize folders on the fly     163

Edit Job Groups Dialog     30

Edit Menu     18

Edit Normal Source Variable File     53

Edit Normal Target Variable File     59

Elapsed Time Indicator     160

Email Report Cycle Options     103

Email reporting     101

E-mail Reporting     33

Email Reporting Features     101

Email Reporting Overview     101

Email Reporting Screen:     101, 102

Attach log file to messages     102

Create administrative Email messages     101

Delete log file after successful send     102

Report file name - Email Reporting     102

Use error information only     102

Use standard report file content     102

Use summary information only     102

Email Threads     138

Embedded Open File Manager     71

EMC Celerra/Isilon Settings     47

EMC Celerra/VNX Settings     48, 49

Enable CIFS Screening     43

Enable file recovery     90

Enable intelligent network load balancing     82

Enable intelligent network load balancing (when
applicable)     82

Enable Last Access Compare     148

Enable NFS Extended Reporting and Display -
Permissions     50

Enable NFSv3 Screening     43

Enable NFSv4 Screening     43

Enable PSObserver Broadcasts     140

Enable SNMP Error Reporting     140

Enable Summary Statistics Collection     140

Enable Temp Files     158

Enabled for Source and Target Connections -
Connection Manager     44

Enabled for Source Connections Only - Connection
Manager     44

Enabled for Target Connections Only - Connection
Manager     44

Encryption - TCP Target     57

Enhanced real-time     65

Enhanced Real-Time Event Queue Delay     155

Enhanced Real-Time Event Upper Limit     155

Enhanced Scan Processing     66

Error Reporting     140

Evaluating a new version of PeerSync     12

Event Options     72

Exception Screen Features     92

Exceptions     33, 92
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Exceptions Screen:    

Exceptions Screen Overview     92

Exclude Files by Character/String/Extension    
93

Exclude Files from Sync by Size     96

Exclude Files in Sync by Attribute     96

Excluding Folders from Sync     95

Include File Types (using wild cards)     92

Include Files in Sync by Attribute     96

Include Files in Sync by Date     96

Exclude all open files until closed     79

Exclude Extensions - NetApp fPolicy     43

Exclude Extensions - NetApp Settings     45

Exclude File Sizes     96

Exclude Files     93

Exclude Files Button     93

Exclude Folders     95

Exclude Folders Button     95

Exclude Folders drop down list     95

Exclude Folders that have a Reparse Point     148

Exclude IP Address - NetApp fPolicy     43

Exclude IP Address - NetApp Settings     45

Exclude open files     79

Exclude open files (allow read access to source file
during transfer)     79

Exclude open files (deny all access to source file
during transfer)     79

Exclude root folders     95

Exclude specific folders only     95

Exclude Users - NetApp fPolicy     43

Exclude Volumes - NetApp Settings     45

Excluded Indicator     160

Exclusion drop down list     93

Exclusive Remedy     3

Executable Path (PeerLock)     123

Executable Path (PeerSync)     121

Explore Source Folder     36

Explore Target Folder     54

- F -
Failed connection     108

Failed Registration     10

FastSync Settings     118

Features     90

File Date Reporting Feature     97

File Dates     96

File Deletion Options     73, 74

File Exclusions     84

File Folder Path Variables     61

File Indicator     160

File Menu     18

File Options     33, 71

File Options Features     71

File Options Screen:     71, 73, 74

Add - synchronize new files to target     71

Avoiding Permanent Deletion     73, 74

Delete Unmatched Target Files     73, 74

Delete Unmatched: Options     73, 74

Deletion Warning Message     73, 74

Mode Selection     71

Replicate - Delete unmatched files/folders     71

Update - synchronize existing files in target    
71

Use Windows Recycle Bin     73, 74

File Path Variables     61

File Path Variables:  Folder Selection     61

File Read/Write Buffer Size     82

File Recovery     90

File Size Reporting Feature     97

File Sizes     96

File Time Change Options     90

File Time Reporting Feature     97

File Versions     86

File/Folder Permission Options:     78

Global Settings     78

NTFS Options     78

Transfer File and Folder Permissions     78

Files Indicator     160

Folder ACL Detection     155

Folder Change Detection     155

Folder Creation Reporting Feature     97

Folder Names Reporting Feature     97

Folder Queue Watch Interval     148

Folder Restoration feature in real-time     65

Folder Selection     33

Folder Selection Features     36

Folder Selection Screen:     36

File Path Variables     61

Folder Selection Screen Overview     36

Source Folder Selection     36

Target Folder Selection     54

Folders Indicator     160

For each individual error message as it occurs    
101

for each message/error as it occurs     104



PeerSync Help171

Copyright © 1993-2021 Peer Software Inc. All Rights Reserved.

Force  Flush File Buffers     148

Force Source Folder Root as Target TCP Folder
Root     59

fPolicy Name - NetApp Settings     45

FPolicy Utility Features:     52

Delete 7-Mode FPolicy     52

Disable cDOT FPolicy     52

- G -
General     3

Get Info - cDOT Options     46, 50

Get Info - System Information for Source Host     45

Get Remote PC Time     148

Global ACL Options     111

Global Advanced File Xfer Options     106, 107

Global bi-directional Options     108, 112

Global Display Options - Profiler Options     114

Global Managed Files Options     108

Global Migrate Shares Options     106, 107

Global Options     119

Global Recovery/Offline Options     108

Global Settings - Permission Options     78

Global Settings (PeerLock):     119

Disable Jobs that are Not Configured from this
Profiler     119

Global Options     119

Link this Profiler to PeerLock     119

Save Changes in PeerLock     119

Show PeerLock     119

Global Settings (PeerSync):     108, 110, 111, 112,
113, 116

Global VSS Options     108

Greater Than File Size Exclusion     96

- H -
H+ (Skip setting of main form visible)     140

Help Button     15

Help Menu     23

Hide     160

Hide Splash Screen     140

Host Name     56

Host Server Name - NetApp Settings     45

Hour variables for Folder Paths     61

- I -
Ignore File Size and/or Date Comparison     148

Ignore Matching/Locked File Extensions     148

Ignore Matching/Locked File Postfix Replacement    
148

Ignore Open File Extensions     148

Ignore Target Space During File Copy     148

Improve Load Balancing     82

Include all open files     79

Include attribute change as synchronization criteria

 
   89

Include Files     92

Include Files Button     92

Include open files     79

Include open files (allow read & write access to
source file during transfer)     79

Include open files (allow read access to source file
during transfer)     79

Include open files (if possible)     79

Include partially open files     79

Include Shares - cDOT Options     46, 50

Include Sub foldersFolder Selection Screen:    

Include Source Sub-Folders     36

Include this Job in PeerLock     119

Include Volumes - NetApp Settings     45

Inclusion drop down list     92

Information Required to Register software     10

initiate scan on trigger file change     70

Initiate Synchronization on Source or Target
File/Folder Change     65

Install Options     8

Install Service (PeerLock)     123

Install Service (PeerSync)     121

INSTALL.LOG     8

Installation (Silent Install)     8

Installation Configuration Options     8

Installing PeerSync     8

Intelligent Network Load Balancing     82

Intermediate View     31

Interval     145

Intervals Button     108

IP Address - NFS Settings     76

Item Count     160
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- J -
job data import     63

Job Indicator     160

Job Menu     22

Job Scan Method - Global:     50

CIFS - Default     50

NFS - Unix/Linux rsync command     50

Job Settings (PeerSync):     33, 36, 65, 69, 70, 71,
79, 81, 82, 84, 86, 88, 90, 92, 97, 99, 101, 105

Job Settings PeerLock:     119

Append Default File/Folder Exclusions from
PeerLock     119

Include this Job in PeerLock     119

Job Threads     110, 138

Jobs     13, 162

- K -
Keep backup files of overwritten Target Files     86

Keep files in Alternate Folder     86

Keep files in Deletion Folder     86

Keep files in Target Folder     86

Keep multiple versions of files     86

Keyboard Activity     145

- L -
Large File or Compression Status     160

Last Run On     61

Last Run On - Reset     27

Last Run On Feature     27

Last Save     61

Last Scan     61

Launch (PeerLock)     132, 133

Launch (PeerSync)     125, 127

Launch Current Profile     15

Left side Panel - Selection Tree     31

Less Than File Size Exclusion     96

License     3

License File     8

Limit CPU usage during file transfers     138

Limit number of processors to use     138

Limit system resources during file transfers     138

Limitations of Liability     3

Limited Warranty     3

Link this Profiler to PeerLock     119

List of Exclude Files (using sub strings)     27, 93

List of Exclude Folders     95

List of Include File Types (using wild cards)     92

List of Job Selections - Daily Timer     65

Load Alternate Configuration File     137

Load Balancing     82

Log File - Clear     27

Log File - View     27

Log file storage/manipulation/organization     61

Log Files:  Administrative     99

Log Messages by Filter     140

Log Messages by Profile     140

Log Messages Only to a Log File by Filter     140

Log Messages Only to a Log File by Filter and/or by
Profile     140

Log Messages Only to a Log File by Profile     140

Log Service Events to the Event Viewer     140

loopback     36, 54

- M -
Managed Files     33, 81

Managed Files Arguments:     158

Always Use Partial Locked File Extensions List
For VSS     158

Set VSS Base Timeout     158

Set VSS Try Count     158

VSS Interval     158

Management IP - cDOT Options     46, 50

Match Shares: Add, Update and Delete     106

Maximize Speed     82

maximum duration of scans     70

Maximum List Size     160

Maximum Log File Size     98

Maximum Number of Events to Process     155

Menu (PeerSync):    

Edit     18

File     18

Help     23

Job     22

Options     20

PeerSync Tray Icon PopUp Menu     26

Run     21

View     19

View Popup Menu     26

Messages Indicator     160

Messages Reporting Feature     97
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Migrate Shares     106

Minute variables for Folder Paths     61

Miscellaneous     33, 88

Mode Indicator     160

Mode Selection     71

Modify NFS Default Options:     77

NFS mount Options     77

NFS rsync Options     77

Monitor ACL changes during real-time     111

Monitor PeerSync activity across the LAN     162

Monitor Remote Instances of PeerSync     162

Month variables for Folder Paths     61

Mount Folders - NFS Settings     76

Move Files     89, 148

Move Job Down     15

Move Job Up     15

MS Windows Explorer Add On - Quick-Sync     163

MSMQ messaging     140

Multiple Copy Threads     110

Multiple Job Threads     110

- N -
Naming and Renaming Jobs     27

NetApp FPolicy - Source Folder NetApp Settings    
45

NetApp FPolicy 7Mode     41

NetApp FPolicy Additional Settings:     45

Exclude Extensions     45

Exclude IP Address     45

Exclude Volumes     45

Include Volumes     45

NetApp FPolicy cDOT     41

NetApp FPolicy cDOT Additional Settings:     46, 50

Include Shares     46, 50

Management IP     46, 50

Primary Server     46, 50

NetApp FPolicy cDOT SVM Logon Settings:     46,
50

Password     46, 50

Username     46, 50

NetApp FPolicy Screening Options:     41

Enable CIFS Screening     41

Enable NFSv3 Screening     41

Enable NFSv4 Screening     41

NetApp Settings :    

Delete fPolicy on Close     45

fPolicy Name     45

Host Server Name     45

Root Path Prefix     45

Use Asynchronous Mode     45

Use cDOT Detection     45

NetApp Settings:     45

Network Constant - TCP Target     57

Network Drive Mapping     64

Network License     3

Network Load Balancing     82

Network Logon Settings:     45

Connect As     45

Password     45

New Profile     15

Next Button     15

NFS - Permissions     50

NFS - Scan Method     50

NFS mount Options     77

NFS Replication     148

NFS rsync Options     77

NFS Settings     33

NFS Settings Screen:     76

Configure     76

IP Address     76

Mount Folders     76

Password     76

Unmount Folders     76

User Name     76

No not delete folders     148

Non Persistent Processes     27

Normal     41

Normal Source     36

Normal Source Mode Selection     41

Normal Source PopUp     53

Normal Target     54

Normal Target Mode Selection     56

Normal Target PopUp     59

NTFS Options     78

Number of backup files to keep     86

- O -
Only Hide the about screen     140

Only use Advanced Settings     100, 103

Open File Manger Options     71

Open File Options     71

Open Files     33, 79, 114, 116

Open Profile     15

Open Source Folder     36, 160
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Open Target Folder     54

Open/Locked Files     79

Optimize Performance     138

Optimize speed     82

Options Menu     20

Options/Commands     33, 114, 116, 160

Options/Commands Features     114, 116

Options/Commands Overview     114, 116

Options/Commands Screen:     113, 114, 116

Current Arguments     113

Current Arguments Button     113

Overview     114, 116

Set Access Password     114, 116

Show tray icon     114, 116

Other Global Options/Command     108

Overview     13, 162

Overwrite Existing Log File     97

Overwrite existing Pre-Sync report file     113

- P -
Parameter Selection from Profiler     113

Partial Locked File Extensions List     148

Password - Network Logon Setting     45

Password - NFS Settings     76

Password - Registration     10

Password - TCP Target     57

Password for Tray Icon     114, 116

Passwords - cDOT Options     46, 50

Path (PeerLock)     123

Path (PeerSync)     121

Path to Host     56

Path to Host - TCP Target     57

pause scan during specific times     69

Pause Service (PeerLock)     132, 133

Pause Service (PeerSync)     125, 127

PeerLock Selection Tree Category     31

PeerLock Service:     132, 133

Launch PeerLock     132, 133

Pause Service     132, 133

Resume Service     132, 133

Run as a service     132, 133

Start Service/Application     132, 133

Stop Service/Application     132, 133

PeerSync Command Line Arguments     136

PeerSync Global Settings     33

PeerSync Installation     8

PeerSync Remote Control     162

PeerSync Selection Tree Category     31

PeerSync Service:     125, 127

In Sync     127

Launch PeerSync     125, 127

Pause Service     125, 127

Resume Service     125, 127

Run as a service     125, 127

Start Service/Application     125, 127

Stop Service/Application     125, 127

Trending     127

PeerSync Status Display     160

PeerSync Status Display Popup Menu     160

PeerSync Temp Folder     8

peersync_architecture_version.exe     8

PeerSync95.lic file     8

Perform binary comparison on all files (using
CRC32)     91

Performance     33, 82

Performance - Threads     110

Performance Command Line Options:     138

Affinity     138

Application Priority     138

Copy Thread Utilization     138

Copy Threads     138

Email Threads     138

Job Threads     138

Limit CPU usage during file transfers     138

Limit number of processors to use     138

Limit system resources during file transfers    
138

Optimize Performance     138

Priority     138

Processor Affinity     138

Set Application Priority     138

Set Copy Threads     138

Set Email Threads     138

Set File Read/Write Buffer Delay     138

Set Multitasking Delay     138

Set Processor Affinity     138

Set Real-time Copy Thread Pool     138

Set Shared Process Delay     138

Set the percentage of copy threads to reserve
for real-time events     138

Shared Process Delay     138

Thread Utilization     138

Threads     138

Performance Features     82

Performance Options All Jobs     114, 116
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Performance Package     110, 114, 116

Performance Priority Selection     110

Performance Screen:     82

Enable intelligent network load balancing (when
applicable)     82

File Read/Write Buffer Size     82

Set maximum number of copy threads to x     82

Throttle bandwidth - Use x percent of available
bandwidth     82

Permissions     33

Permissions (Security style) - Global:     50

CIFS - Default (NTFS)     50

Enable NFS Extended Reporting and Display    
50

NFS - Unix/Linux down and chmod commands
(UNIX)     50

Pop Up Menu: Profile Job List     27, 31

Pop Up Menu: Selection Tree     31

Port - Email Reporting     102

Port - TCP Target     57

Port Configuration     84

Post Installation Configuration Options     8

Post process application     105

Pre Installation Configuration Options     8

Pre process application     105

Pre/Post Features     105

Pre/Post Overview     105

Pre/Post Process     33, 105

Pre/Post Process Overview     105

Pre/Post Process Screen:     105

Select Application/Script to Run After     105

Select Application/Script to Run Before     105

Use maximum wait time of x seconds     105

Wait for application to end before continuing    
105

Preserve Paths     73, 74

Pre-Sync Report Options     113

pricing information     10

Primary Server - cDOT Options     46, 50

Print     160

Priority     138

Priority Selection     110

Process Delay for Enhanced Real-time Changes    
155

Process Migrate Shares after each scan     107

Process Migrate Shares every x minute(s)     107

Processed Lists     160

Processor Affinity     138

Product Definitions     13, 162

Product Support     13, 162

Product Updates     10

Profile Description:     18

Default Description     18

Hiding Profile Description Toolbar     18

Moving Profile Description Toolbar     18

Profile Indicator     160

Profile Job List Pop Up Menu     27

Profile Job List:     27

Add/Delete/Modify Jobs     27

Changing Size of Window     27

Naming and Renaming Jobs     27

Selecting Jobs and Multiple Jobs     27

Profile Options: Customize     31

Profile Options: Show All     31

Profile Selection     162

Profile Selection List     162

Profiler     13, 162

Profiler Command Line Arguments     136

Profiles     13, 162

PSDef.CFG     8

PSError.log     97, 98

PSObserver Broadcasts     140

- Q -
Quantity Discounts     10

Quick-Sync     163

Quick-Sync Folder     163

Quick-Sync Profile     163

Quit     160

- R -
Real time File Folder Change Detection     65

Real Time Mode     13, 162

Real time Monitoring Argument     145

Real Time Options     67

Real-time Attribute Change     155

Real-Time Command Line Arguments:     155

Disable Real-time Security Change     155

Folder ACL Detection     155

Folder Change Detection     155

NFS Replication     155

Real-time Attribute Change     155

Set Delay between Enhanced Real-Time
Deletions     155
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Real-Time Command Line Arguments:     155

Set Delay between Enhanced Real-Time Event
Processing     155

Set Delay between Enhanced Real-Time Queue
Checking     155

Set Empty File Delay     155

Set Enhanced Real-Time Event Queue Delay    
155

Set Enhanced Real-Time Event Upper Limit    
155

Set Maximum Number of Events to Process    
155

Set Process Delay for Enhanced Real-time
Changes     155

Set Real-time Copy Thread Pool     155

Set Shadow Detection     155

Use Update Sensitivity     155

Real-time Copy Thread Pool     155

Real-Time Event Detection Options     65

Real-time Monitoring     65

Real-time Options Button     65

Reboot Options Button     90

receive an e-mail at start of profile     104

receive an e-mail at stop of profile     104

Recovery Intervals Button     108

Register by FAX     10

Register by mail     10

Register by phone     10

Register online     10

Registering Evaluation Copy of PeerSync     10

Registering Unregistered Copy of PeerSync     11

Registration and Passwords:     10

Entering User ID/Password (Evaluation Copy)  

 
 10

Register By Mail     10

Registry variables to use in Folder Paths     61

Related Global Settings     79

Relative Paths     74

Re-load Profile     160

Remote Connection Information     162

Remote Connection Licenses     162

Remote Control     162

Remove Failed Events If Successfully
Re-Processed     148

Remove Service (PeerLock)     123

Remove Service (PeerSync)     121

Rename Job     15

Replace In use Files Options     90

Replace in use files upon reboot     90

Replace Shares: Add and Overwrite     106

Replicate - Delete unmatched files/folders     73, 74

Replication     13, 162

Report file name     100, 102

Report file path     100

Report Non Standard Events     140

Reporting     33, 97

Reporting Command Line Arguments:     140

Create and Append Summaries into One Report

 
   140

Display status in PeerSync     140

Display status in PeerSync upon completion    
140

Enable PSObserver Broadcasts     140

Enable SNMP Error Reporting     140

Enable Summary Statistics Collection     140

Error Reporting     140

Hide Splash Screen     140

Log Messages by Filter     140

Log Messages by Profile     140

Log Messages Only to a Log File by Filter    
140

Log Messages Only to a Log File by Filter
and/or by Profile     140

Log Messages Only to a Log File by Profile    
140

Log Service Events to the Event Viewer     140

MSMQ messaging     140

Only Hide the about screen     140

PSObserver Broadcasts     140

Report Non Standard Events     140

Run Pre-Sync Report     140

Show Tray Icon     140

Skip setting of main form visible     140

SNMP Error Reporting     140

Summary Report     140

Summary Statistics Collection     140

Suppress connection of PeerSync to the Profiler

 
   140

Tray Icon     140

Reporting Features     97

Reporting Screen:     97

Clear Log File     97

Include Options     97

Maximum Log File Size     98

Overview     97

Overwrite Existing Log File     97

Use Log File     97

View Log File     97
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Reporting Standard report file content     100, 102

Reporting Summary Information Only     100, 102

Reset Last Run On Value     27

Resume Service (PeerLock)     132, 133

Resume Service (PeerSync)     125, 127

Retain Last Access Time     158

Retry failed connections every x minutes     108

Retry open files every x seconds     108

retry open inaccessible files     108

Retry Options Button     90

Revisioning     33, 86

Revisions     86

Root Path - TCP Target     57

Root Path Prefix - NetApp Settings     45

Run a Pre-Sync Report (do not sync files/folders)    
113

run a scan on reconnect     108

Run application at start of PeerSync     148

Run as a service (PeerLock)     132, 133

Run as a service (PeerSync)     125, 127

Run at specific times and selected days     65

Run External applications/scripts before and after
the processing of a given Job     105

Run Menu     21

Run Pre-Sync Report     140

Run RegEdit     121

Run Scheduled Operation     145

Run selected Jobs at a specific time of day     65

Run VSS every x minutes     112

Run/View     31

Run/View (PeerLock):     132, 133

Launch PeerLock     132, 133

Pause Service     132, 133

Resume Service     132, 133

Run as a service     132, 133

Start Service/Application     132, 133

Stop Service/Application     132, 133

Run/View (PeerSync):     125, 127

In Sync     127

Launch PeerSync     125, 127

Pause Service     125, 127

Resume Service     125, 127

Run as a service     125, 127

Start Service/Application     125, 127

Stop Service/Application     125, 127

Trending     127

Run/View Current Profile Activity Screen:     160

Added Indicator     160

Checked Indicator     160

Deleted Indicator     160

Elapsed Time Indicator     160

Excluded Indicator     160

File Indicator     160

Files Indicator     160

Folders Indicator     160

Job Indicator     160

Messages Indicator     160

Mode     160

Profile Indicator     160

Size Indicator     160

Skip Files Button     160

Source Indicator     160

Target Indicator     160

Target Space Indicator     160

Updated Indicator     160

Running Jobs vs. Running Profiles (Run a Quick
Sync)     27

- S -
Sample Exclusions     93

Save As     160

Save Changes in PeerLock     119

Save Profile     15

Saving Profiles     15

Scan at Start     145

Scan limitations     33, 70

Scanning Options     65

Scheduled Mode     13, 162

Scheduling Options     65

Security style     79

Select a folder for deleted files to be placed     74

Select Application/Script to Run After     105

Select Application/Script to Run Before     105

Select days of the week to run Jobs     65

Select Source Folder     36

Select Source Folder Button     36, 52

Select Target Folder     54

Select Target Folder Button     54

Selected File Dates     96

Selecting Jobs     27

Selecting Multiple Jobs     27

Selecting Source Folders     36

Selecting Target Folders     54

Selection Tree     31

Selection Tree: Customize Options     31
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Send an email for every event     103

Send an email on an interval     103

Send an email once a day     103

Send an email once a week     103

Service (PeerLock)     132, 133

Service (PeerSync)     125, 127

Service Details (PeerLock)     123

Service Details (PeerSync)     121

Set Access Password     114, 116

Set Alternate/Additional Normal Targets     59

Set Application Priority     138

Set CIFS Defaults Button     50

Set Copy Threads     138

Set Deletion Move To Folder Cleanup Interval    
148

Set Email Threads     138

Set Empty File Delay     155

Set Failed Connection Timer     148

Set File Comparison Value     148

Set File Read/Write Buffer Delay     138

Set Job Comparison Delta     148

Set maximum number of copy threads to x     82

Set maximum number of retries to x     108

Set Multitasking Delay     138

Set NFS Defaults Button     50

Set Processor Affinity     138

Set Queue Directory Change Count     148

Set Real-time Copy Thread Pool     138

Set Safety Value for Last Run Time     158

Set Shadow Detection     155

Set Shared Process Delay     138

Set SNC File to Load     137

Set Source Path     137

Set Target File Overwrite     148

Set the maximum log file size to x bytes     98

Set the percentage of copy threads to reserve for
real-time events     138

Set Today's Date Button     96

Set Trigger Folder File Name     158

Set VSS Try Count     158

Shadow Time Range     148

Share Migration support for cDOT 8.3     148

Shared Process Delay     138

Show Advanced/Normal Display     127

Show Advanced/Normal Display PeerLock     133

Show All Profile Options     31

Show PeerLock     119

Show Pre-Sync report file at end of run     113

Show Tray Icon     114, 116, 140

Show/hide Selection Tree     15

Show/hide the Selection Tree     31

Silent Installation     8

Simple Network Management Protocol reporting    
98

Size Indicator     160

Skip File Button     160

Skip setting of main form visible     140

SMTP Host - Email Reporting     102

SNC File     137

SNMP Error Reporting     140

SNMP Options Button     98

SNMP reporting     98

Source and Target Selections     36

Source Configuration     107

Source File/Folder Alterations     88, 89

Source Folder Connection Manager     44

Source Folder Field     36

Source Folder NetApp Settings     45

Source Folder Popup Menu     53

Source Folder Selection     36

Using Normal Mode     36

Using TCP Mode     36

Source Folder Selection Button:     52

Create Source Button     52

Explore Source Button     52

Open Source Button     52

Source Indicator     160

Specific time scheduling     65

Standard synchronization     71

Start Service/Application (PeerLock)     132, 133

Start Service/Application (PeerSync)     125, 127

Startup/Service     31

Startup/Service (PeerLock):     123

Executable Path (PeerLock)     123

Install Service (PeerLock)     123

Path (PeerLock)     123

Remove Service (PeerLock)     123

Service Details (PeerLock)     123

Startup/Service (PeerSync):     121

Add to Windows registry     121

Add to Windows StartUp     121

Create Shortcut on Desktop     121

Create SNC extension     121

Disable all Startup Options     121

Executable Path     121

Install Service     121
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Startup/Service (PeerSync):     121

Quick-Sync Folder Option     121

Remove Service     121

Run RegEdit     121

Service Details     121

Status Display     160

Status Screen     160

Stop Service/Application (PeerLock)     132, 133

Stop Service/Application (PeerSync)     125, 127

store events while connection is down     108

store missed events and process on reconnect    
108

Summary Report     140

Summary Reporting Feature     97

Summary Statistics Collection     140

Suppress connection of PeerSync to the Profiler    
140

Suppress Reboot during Install     8

suspend file transfer     69

Swap Source and Target Folders     60

Sync Selected Jobs     27

Synchronization     13, 162

Synchronization Command Line Arguments:     148

Active Connection Interval     148

Allow Replication During Dynamically Created
Jobs     148

Always Run Post Process     148

Always use the local machine time for the Last
Run Time     148

Compare and Set File Attributes from Windows
to NetApp     148

Delete Empty Source Folders After Move     148

Disable application associated with sync     148

Disable Failed Connection Timer     148

Do Not Validate Connections Before Profile is
Loaded     148

Enable Last Access Compare     148

Exclude Folders that have a Reparse Point    
148

Folder Queue Watch Interval     148

Force  Flush File Buffers     148

Get Remote PC Time     148

Ignore File Size and/or Date Comparison     148

Ignore Matching/Locked File Extensions     148

Ignore Matching/Locked File Postfix
Replacement     148

Ignore Open File Extensions     148

Ignore Target Space During File Copy     148

Move Files     148

No not delete folders     148

Partial Locked File Extensions List     148

Run application at start of PeerSync     148

Set Deletion Move To Folder Cleanup Interval  

 
 148

Set Failed Connection Timer     148

Set File Comparison Value     148

Set Job Comparison Delta     148

Set Queue Directory Change Count     148

Set Target File Overwrite     148

Shadow Time Range     148

Share Migration support for cDOT 8.3     148

Target In-Use Replacement     148

Terminate All Instances of PeerSync     148

Use Alternate Copy File Methods     148

Use Delete Path for Revisions     148

Use Full Access File Copy     148

Use Network Password Dialog     148

Verify User-Name     148

WordPerfect Fixes for synchronization     148

Synchronization of files between dissimilar time
zones     91

Synchronization Timer Argument     145

Synchronization Timer Argument with Keyboard
Activity     145

Synchronize ALL files via Managed Files     81

Synchronize open/locked files via Managed Files    
81

Synchronize Selected Jobs Option     27

System Information for Source Host - cDOT:     46,
50

Get Info     46, 50

System Information for Source Host:     45

Get Info     45

- T -
Target Configuration     107

Target File Time Change Option     91

Target File/Folder Alterations     88

Target Folder Field     54

Target Folder Popup Menu     59

Target Folder Selection     54

Target Indicator     160

Target In-Use Replacement     148

Target Space Indicator     160

TCP Source     37

TCP Source Mode Selection     39
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TCP Source PopUp     53

TCP Target     55

TCP Target Configuration Tab     56

TCP Target Mode Selection     56

TCP Target PopUp     59

TCP Target Port Configuration Tab     57

TCP Wan Connector Option     37, 39, 55, 56

Temp Files     88

Temp Folder Selection     8

Term and Trial Period     3

Terminate Active Profile     15

Terminate All Instances of PeerSync     148

Thread Utilization     138

Threads     110, 138

Throttle bandwidth     82

Throttle bandwidth - Use x percent of available
bandwidth     82

Time Change After Sync     91

Time Delta Selection     91

Time Out - TCP Target     57

Time variables for Folder Paths     61

Time Zone Option     91

Timer Argument     145

Tool Buttons     15

Tool Buttons:     15

Add Job     15

Back     15

Copy Job     15

Delete Job     15

Help     15

Hiding/Moving Toolbar     15

Launch Current Profile     15

Move Job Down     15

Move Job Up     15

New Profile     15

Next     15

Open Profile     15

Overview     15

Rename Job     15

Save Profile     15

Settings Screens Drop-Down List     15

Show Selection Tree     15

Terminate Active Profile     15

Toolbars:  Profile Description     18

Transfer File and Folder Permissions     78

Transfer Time Reporting Feature     97

Trap Prefix     99

Tray Icon     114, 116, 140

Tray Icon Popup Menu     26

Tree     31

trigger file     70

Turn file archive attribute off after synchronization    
89

- U -
Uninstall     8

Uninstall previous versions of PeerSync     12

Unmount Folders - NFS Settings     76

Update - synchronize existing files in target     71

Updated Files Reporting Feature     97

Updated Indicator     160

Updates:  Product     10

Upgrade     12

Upgrade Information     12

Upgrade PSListener     12

Use Alternate Copy File Methods     148

Use Arguments from Profile     137

Use Asynchronous Mode - NetApp Settings     45

Use Block Byte Level Synchronization     84

Use block/byte level synchronization     84

Use cDOT Detection - NetApp Settings     45

Use daily timer scheduling     65

Use Delete Path for Revisions     148

Use Device Driver method     145

Use Enhanced bi-directional synchronization mode  

 
 158

Use enhanced bi-directional synchronization mode
options     112

Use enhanced real-time monitoring     65

Use error information only     100, 102

Use Full Access File Copy     148

Use intermediate file during copy:     88

Use Last Access File Time     158

Use Log File     97

Use maximum wait time of x seconds     105

Use Network Password Dialog     148

Use Optional Target Unix Linux Settings     77

Use SNMP reporting     98

Use standard report file content     100, 102

Use summary information only     100, 102

Use Unix/Linux system for Job Scans, Copy File
and/or setting Permissions     76

Use Update Sensitivity     155

Use Variables for folder paths stored in registry    
61
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Use VSS     71

User ID - Email Reporting     102

User Name - NFS Settings     76

User Name - TCP Target     57

User Name and Password     10

User Name variable     61

Usernames - cDOT Options     46, 50

Using # in Excluding Folders     95

Using Variable Paths     61

Using Wild Cards for files to Include     92

- V -
Validate target file (using CRC32)     91

Validation Options     90, 91

variable data import     63

Variables     61

Variables:  File Path     61

Verify User-Name     148

version of files     86

View Admin Folder     160

View Alternate Target Path Selection     60

View Log File     27, 97, 160

View Menu     19

View PeerSync activity across the LAN     162

View Popup Menu     26

View Target Folder     160

Volume Shadow Copy Service (VSS)     81, 112,
158

VSS     71, 81, 112, 158

VSS Interval     112, 158

- W -
Wait for application to end before continuing     105

Web Farms     114, 116

What email address to send from     102

Who to send emails to     102

Window:  Changing Height of Profile Job List     27

Windows Explorer Add On - Quick-Sync     163

Windows Platforms     13

Windows Variables for Folder Paths     61

WordPerfect Fixes for synchronization     148

Working With Jobs     13, 162

Working with Profiles     13, 162

- Y -
Year variables for Folder Paths     61
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